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EditPad 7 Help 

Welcome to the documentation for EditPad Lite 7 and EditPad Pro 7. All features that are available in 
EditPad Lite are also available in EditPad Pro. Some features are available in EditPad Pro but not in EditPad 
Lite. Those features are indicated as (available in EditPad Pro only) in this help file. 

If you are upgrading from EditPad Pro 6 to EditPad Pro 7, check out whatõs new and learn how to migrate 
from EditPad Pro 6 to EditPad Pro 7. 

EditPad is very configurable. Almost every aspect can be adjusted to your own tastes and habits. Many 
settings can be made separately for each file type. To do so, select Options|Configure File Types in the 
menu. To edit general preferences, use Options|Preferences. 

You can access all of EditPadõs functionality through the main menu. Once you get used to working with 
EditPad, youõll mostly rely on the fully configurable toolbar and keyboard shortcuts. 

EditPadõs menus are: 

¶ File  

¶ Edit  

¶ Project  

¶ Search  

¶ Go  

¶ Block  

¶ Mark  

¶ Fold  

¶ Tools  

¶ Macros  

¶ Extra  

¶ Convert  

¶ Options  

¶ View  

¶ Help  

Some functionality can be accessed through panels that dock to the sides of EditPadõs window: 

¶ Search and Replace  

¶ Spell Check  

¶ Clip Collection  

¶ Character Map  

¶ Byte Value Editor  

¶ Files Panel  

¶ Explorer Panel  

¶ FTP Panel  

¶ File History  

¶ File Navigator  
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1. File Menu 

File|New  

Creates a new tab with a blank, untitled file. If you click the File|New item directly, then the file type for the 
new file is the one for which you selected òdefault file type for new filesó in the file type configuration. If you 
select a file type from the File|New submenu, then the new file uses the settings for the file type that you 
selected. 

If you use File|Save As and give the file a name with an extension that belongs to a file type other than the 
one used by File|New, then the fileõs file type is be changed to the file type associated with that extension. 
The file will then also use the settings defined for that file type. 

File|Open  

The File|Open command shows an open file common dialog. It allows you to open one or more files from 
the folder of your choice. To select more than one file, hold down the Shift or Control key on the keyboard 
while you click with the mouse. You can configure the initial folder of the open dialog in the Open Files 
Preferences. 

You can tick the read-only checkbox to force EditPad to open the file in read-only mode, regardless of 
whether the file is writable or not. This can be useful to make sure you donõt accidentally overwrite the file. It 
also tells EditPad not to try to open the file for writing. 

If the active file is untitled and empty, it is replaced by the file you open. This ensures EditPad does not get 
cluttered with empty tabs. 

If you open a single file that is already open, EditPad simply switches to the copy that is already open, as if 
you had clicked on its tab rather than attempting to open it again. If that file is open in another project, 
EditPad switches that project and to the file. If you open multiple files that are all open in the same project, 
EditPad switches to that project and to one of the files you wanted to open. 

If you open multiple files and some, but not all, of them are open in projects other than the active one, 
EditPad moves all the files into the active project. If some of the files were open in unmanaged projects, 
those files are removed from those projects. If some of the files were open in managed projects, those files 
are closed in those projects, but remain part of the other projects. 

If the active project is a managed, the File|Open command does not add the files to the project. The files 
show up under the projectõs tab as outside files. To make the files part of a managed project, either use 
Project|Add to Project instead of File|Open, or use Project|Add Outside Files after using File|Open. 
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Recently Closed Files 

The File|Open command has a submenu that 
lists recently closed files. Opening a file 
removes it from the File|Open submenu. 
Closing a file adds it to the top of the 
File|Open submenu. Selecting the file in that 
submenu opens it again. 

Only files that were opened individually are 
added to the menu when they are closed. That 
includes files opened by double-clicking on 
them in Windows Explorer or by dragging and 
dropping them onto EditPad. Files that are 
opened in bulk such as by opening a project or 
opening a folder are not added to the 
File|Open menu when you close them. The 
Project|Open Project and Project|Open 
Folder commands have their own submenus 
for reopening projects and folders. Whether 
you close files one by one or all at the same 
time does not matter. How the file was opened 
determines whether it is added to the 
File|Open submenu. 

At the bottom of the submenu, you will see the òRemove Obsolete Filesó and òRemove All Filesó items. The 
former removes all files that no longer exist from the list of recently closed files. The latter clears the list of 
recently closed files entirely. 

Though the menu can display only 16 files, EditPad Pro actually remembers the last 100 files. To access the 
complete list, select the Maintain List item at the bottom. This item is only available in EditPad Pro. 

When working with projects in EditPad Pro, the Project|Add to Project has its own submenu with recently 
closed files. It works just like the File|Open submenu, except that it remembers the last 100 files that were 
closed in that project only. If you havenõt worked with a project for a while, the Project|Add to Project 
submenu may still list closed files that have already dropped off the File|Open submenu. 

Maintain List  

Though the File|Open submenu can display only 16 files, EditPad Pro actually remembers the last 100 files 
you closed. To access the complete list, select the Maintain List item at the bottom. This item is only available 
in EditPad Pro. 

 

To open many files again at once, select all of them and click the Open button. Clicking the Open button 
does not close the Maintain List dialog. You can select files and click the Open button repeatedly to open 
multiple sets of files. 
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To remove files from the history, select them and click the Remove button. This will only remove files from 
the list. It will not delete any files. If you want to remove all files that no longer exist, you can do so by 
selecting òRemove Obsolete Filesó in the File|Open submenu itself, rather than selecting òMaintain Listó to 
open the above dialog. 

Using the Up and Down buttons, you can change the order of the files in the history list. Press the Control 
key on the keyboard while clicking the Up or Down button to move a file all the way to the top or the 
bottom. If you want an item to be visible directly in the File|Open submenu, move it up until it is among the 
first 16 files in the list. 

Read-Only Files 

If a file is in use by an application, another application cannot modify it. Files stored on read-only media such 
as CD-ROMs cannot be modified by applications either. Files that have the read-only attribute set should not 
be modified by applications, but can be if you have the necessary security privileges to remove the read-only 
attribute. 

If you use EditPad to open a file that is already in use by another application, stored on read-only media, or 
has the read-only attribute set, EditPad will open that file in òread onlyó mode. This is indicated on the status 
bar. Where you normally see whether the current file has been modified or not (the indicator shows 
òModifiedó or shows nothing), you will then see òRead Onlyó. A file that is in read only mode cannot be 
edited in EditPad. 

You can turn off òread onlyó mode by clicking on the òRead Onlyó indicator on the status bar. If the file is in 
use by another application or stored on a read-only device, however, you still wonõt be able to save it even if 
you can edit it in EditPad. To save your changes, either close the other application that is using the file and 
then use File|Save, or save your changes to a new file with File|Save As. If the file was opened as read-only 
because the read-only attribute was set, EditPad will attempt to remove the read-only attribute if you try to 
save the file. 

The File|Open screen has a òread onlyó checkbox at the bottom. If you tick that, EditPad opens the file as 
read only, even if the file is perfectly writable. In that case, clicking the òRead Onlyó indicator on the status 
bar makes the file editable, as if you had opened it without using the òread onlyó checkbox. 

If you have a file open that is not read only and it doesnõt have any unsaved changes, you can make it read-
only by clicking the blank space in the status bar reserved for the òModifiedó or òRead Onlyó indicator. This 
only prevents accidental changes to the file in EditPad. EditPad does not set the fileõs read-only attribute, nor 
does it prevent other applications from modifying the file. 

File|Favorites 

In the Favorites submenu of the File menu, you can keep lists of files that you often work with. This way you 
can quickly open them to continue working on them. 

To add a file to your favorites list, first open the file in EditPad. Then select File|Favorites|Add Current File 
from the menu. The next time you open the File|Favorites menu, you will see the file listed there. The files 
are sorted alphabetically by their complete path names. If you have added folders via the Organize Favorites 
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screen (see below), you can add a file to one of the folders by selecting the òAdd Current Fileó item from the 
folderõs menu. 

To purge files that no longer exist from the list of favorites, select òRemove Obsolete Filesó from the 
Favorites menu. If you have created folders, non-existent files will be purged from those folders as well. To 
remove only certain files, whether they still exist or not, use the Organize Favorites screen. 

To open one of your favorite files, simply choose it from the Favorites menu. To open many of your favorite 
files, use Organize Favorites. 

Organize Favorites 

Click the File|Favorites item directly or select Organize Favorites from the File|Favorites submenu to 
organize the list of your favorite files, or to open many of those files quickly. 

Creating folders is useful if you have more 
than twenty favorite files. If you add more 
than 20 files directly to the favorites menu, 
or to one of the folders, then the menu 
listing your favorites will become very long 
and difficult to use. Note that creating a 
folder here to hold your favorites does not 
actually create a folder on your hard disk. 
It simply adds a hierarchical structure to 
the list of favorites stored in your EditPad 
Pro preferences. Use the New Folder 
button to create a new folder to which you 
can add favorites. You can change the 
caption of a folder by clicking on the 
folder and then clicking on the Rename 
Folder button. 

When adding file to the favorites list, files 
are added to the main list if either nothing 
is selected or if a file in the main list is 
selected. To add files to a folder, select 
either the folder or a file in that folder. Click the Add Files button to find and add files. 

You can move files between folders by dragging and dropping them with the mouse. EditPad Pro 
automatically sorts the list of favorites alphabetically. You cannot rearrange files inside a folder. 

To open one or more files, select them and click on the Open button. Note that when selecting more than 
one file, all the files must be in the same folder. You cannot select multiple files across folders. If you want to 
open files from several folders, open them folder by folder. You can click the Open button as many times as 
you want to open as many files as you want. 

To remove one or more files from the favorites, select them and click on the Remove button. This will not 
delete the files, but only remove them from the list of favorites. If you want to remove all files that no longer 
exist, select Remove Obsolete Files, instead of Organize Favorites, from the File|Favorites menu. 
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File|Templates  

The Templates submenu of the File Menu works just like the Favorites submenu, with one small but 
important difference. When you select a file from the Favorites menu, EditPad simply opens that file. If you 
select a file from the Templates menu, however, EditPad will create a new, untitled file with the content of 
the file you selected. 

If you often edit a particular file, saving the changes back into the same file, you should add it to the 
Favorites. If you often create new files based on the contents of a particular file, you should add that file to 
the Templates menu. Using templates, you wonõt accidentally save the changes over the original file. 

The Favorites and Templates menus are completely independent. You can add the same file to both. 

File|Save 

Saves the active file to disk, overwriting the original, if any, without warning. 

In Save Files Preferences you can specify if and how backup copies should be created. 

If the active file is untitled, File|Save invokes File|Save As. 

File|Save As 

Saves the active file under a new name. If the active file has previously been saved, the original copy will 
remain available. If you later use File|Save after using File|Save As, it will save under the new name as well. 
This is indicated by the file name on the tab which changes after you use File|Save As. 

When you select File|Save As, a save file common dialog box will appear. You can select the folder in which 
you want to save and type in a file name. You can configure the initial folder of the save dialog in the Open 
Files Preferences. 

If you do not specify an extension for the file name, EditPad adds one depending on the selection you made 
in the filters (the bottommost drop-down list) in the Save As dialog box. If the active filter is òany fileó (*.*), 
no extension is added. If any other filter is active, the default extension for that file type will be added to the 
file name. The default extension is the first extension listed in the Extensions setting of the file typeõs settings. 

If you do specify an extension, EditPad will save the file with that extension. If the extension is part of 
another file type, all the file type dependent settings such as auto indent, number lines and word wrap will be 
changed to match the settings for that new file type as made in the file type configuration. 

File|Save All 

Rapidly performs a File|Save for each open file, in each project. 
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For untitled files, File|Save As is invoked. If you click on Cancel in the save as dialog box, the save all 
function will not save any further files either. 

File|Print  

Select File|Print in the menu to print the active file. A preview of the printout is shown first. 

 

The margins can be changed by moving the mouse over one of the dotted blue margin lines. The mouse 
pointer will change to indicate that you can move the margin, and a hint box will indicate the size of the 
margin in centimeters and inches. Click on the line, hold the mouse button down and drag the line until it 
indicates the desired margin position. 

Long lines are wrapped at the right hand margin if while editing the file you have word wrap turned off or set 
to wrap at the window border. If you have word wrap set to limit lines to a certain number of characters then 
the printout also wraps lines at that number of characters. If the space between the margins is insufficient for 
lines with that number of characters then lines that are too long are clipped at the right hand margin. You can 
change word wrapping using the Options|Word Wrap menu item before selecting File|Print. 
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With the blue arrow buttons at the top, you can browse through the pages that will be printed. You can also 
press the Page Up and Page Down keys on the keyboard. 

The magnifying glass buttons zoom the preview in and out. You can also press the plus and minus keys on 
the numeric keypad on your keyboard. Zooming does not affect the printout, only the preview. 

If you want to print with a different font or different text spacing, click the Font & Layout button. This 
button shows the same text layout configuration screen as the Options|Text Layout menu item, except that it 
shows the text layouts you have configured for printing rather than the ones youõve configured for editing. 
Another difference is that if you turn on the òallow bitmapped fontsó checkbox, the font list will include 
printer fonts rather than screen fonts in addition to the TrueType and OpenType fonts that work everywhere. 
A òprinter fontó is a font built into your printerõs hardware. If you select a printer font, set òtext layout and 
directionó to òleft to right onlyó for best results. 

Because EditPad keeps separate text layout configurations for printing and editing, any changes you make to 
text layouts via the print preview only affect the printout. EditPad remembers the layout you used for 
printing in combination with the layout you used for editing. If you edit a file with a text layout youõve called 
òedit monospacedó and you print it with a text layout youõve called òprint monospacedó, then the next time 
you print a file youõre editing with the òedit monospacedó layout, the print preview will automatically select 
the òprint monospacedó layout. 

Press the Setup button to access your printerõs setup screen or to select a different printer than the default 
printer. 

òFrom pageó and òto pageó determine the range of pages that will be printed. The value of òfrom pageó must 
be smaller than or equal to that of òto pageó, even if you want to print in reversed order (see below). 
òCopiesó is the number of copies that should be printed of each page. 

Activating òAll pagesó will print all pages in the range specified by òfrom pageó and òto pageó, while òodd 
pagesó will print only the odd-numbered (1, 3, 5, ...) pages in the range, and òeven pagesó only the even-
numbered (2, 4, 6, ...) ones. If the page range is only one page (òfrom pageó equals òto pageó) and that page is 
odd-numbered while òeven pagesó is activated, or the other way around, nothing will happen when you click 
the Print button. You will not get an error message. 

If you mark òReversedó, the pages will be printed from last to first instead of from first to last. This can be 
useful if you have an inkjet printer that puts pages in reversed order in the out tray. 

If you opened the print preview with File|Print, you can mark the òselection onlyó box to print only those 
lines that are selected in EditPad. The òselection onlyó checkbox works at the level of a single line. If a line is 
partially selected, it will be printed. If you only want to print exactly what you selected, select Block|Print in 
the menu instead. 

If you have a monochrome printer or you do not want to waste expensive color ink cartridges, turn off òprint 
in coloró to print black text without any background colors. If you turn on òprint in colorsó, the printout is in 
full color. Be careful if you have selected the white on black color palette. Youõll see white on black in the 
print preview, and the printout will use loads of black ink to make the whole page black. 

When printing only the selection, syntax coloring may be applied differently when you use Block|Print to 
print the exact selection rather than using File|Print and turning on òselection onlyó to print the selected 
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lines. With Block|Print, the syntax coloring will color the block as it were the whole file, while File|Print 
applies syntax coloring to the whole file, even with òselection onlyó turned on. 

Turn òprint line numbersó on or off to print the file with or without line numbers, regardless of whether 
youõve used Options|Line Numbers to edit the file with line numbers. The print preview remembers this 
checkbox separately for each file type. 

In EditPad Pro, you can use the òvisualize spacesó and òvisualize line breaksó checkboxes to make spaces and 
line breaks visible in the printout or not, overriding the Options|Visualize Spaces and Options|Visualize 
Line Breaks menu items. These checkboxes are also remembered separately for each file type. 

If you used the Fold|Fold command to hide certain lines, then you can turn on the òhide folded linesó option 
to exclude those lines from the printout. The printout will not indicate folding ranges with òplusó or òminusó 
buttons. 

If you have òprint in coloró turned on, you can click the Color Palette button to select a different set of 
colors. You should select a palette that uses a white background. Otherwise, EditPad will use loads of ink to 
give the printout a colored background. If you print on colored paper, you should still select a white 
background in EditPad. EditPad cannot determine the color of your paper. White is assumed. The Color 
Palette button shows the same color selection screen as the corresponding button in the file type 
configuration. If you edit any palettes, those changes also affect the palettes used for editing. If you want to 
use different palettes for editing and for printing, create new palettes for printing instead of editing existing 
ones. EditPad remembers the palette used for printing in combination with the palette used for editing. E.g. if 
you edit a file with the òBorland classicó palette (which uses a blue background) and then select the 
òEmbarcaderoó palette for printing it without the blue background, then the print preview automatically 
defaults to the Embarcadero palette next time you print a file that youõre editing with the Borland palette. 

Click the òPrintó button to start printing. Then click the òCloseó button or press Escape on the keyboard to 
close the print preview. 

Print Headers 

Click the "Headers & Footers" button in the Print Preview window to change the headers and footers to be 
printed, if any. 

The headers and footers are printed inside the margins specified on the print preview. If no headers or 
footers are specified, their space will be claimed by the text body. 

A few special placeholders are available in the headers and footers: 

%P   Page number of the current page 
%N   Total number of pages 
%D   Current date, printed using the short date format specified in the regional settings of the Control Panel 
%T   Current time, printed using the short time format specified in the regional settings of the Control Panel 
%FD  Date the file was last modified, again printed in short date format. 
%FT  Time of the day the file was last modified, again printed in short time format. 
%FP  Full path to the file being printed: folder + filename 
%FN  Filename (without folder name) of the file being printed 
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File| Mail  

Select File|Mail from the menu to send the current file to somebody via email. The email composition pane 
is shown. 

 

Type in your full name followed by your own email address in the field labeled òFromó. If you have 
previously used the email function, you can quickly select your email address from the drop-down list. 

Then type in the recipientõs email address in the òToó field. You can either enter the recipientõs full name 
followed by his or her email address, or you can enter only the email address. 

If you want to send your message to more than one recipient, click the Add button next to the òToó field to 
add the first email address to the list. Then type in the second email address into the òToó field, and click the 
Add button again. Do so for all recipients. If you make a mistake, you can remove a recipient by selecting his 
or her email address from the list and clicking the Remove button. 

In the òSubjectó field, type in the subject of the email message. 

If you want to attach files to the email message, click the Attach button. Select the file you want to send. You 
can attach more than one file if you want to. If you change your mind about attaching a file, click on it in the 
list and click the Remove button below the list of attachments. 

The Send or Enqueue button does not become enabled until you type in your email address, the recipientõs 
email address, and the messageõs subject. When you click the Send button, the email is placed in the mail 
queue and sent out immediately. When you the Enqueue button, the email will be added to the mail queue, 
but will not be sent until you click the Send button in the mail queue. Which of the two buttons appears 
depends on the option to send out email immediately in the Email Preferences. 

Before you can actually send mail, you need to specify the outgoing mail server that EditPad Pro should use 
in the Email Preferences. If you havenõt done this yet, clicking the Send button brings up the Preferences 
screen. 

Mail  Queue 

The mail queue pane appears after you click the Enqueue or Send button in the mail composition pane. Each 
time you click the Enqueue or Send button, another email message will be added to the bottom of the mail 
queue. The messages will be marked as òqueuedó. 
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Click the Send button in the mail queue to start sending the messages in the queue. EditPad Pro will start 
sending the first message in the queue marked as òqueuedó. EditPad Pro always starts sending the first 
message, no matter which message you selected in the queue before clicking the Send button. When the first 
message has been sent, EditPad Pro continues with the next, until all queued messages have been sent. The 
message that is being sent is marked as òsendingó. After it has been sent, it will either be marked as òsentó in 
case of success, or òfailedó in case the message could not be sent. While email is being sent, EditPad Pro tells 
you what is happening in the caption bar above the queue. The caption indicates òEmail Queueó if you have 
not sent anything yet. 

To remove a message from the queue, select it and click the Delete button. You can delete any message, even 
while EditPad Pro is sending email . Only the message that is currently being sent (if any) cannot be deleted 
from the queue. If you want to delete all successfully sent messages from the queue, click the Close button. 

If EditPad Pro could not send a particular message, it will be marked as òfailedó. If you want to try the 
message again without making any changes to it, select it and click the Retry button. This will mark the 
message as òqueuedó. You can do this whether EditPad Pro is sending messages or not. Alternatively, you 
can cancel sending the message by deleting it from the queue. EditPad Pro will not automatically retry failed 
messages. You have to mark them again as òqueuedó. 

To move a message up or down in the queue, select it and click the Move Up or Move Down button. You 
can move any message, regardless of its status. However, the order of the messages only matters for those 
marked as òqueuedó. The first one in the list is the one that will be sent next, regardless of which message is 
currently being sent (if any). 

Click the Close button to close the mail queue pane. This will also delete all successfully sent messages from 
the pane. The only way to make the mail queue appear again after closing it, is to add another message to the 
queue through the mail composition pane. Therefore, you cannot close the mail queue while email is being 
sent. If the pane takes up too much space, click on the minimize button on the caption bar below the queue. 
This will hide the list of messages and the buttons, but not the caption bar. This allows you to continue 
monitoring the progress in the caption bar, and to see the queue again by clicking the minimize button turned 
restore button again. 

Note that the email queue sends email in the background. This means that you can continue using EditPad 
Pro as usual, including composing new emails, while email is being sent. This is particularly useful when 
sending large attachments over a slow connection. The only function you cannot use is File|Exit. 

File|Mail as Attachment 

Select òMail as Attachmentó from the File menu to start with a blank email message and attach the current 
file to the email. The mail composition pane will appear to allow you to further prepare the email message. 
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File|Reload from Disk  

Select File|Reload from Disk from the menu to revert the active file to the status it had when it was last 
saved. This can be useful if you are viewing a file that is being written to by another program. 

Note that if you switch tabs within EditPad or if you switch to another application and then back to EditPad, 
EditPad automatically checks whether the file on disk has been changed. If so, and you have not modified the 
file in EditPad, it will be automatically reloaded. If you did modify the file in EditPad, you will be asked if you 
want to keep the changes made in EditPad or reload from disk. In the Open Files Preferences, you can 
disable the automatic reload, or make EditPad always prompt before reloading. 

If you click Keep Changes, EditPad will not reload the file, and will not overwrite the file on disk unless you 
use File|Save. If you want to keep both the changes youõve made in EditPad and the modified copy of the 
file on disk, click the Keep Changes button, and then use File|Save As to save the changes in EditPad into a 
new file. 

In addition, EditPad Pro gives you the option to see the difference between the file in EditPad and the file on 
disk. If you click the See Difference button, EditPad Pro invokes Extra|Compare with File on Disk. EditPad 
Pro will not reload the file, and will not ask you again to reload the file, until is is changed on disk again. If you 
want to reload the file from disk after looking at the differences, use the File|Reload from Disk menu item. 

File|Save Copy As 

The Save Copy As command in the File menu works just like File|Save As. The only difference is that after 
File|Save Copy As, the File|Save command will continue to save the file using the original file name. The file 
name indicated by the tab does not change. 

The Save Copy As command adds an extra òopen the saved fileó checkbox at the bottom of the file selection 
screen. If you turn on this option, EditPad opens the copy of the file that you just saved. Youõll end up with 
two tabs, one for the original file, and one for the copy. You can edit them independently. 

See File|Save As for more information on how EditPad saves files. See View|File History for a quicker way 
to save milestone copies of your files. 

File|Rename and Move 

Use this function to move the active file into a different folder, and/or to change its file name. 

This feature is similar to File|Save As, except that the original file will be deleted after the file has been saved 
under the new name, effectively òmovingó the file. 

File|Delete  

After you confirm the warning message, File|Delete closes the active file and also deletes it from disk. 
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If Windows keeps a Recycle Bin for the drive the active file is on, it will be moved into the Recycle Bin 
awaiting its final fate. 

File|Close 

Closes the active file. If the file has unsaved modifications, depending on the choice you made in Open Files 
Preferences, EditPad will ask if you want to save, automatically save or automatically discard the changes. If 
you closed the last file in the project, EditPad will automatically start with a new, blank file. 

You can also close the active file by clicking with the mouse wheel on the fileõs tab. If you have enabled the X 
button to be shown on tabs or the tab control in the Tabs Preferences, you can use the X button to close the 
file. Closing a file by closing its tab is exactly the same as using the File|Close menu item. 

If the file is part of a managed project, closing open files does not remove the file from the project. Files that 
are part of managed projects remain part of the project as closed files. The Files Panel and Search Panel can 
show and search through files that are closed but are still part of managed projects. Closing outside files 
removes them from the project, because they were never an actual part of the project. 

If you want to remove an open file from a managed project, use Project|Remove From Project to close and 
remove the file. If you want to remove files that you have already closed from a managed project, use 
Project|Remove Closed Files. 

To close EditPad itself, click on the X button in the upper right of the Window, or select File|Exit in the 
menu. 

File|Close All  

Select Close All in the File menu to close all open project and all open files. If any files have unsaved 
modifications, depending on the choice you made in Open Files Preferences, EditPad will ask if you want to 
save or not, automatically save or automatically discard the changes. 

EditPad will start with a new untitled project, with one blank untitled file. 

To close all files in the current project only, use Project|Close All Files, or close the project itself with 
Project|Close Project. To close EditPad itself, click on the X button in the upper right of the Window or 
select File|Exit in the menu. 

File|Close All but Current 

Closes all files in the current project, except the one youõre currently viewing. If any files have unsaved 
modifications, depending on the choice you made in Open Files Preferences, EditPad will ask if you want to 
save or not, automatically save or automatically discard the changes. 

To close all files in all projects, except the current file, use Project|Close All but Current to close all other 
projects, and then File|Close All but Current to close all other files. 
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File|Exit  

Closes all files and terminates EditPad completely. 

If you have enabled EditPadõs icon next to the system clock in the System Preferences then File|Exit is not 
the same as clicking the X button in the upper right corner. Clicking the X button keeps EditPad in memory 
and keeps the icon visible, enabling EditPad to pop up instantly next time you want to edit a file. File|Exit 
removes the icon and shuts down EditPad completely. 

If the icon next to the system clock is disabled, clicking the X button is the same as using File|Exit. 
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2. Edit Menu 

Edit|Undo  

Use Edit|Undo to undo the last editing action. Repeat to undo more actions. 

You can undo the undo with Edit|Redo if you do so right away. If you take any other action that is 
remembered by the undo function, the redo list will be cleared. Only trivial actions such as moving the cursor 
do not clear the redo list. 

You can undo several actions in one go via the submenu of the Undo command. When you select an action, 
that action and all actions listed above it in the submenu will be undone at once. They will all be added to the 
redo list too. 

If you use the menu item or toolbar button to invoke this command, it will be invoked on EditPadõs main 
editor, where you edit files. If you press the shortcut key on the keyboard, it will be invoked on whichever 
editor is showing the text cursor (vertical blinking bar), whether thatõs the main editor, the search box, or the 
replace box. 

The undo feature remembers all changes you made to any file since you opened it in EditPad. Saving a file 
does not clear the undo list. Switching between files switches between the undo lists of those files. EditPad 
remembers the changes you made to each file even while you work with other files, until you close each file. 

Undoing and redoing actions updates the fileõs òmodifiedó status as indicated by the status bar and tab color. 
When you undo all changes you made since last saving the file, or redo all changes you undid since last saving 
the file, the file will be indicated as being unmodified. 

EditPad may use quite a lot of memory to remember all the changes you made to all the files you have open. 
Some commands, such as a search-and-replace across all files, may result in very large numbers of changes. 
EditPadõs undo history includes a safeguard to make sure EditPad does not run out of memory. If the undo 
history grows too large, EditPad automatically discards the oldest changes. In extreme cases, like a search-
and-replace that makes millions of replacements, the undo history may be cleared entirely. 

In EditPad Lite, the memory limits are set automatically to make sure EditPad Lite doesnõt use up all of your 
computerõs memory, while still being able to keep a complete undo history. Unless youõre making millions of 
changes in a search-and-replace, EditPad Liteõs undo history can easily keep track of a full dayõs worth of text 
editing. 

In EditPad Pro, you can configure the limits in the System Preferences. The default limits use the same 
balance as EditPad Lite. The actual numbers depend on the amount of RAM your PC has. 

In practical terms, you neednõt worry about EditPadõs undo history. Itõll remember virtually everything, 
without causing your computer to run out of memory and crash. If you do need to undo very long editing 
sessions, EditPadõs backup options and File History may be more practical anyway. 
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Edit|Redo  

If you change your mind after undoing an action with Edit|Undo, use Edit|Redo to redo it. 

The redo function works exactly the same like the undo function, except that making any change to a file in 
any way except through Edit|Undo or Edit|Redo, will clear the redo list. 

In contrast with other text editors, EditPad Lite and Pro do not clear the redo list when you take a trivial 
action such as moving the text cursor or making a selection. This gives you more opportunity to change your 
mind and redo undone actions. 

If you use the menu item or toolbar button to invoke this command, it will be invoked on EditPadõs main 
editor, where you edit files. If you press the shortcut key on the keyboard, it will be invoked on whichever 
editor is showing the text cursor (vertical blinking bar), whether thatõs the main editor, the search box or the 
replace box. 

Edit|Cut  

Deletes the current selection and places it on the Windows clipboard. Use Edit|Copy to put the selection on 
the clipboard without deleting it. If there is no current selection, and the option to copy the active line is 
turned on in the Editor Preferences, then the entire current paragraph is deleted and placed onto the 
clipboard. 

Any data previously held by the clipboard is removed from it. Use Edit|Cut Append instead if you do not 
want this. 

EditPad always copies text to the clipboard using Windows line breaks. This ensures maximum compatibility 
with other Windows applications. If the file uses syntax coloring, then EditPad places both plain text and rich 
text on the clipboard. When you paste the rich text version into a word processor, it will be pasted with the 
same font and colors you were using in EditPad. The rich text version is only generated when another 
application requests it. When copying and pasting within EditPad or between EditPad and another plain text 
editor, no time or memory is wasted to generate the RTF. If you donõt want word processors to paste rich 
text, either use the òpaste as plain textó or òpaste unformatted textó command in your word processor, or tell 
EditPad Pro not to copy rich text in the Editor Preferences. 

This command is always invoked on whichever editor is showing the text cursor (vertical blinking bar), 
regardless of whether you use the main menu, a toolbar button, or a keyboard shortcut. 

If youõre editing a file in hexadecimal mode, and you cut something from that file, and you paste that into 
another application or into a file youõre editing in text mode in EditPad, the result will differ depending on 
whether the cursor was in the hexadecimal section or the ASCII section when you used Edit|Cut. If you cut 
from the hexadecimal section, and paste into another application, the other application will see the 
hexadecimal representation on the clipboard, e.g.: ò74657374ó. If you cut from the ASCII section, the other 
application will see the actual bytes, e.g.: òtestó. 

If you cut and paste between EditPad and another hex editing application, you may need to switch EditPad to 
hexadecimal mode and place the cursor in the hexadecimal or ASCII section of the editor to get the results 
you expect. 
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Edit| Cut Append 

Deletes the current selection and places it on the Windows clipboard. Use Edit|Copy Append to do this 
without deleting the selection from EditPad. If there is no current selection, and the option to copy the active 
line is turned on in the Editor Preferences, then the entire current paragraph is deleted and placed onto the 
clipboard. 

If the clipboard already holds plain text data, the selection is appended to the text already on the clipboard, 
even if the text was placed on the clipboard by another application. Edit|Paste will then paste both the 
original text plus the selection appended to it. 

If the file uses syntax coloring, and the clipboard already holds a rich text version of other text copied by 
EditPad, then the rich text version is appended to as well. If the clipboard holds rich text copied by another 
application, Edit|Cut Append removes it from the clipboard. 

This command is always invoked on whichever editor is showing the text cursor (vertical blinking bar), 
regardless of whether you use the main menu, a toolbar button, or a keyboard shortcut. 

Edit|Copy  

Places the current selection on the Windows clipboard. If there is no current selection, and the option to 
copy the active line is turned on in the Editor Preferences, then the entire current paragraph is placed onto 
the clipboard. 

Any data previously held by the clipboard is removed from it. Use Edit|Copy Append instead if you do not 
want this. 

If you select a block that includes one or more folded sections and copy the block to the clipboard, all 
selected lines, including lines hidden by folding, will be copied to the clipboard. Use Fold|Copy Visible Lines 
if you donõt want to copy the hidden lines. When pasting back into EditPad Pro, the folded sections remain 
folded. 

EditPad always copies text to the clipboard using Windows line breaks. This ensures maximum compatibility 
with other Windows applications. If the file uses syntax coloring, then EditPad places both plain text and rich 
text on the clipboard. When you paste the rich text version into a word processor, it will be pasted with the 
same font and colors you were using in EditPad. The rich text version is only generated when another 
application requests it. When copying and pasting within EditPad or between EditPad and another plain text 
editor, no time or memory is wasted to generate the RTF. If you donõt want word processors to paste rich 
text, either use the òpaste as plain textó or òpaste unformatted textó command in your word processor, or tell 
EditPad Pro not to copy rich text in the Editor Preferences. 

This command is always invoked on whichever editor is showing the text cursor (vertical blinking bar), 
regardless of whether you use the main menu, a toolbar button, or a keyboard shortcut. 

If youõre editing a file in hexadecimal mode, and you copy something from that file, and you paste that into 
another application or into a file youõre editing in text mode in EditPad, the result will differ depending on 
whether the cursor was in the hexadecimal section or the ASCII section when you used Edit|Copy. If you 
copy from the hexadecimal section, and paste into another application, the other application will see the 
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hexadecimal representation on the clipboard, e.g.: ò74657374ó. If you copy from the ASCII section, the other 
application will see the actual bytes, e.g.: òtestó. 

If you copy and paste between EditPad and another hex editing application, you may need to switch EditPad 
to hexadecimal mode and place the cursor in the hexadecimal or ASCII section of the editor to get the results 
you expect. 

Edit|Copy Append  

Places the current selection on the Windows clipboard. If there is no current selection, and the option to 
copy the active line is turned on in the Editor Preferences, then the entire current paragraph is placed onto 
the clipboard. 

If the clipboard holds text data, the selection is appended to the text already on the clipboard. Edit|Paste will 
then paste both the original text plus the selection appended to it. 

If the file uses syntax coloring, and the clipboard already holds a rich text version of other text copied by 
EditPad, then the rich text version is appended to as well. If the clipboard holds rich text copied by another 
application, Edit|Copy Append removes it from the clipboard. 

This command is always invoked on whichever editor is showing the text cursor (vertical blinking bar), 
regardless of whether you use the main menu, a toolbar button, or a keyboard shortcut. 

Edit|Paste  

If you select Edit|Paste when the Window clipboard holds textual data, it will be inserted into the active file 
at the current position of the text cursor. If EditPad is in overwrite mode, and youõre not pasting whole lines 
(see below), the pasted text overwrites the text after the cursor, as if you had typed in the text. Pressing the 
Insert key on the keyboard or clicking the Insert/Overwrite indicator on the status bar toggles between insert 
and overwrite modes. 

If the active file does not use Windows line breaks, the text on the clipboard is automatically converted to the 
correct line break style before it is inserted. The text on the clipboard remains untouched, in case you want to 
paste it into other applications too. 

If you want to paste a block of text from another application as a rectangular selection, first make a 
rectangular selection in EditPad, and then paste. EditPad will then interpret the text on the clipboard as a 
rectangular block and replace the selection with it. Text copied from EditPad Pro is always pasted in the way 
(linear or rectangular) you had it selected when you cut or copied it. 

This command is always invoked on whichever editor is showing the text cursor (vertical blinking bar), 
regardless of whether you use the main menu, a toolbar button, or a keyboard shortcut. 

In EditPad Pro, the option òpaste whole lines when lines are copied as a wholeó affects how text is pasted if 
you copied complete lines to the clipboard. Copying a complete line means to copy everything from the start 
of the line to the end of the line, including the line break at the end of the line. Copying multiple lines 
completely means copying everything from the start of the first line in the block until the end of the last line 
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in the block, including the line break at the end of the last line. When the option òpaste whole lines when 
lines are copied as a wholeó is on, lines that were copied as a whole are always pasted as if the cursor were at 
the start of the line when youõre pasting. Thus, lines copied as a whole are always pasted as a whole before the 
line that the cursor is on when pasting. This makes it easy to move blocks of lines around without worrying 
about the horizontal position of the text cursor. If this option is off, text is always pasted at the exact spot the 
text cursor is at, even when whole lines were copied. Only whole lines copied in EditPad can be pasted as 
whole lines. EditPad cannot determine whether text copied from other applications is a whole line or not. 
EditPad Lite does not have this option and always pastes at the exact spot the text cursor is at. 

In hexadecimal mode, if the clipboard contains a hexadecimal representation of characters, the effect of the 
Paste command depends on whether the text cursor is in the hexadecimal section at the left, or the ASCII 
section at the right. If you paste into the hexadecimal section, EditPad will paste the bytes represented by the 
text on the clipboard. If you paste into the ASCII section, EditPad will paste the text on the clipboard òas isó. 
E.g. if the clipboard holds ò74657374ó, pasting into the hex section inserts òtestó, while pasting into the 
ASCII section inserts ò74657374ó into the file. 

If the text on the clipboard is not text with hexadecimal values, EditPad pastes the text regardless of whether 
the cursor is in the text or hexadecimal section. If the clipboard holds something you copied in hexadecimal 
mode in EditPad, EditPad will always paste the bytes that you copied, even if you moved the cursor from the 
ASCII to hex section or vice versa. If you copied text from a file in EditPad that youõre editing in text mode, 
then the hex interpretation does take place. 

If you copy and paste between EditPad and another hex editing application, you may need to switch EditPad 
to hexadecimal mode and place the cursor in the hexadecimal or ASCII section of the editor to get the results 
you expect. 

Edit|Swap with Clipboard  

If you select Edit|Swap with Clipboard when the Window clipboard holds textual data, it will be swapped 
with the current selection in the active file. That is, the selection is put on the clipboard as happens when you 
use Edit|Cut and then the text previously held by the clipboard is pasted into the text like Edit|Paste does. 

This command is always invoked on whichever editor is showing the text cursor (vertical blinking bar), 
regardless of whether you use the main menu, a toolbar button, or a keyboard shortcut. 

Edit|Select All  

Selects all the text in the active editor. This command is always invoked on whichever editor is showing the 
text cursor (vertical blinking bar), regardless of whether you use the main menu, a toolbar button, or a 
keyboard shortcut. 

Edit|Insert Date & Time  

Inserts the current date and time at the position of the text cursor. If you click this item directly or use its 
keyboard shortcut, the date and/or time are inserted using the format you last used. If youõve never used this 
command before, it defaults to the short date and time formats set in the Windows Control panel. 
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To use a different date and time format, or to insert the date only or the time only, select Other Date & Time 
format in the submenu of the Insert Date & Time menu item. A screen will pop up with a list of date and 
time specifiers. You can type in the date and/or time format that you want in the edit box at the top. You can 
double-click a specifier in the list to add it to the format. The òactual date and timeó box shows a preview of 
the text that will be inserted when you click OK. 

The Insert Date & Time submenu keeps a history of the last 16 formats that you used. Click on one to insert 
the current date and/or time using that format. 

Date and Time Format Specifiers 

These are the date and time placeholders that you can use. Format specifiers may be written in upper case as 
well as in lower case letters. Both produce the same result. 

c           Displays the date in short format followed by the time in long format as specified in the 
regional settings in the Windows Control Panel. 
d           Displays the day as a number without a leading zero (1-31). 
dd          Displays the day as a number with a leading zero (01-31). 
ddd         Displays the day as an abbreviation (Sun-Sat) in the language of the current Windows locale. 
dddd        Displays the day as a full name (Sunday-Saturday) in the language of the current Windows 
locale. 
ddddd       Displays the date using the short date format specified in the regional settings in the Windows 
Control Panel. 
dddddd      Displays the date using the long date format specified in the regional settings in the Windows 
Control Panel. 
m           Displays the month as a number without a leading zero (1-12). If the m specifier immediately 
follows an h or hh specifier, the minute rather than the month is displayed. 
mm          Displays the month as a number with a leading zero (01-12). If the mm specifier immediately 
follows an h or hh specifier, the minute rather than the month is displayed. 
mmm         Displays the month as an abbreviation (Jan-Dec) in the language of the current Windows 
locale. 
mmmm        Displays the month as a full name (January-December) in the language of the current 
Windows locale. 
yy          Displays the year as a two-digit number (00-99). 
yyyy        Displays the year as a four-digit number (0000-9999). 
h           Displays the hour without a leading zero (0-23). 
hh          Displays the hour with a leading zero (00-23). 
n           Displays the minute without a leading zero (0-59). 
nn          Displays the minute with a leading zero (00-59). 
s           Displays the second without a leading zero (0-59). 
ss          Displays the second with a leading zero (00-59). 
z           Displays the millisecond without a leading zero (0-999). 
zzz         Displays the millisecond with a leading zero (000-999). 
t           Displays the time using the short time format specified in the regional settings in the Windows 
Control Panel. 
tt          Displays the time using the long time format specified in the regional settings in the Windows 
Control Panel. 
am/pm       Uses the 12-hour clock for the preceding h or hh specifier, and displays õamõ for any hour 
before noon, and õpmõ for any hour after noon. The am/pm specifier can use lower, upper, or mixed case, 
and the result is displayed accordingly. 
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a/p         Uses the 12-hour clock for the preceding h or hh specifier, and displays õaõ for any hour before 
noon, and õpõ for any hour after noon. The a/p specifier can use lower, upper, or mixed case, and the result is 
displayed accordingly. 
/           Displays the date separator character specified in the regional settings in the Windows Control 
Panel. 
:           Displays the time separator character specified in the regional settings in the Windows Control 
Panel. 
'xx'/"xx"   Characters enclosed in single or double quotes are displayed as-is, and do not affect 
formatting. 

Edit|Insert Matching Bracket  

The Insert Matching Bracket command is only available when bracket matching is enabled in the syntax 
coloring section of the file type configuration for the active fileõs file type. The syntax coloring scheme 
determines exactly which brackets are matched. See that section in this help file to learn how bracket 
matching works in EditPad Pro. 

Just like the syntax coloring scheme determines which brackets are matched, it also determines what is 
inserted by the Insert Matching Bracket command. When an unclosed opening bracket is highlighted, the 
corresponding closing bracket is inserted. When an unmatched closing bracket is highlighted, the 
corresponding opening bracket is inserted. The HTML and XML schemes insert matching opening and 
closing tags. 

The Insert Matching Bracket command is intended to be used while typing with minimal cursor movement. 
If you wanted to type "this <b>bold</b> word" into an HTML file, you would first type "this <b>bold", 
then use Edit|Insert Matching Bracket, and then type ò wordó. When you use Edit|Insert Matching Bracket, 
the cursor is automatically placed after the inserted tag. 

Do not use Insert Matching Bracket immediately after typing "this <b>". Though it may seem neat to close 
the bold tag immediately, before typing its contents, this requires unnecessary cursor movement. Youõd end 
up with the cursor after "this <b></b>ò requiring you to move the cursor back over the ó</b>" tag, then 
type òboldó, then move the cursor forward over "</b>ò and then type ó word". Since EditPad Pro 
automatically highlights the "<b>" tag as long as it is unclosed, there is no need to close it immediately. 
Simply leave it unclosed until you have typed in everything you want between the tag, and then use 
Edit|Insert Matching Bracket. 

If you use Insert Matching Bracket when an unmatched closing bracket is highlighted, it inserts the matching 
opening bracket. The cursor is then placed to the left of the bracket that was inserted. This way you can easily 
use Edit|Insert Matching Bracket repeatedly to insert multiple opening brackets. E.g. if you type 
"unclosed)}] " into a C++ file, then put the cursor before òunclosedó, and then use Edit|Insert Matching 
Bracket three times, youõll get "[{(unclosed)}] ". 

The Insert Matching Bracket command can match up an unmatched bracket even when matching brackets 
are highlighted. In the C statement if (a == b) && (c == d))  the last )  is unmatched. If you put the 
cursor before the first ( , EditPad Pro will highlight it as being matched with the )  after b. This clearly shows 
that the if  statement isnõt properly enclosed in parentheses. If you use Edit|Insert Matching Bracket with 
the cursor at this position, EditPad Pro looks for the nearest unmatched bracket. In this case that is the 
final )  in the statement. EditPad Pro inserts ( , correctly completing if ((a == b) && (c == d)) . 



 
 

24 

Edit|Duplicate Line  

Duplicates the line the text cursor is on. 

If you use the menu item or toolbar button to invoke this command, it will be invoked on EditPadõs main 
editor, where you edit files. If you press the shortcut key on the keyboard, it will be invoked on whichever 
editor is showing the text cursor (vertical blinking bar), whether thatõs the main editor, the search box or the 
replace box. 

Edit|Insert Page Break 

Select Insert Page Break from the Edit menu or press Ctrl+Enter to insert a page break into the current file at 
the current position of the text cursor. 

A page break will show up as a horizontal line while you edit the file in EditPad Pro. When you print the file, 
a new page will be started at the page break. The first paragraph below the horizontal line indicating the page 
break, will be the first paragraph on the new page. 

Edit|Delete  

Deletes the selected part of the current file. If nothing is selected, or when selections are persistent, the 
character to the right of the cursor is deleted. 

This command is always invoked on whichever editor is showing the text cursor (vertical blinking bar), 
regardless of whether you use the main menu, a toolbar button, or a keyboard shortcut. 

Edit|Delete Line  

Selects the line the text cursor is currently on, and deletes it. If the cursor is on the first line of a folded block 
of lines, indicated by a square with a + in it in the left margin, then all the lines folded underneath the current 
line are also deleted. 

If you use the menu item or toolbar button to invoke this command, it will be invoked on EditPadõs main 
editor, where you edit files. If you press the shortcut key on the keyboard, it will be invoked on whichever 
editor is showing the text cursor (vertical blinking bar), whether thatõs the main editor, the search box or the 
replace box. 
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3. Project Menu 

About EditPad Pro Projects 

An EditPad Pro Project is a series of files that you can open all at once through Project|Open Project. If you 
regularly work with a set of related files, it is convenient to create a project file for them. You could have a 
project for your web site, for the source code of an application you are working on, the chapters of your next 
book, etc. 

When you start EditPad Pro, it opens with an untitled project containing one untitled blank file. To create a 
project, simply open all the files that should be in the project. If you already have some files open that you 
donõt want to be in the new project, select Project|New Project in the menu before opening the files. After 
opening the files, save the project with Project|Save Project As. From that point on, EditPad Pro 
automatically maintains the project. Whenever you open new files into the project, or close files, the projectõs 
file list is updated. 

If you prefer to actively manage the list of files in the project, turn on the Managed Project option in the 
Project menu. Then you can use the commands below that item to add files to the project or remove them. 
You can still open and close files as usual using the File menu, but opened files wonõt be added to the project, 
and closed files wonõt be removed. 

Project files also keep track of the last editing position, bookmarks and editing options for each file in the 
project. When you reopen a project the next time you start EditPad Pro, it will be in exactly the same state as 
it was in when you last closed the project. EditPad Pro will not bother you with prompts to save the project. 

You can have as many projects open at the same time as you want. Creating a new project or opening an 
existing one does not close the files or projects that you already have open. By default, once you have two or 
more projects open, a second row of tabs will appear above the row of tabs for files. The new row of tabs 
allows you to switch between open projects. The tabs for files will list only those files that are part of the 
active project. Tabs can be configured in the Tabs Preferences. 

Project|New Project 

Select New Project in the Project menu to start with an untitled project containing a blank, untitled file. 

An untitled project is simply a holding space for files. When working with lots of files at the same time, itõs 
often handier to create a bunch of untitled, temporary projects to hold different sets of files. Instead of 
having one long row of tabs for all the files, youõll have one row of tabs for the projects, and one row of tabs 
showing only the files in the active project. Itõs often faster to switch between files by clicking on one project 
tab and on one file tab, than to scroll through a long list of file tabs. 

If you regularly work with the same set of files, save the project with Project|Save Project As. From that 
point on, EditPad Pro automatically maintains the project. Whenever you open new files into the project, or 
close files, the projectõs file list is updated. 

If you prefer to actively manage the list of files in the project, turn on the Managed Project option in the 
Project menu. Then you can use the commands below that item to add files to the project or remove them. 
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You can still open and close files as usual using the File menu, but opened files wonõt be added to the project, 
and closed files wonõt be removed. 

Project|Open Project 

Opens an EditPad Pro Project saved with Project|Save Project. Click the Project|Open Project item directly 
to show a file selection window from which to select the .epp  file. Or use the submenu of the Project|Open 
Project item to reopen a recently closed project. Opening a project removes it from the Project|Open 
submenu. Closing a project adds it to the top of the Project|Open submenu. You can manage the 
Project|Open Project submenu just like the File|Open submenu. 

You can have as many projects open at the same time as you want. Opening a project does not close any 
projects that are already open. If you opened individual files before opening the project, those files are in an 
untitled project that will remain open. If the active project is untitled and holds only a blank untitled file, then 
the blank project is closed when you open a project. 

Each file can be open only once in a single EditPad instance. If the project youõre opening holds a file that is 
already open in another project that is open in EditPad, the file is closed in the other project. If that project is 
unmanaged, that causes the file to be removed from the other project. If the other project is managed, the file 
is still closed in that project, but it remains part of it. The fileõs options, cursor position, and any unsaved 
changes are all preserved. The file is closed in the other project and moved òas isó to the newly opened 
project. 

Project|Favorite Projects  

The Project|Favorite Projects menu works just like the File|Favorites menu, except that it lists EditPad Pro 
project files rather than text files. You have to save a project before you can add it to the favorites. 

Project|Save Project As 

Select Save Project As from the Project menu to save the current project under a different name. From that 
point on, EditPad Pro will automatically maintain the project, updating the file you saved it into. Whenever 
you open new files into the project, or close files, the project is updated. If the project was previously saved 
under another name, the old project file will not be updated unless you reopen the old project. 

You only need to use Save Project As when you want to save an untitled project, or you want to create a new 
copy of a previously saved project. There is no need to repeatedly save projects under the same name to 
prevent losing changes like you would do with files. EditPad Pro always saves project files automatically when 
the state of the project changes as soon as youõve saved the project once to give it a file name. 

Project|Save All Files in Project 

Rapidly performs a File|Save for each open file in the current project. 
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For untitled files, File|Save As is invoked. If you click on Cancel in the save as dialog box, the save all 
function will not save any further files either. 

Project|Open Folder 

Select Open Folder from the Project menu to 
open all files or files of a certain type from a 
particular folder. 

You can type in the path to the folder 
containing the files you want to open into the 
drop-down list at the top. If you have 
recently opened files from this folder, you 
can select it from the drop-down list. EditPad 
Pro remembers the last 16 folders. Another 
way to select the folder is to browse for it 
using the folder tree. The drop-down list and 
folder tree are automatically kept in sync. 

Mark the option òrecurse through 
subfoldersó if you also want to open files 
contained in subfolders of the folder you 
selected. 

If you want to open all files in the folder (and 
optionally its subfolders), select the òall filesó 
option. If you want to open only files from a 
certain type, you can select òfiles of typeó and 
pick one of the file types from the drop-
down list. The list will contain all the file 
types you defined in Configure File Types. 
This will open all files that match the file 
typeõs file mask. 

To open files matching another list of 
extensions, select òfile maskó and type in the list of extensions or file masks, separated by semicolons, into 
the òfile maskó drop-down list. You can also select a recently used file mask from the drop-down list. 

If you choose the òregular expressionó option, then the regular expression must find a (partial) match in the 
name of a file for it to be included in the search. This regex is used to filter files by their names only. If you 
want to search through the contents of the files, use the Find on Disk command in the Search menu instead 
of the Open Folder command. 

Tick òcreate new projectó to open the files into a new, untitled project. This is the same as using Project|New 
Project before using Project|Open Folder. 

Tick òopen the filesó to make EditPad Pro actually open all of the files. If you turn this off, then òadd files to 
the projectó is automatically turned on, and EditPad Pro adds the files to the project without opening them. 
The files will show up in the Files Panel as closed files. Since only managed projects can contain closed files, 
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turning off òopen the filesó automatically changes the current or the new project that the files are added into 
a managed project. 

Tick òadd the files to the projectó to add the files to the project. If you turn this off, then òopen the filesó is 
automatically turned on, and the files will be opened as outside files, without adding them to the project. 
Since only managed projects can have files open that arenõt part of the project, turning off òadd the files to 
the projectó automatically changes the current or the new project that the files are opened into a managed 
project. 

Recently Opened Folders 

The Open Folder item has a submenu that lists recently opened folders. Each time you use Project|Open 
Folder, the opened folder is added to top of this submenu. Though the menu shows only the folderõs path, all 
the settings from the Open Folder window are remembered by the menu. Select Maintain List in the 
submenu to see the settings used for each folder. When you select one of the remembered folders, EditPad 
Pro opens the files contained by that folder, using the same file mask and other options as you last used for 
that folder. If you have opened files from this folder more than once, the folder will appear only once in the 
Reopen Folder menu, with the most recently used settings. 

òRemove Obsolete Foldersó removes all folders that no longer exist from the Open Folders submenu. 
EditPad Pro does not check whether the folders still contain any files matching the file mask. EditPad Pro 
only checks whether the folders themselves still exist. òRemove All Foldersó clears the Open Folders 
submenu. 

Project|Managed Project 

New projects created with Project|New Project are always unmanaged projects. The blank project that 
EditPad Pro starts up with is also unmanaged. If you used EditPad Pro 6 in the past, projects in EditPad Pro 
6 were always unmanaged. 

In EditPad Pro 7, an unmanaged project means that you wonõt be explicitly managing which files are part 
of the project and which arenõt. The project simply consists of the files that you have open in the project. 
Opening a file automatically adds it to the project, and closing a file automatically removes it from the project. 

Unmanaged projects are a great way to keep groups of files that you are working with, without requiring any 
extra effort from you. Simply save the project once to give it a file name. From then on, EditPad Pro 
automatically updates the project. The project will always open the set of files you had open in it last time. 

A managed project means that EditPad Pro expects you to manage which files are part of the project, and 
which arenõt. A managed project can contain three kinds of files: open files are part of the project and are in 
EditPad; closed files are part of the project, but are not open in EditPad; outside files are not part of the 
project, but are open under the projectõs tab in EditPad. If you close a managed project and then open it 
again, the òopen filesó are opened again, the òclosed filesó are not opened but remain part of the project, and 
the outside files are gone (they may still exist as separate files, but the project wonõt remember them). Open 
files and outside files have their own tabs under the projectõs tab. Closed files do not have tabs until you open 
them again. 



 
 
29 

In the Files Panel, all files in unmanaged projects, and open files in managed projects are listed using a plain 
font. Outside files in managed projects are listed in italics. Closed files in managed projects are listed with a 
dimmed font. Closed files may not be listed at all if you turned off the option to show closed files in the Files 
Panel. Double-clicking a closed file opens it. 

Managed projects take a bit more effort. Itõs worth it for projects that consists of large sets of files because a 
managed project doesnõt force you to open all the files that it contains. You can quickly access closed files 
from the Files Panel and you can even search through closed files without opening them (as long as the 
project is open). Managed projects are also great for preventing accidental changes. Files are opened as 
outside files, and closing files doesnõt remove them. The list of files in the project remains the same, unless 
you explicitly add files to the project or remove files from the project. 

To turn an unmanaged project into a managed one, select the Managed Project item in the Project menu or 
click the corresponding toolbar button. The icon on the projectõs tab changes from the red unmanaged 
project icon to the blue managed project icon. All files that were open in the unmanaged project become part 
of the managed project as open files. 

You can turn a managed project back into an unmanaged one by selecting the Managed Project item in the 
Project menu again. If the managed project consisted of open files only, all that happens is that the icon on 
the projectõs tab changes from blue to red to indicate the project is unmanaged. If the managed project 
contained closed files and/or outside files, EditPad Pro will ask what you want to do with those files. 

 

Unmanaged projects cannot contain closed files. If you try to turn a managed project that contains closed 
files into an unmanaged project, you need to choose what to do with the closed files. If you select to open 
them, the closed files will be opened and remain part of the unmanaged project as open files. If you select to 
remove them, the closed files are removed from the project. They will remain as individual files on your hard 
disk. 

Unmanaged projects cannot have outside files. If you try to turn a managed project that has outside files into 
an unmanaged project, you need to choose what to do with the outside files. If you select to keep them open, 
the outside files remain open and will be added to the unmanaged project as open files. If you select to close 
them, the outside files are closed and removed from the project. They will remain as individual files on your 
hard disk. 
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The project menu offers several commands that you can use to handle open files, closed files, and outside 
files in managed projects: 

Add to Project: Select files from disk to be opened and added to the project as open files. 
Add to Project Unopened: Select files from disk to be added to the project as closed files. 
Add Active File: If the active file is an outside file, add it to the project as an open file. 
Add Outside Files: If the project has one or more outside files, add all of them to the project as open files. 
Open Closed Files: If the project contains one or more closed files, open them all. 
Remove From Project: Close the active file and remove it from the project. 
Remove Closed Files: If the project contains one or more closed files, remove them all from the project. 
Close Outside Files: If the project has one or more outside files, close them all and remove them from the 
project. 
Close All Files: Close all files in the project. If the project has outside files, those are removed from the 
project. Open files remain part of the project as closed files.  

Project|Add to Project 

The Add to Project command in the Project menu works like the File|Open command with two small but 
important differences. 

If the active project is a managed project, files opened with Project|Add to Project are opened and added to 
the project as open files. Files opened with File|Open are opened as outside files that are not part of the 
project. If you close the managed project and then reopen it, files opened with Project|Add to Project are 
opened again along with the project, while files opened with File|Open are not remembered by the project. 

If you have already opened files with File|Open and they now appear as outside files in your managed 
project, you can use Project|Add Outside Files to make them part of the project. 

If the active project is an unmanaged project, then there is no difference between opening files using 
File|Open or Project|Add to Project. Both commands add the files and open files to unmanaged projects. 

The other difference is the submenu with recently closed files. This applies to both managed and unmanaged 
projects. The File|Open submenu lists files that were opened and then closed in any project, including 
untitled projects that were never saved. This list is saved by EditPad along with its general settings and history 
information. The Project|Add to Project submenu lists files that were opened and then closed in the current 
project only. This list is saved in the .epp  project file. 

If you havenõt worked with a particular project for a while, any files that you had open in that project and 
then closed will have long dropped off the 100 files that the File|Open submenu remembers. But when you 
open that project again, the Project|Add to Project submenu will still remember the last 100 files you closed 
while working with that project. 

The File|Open and Project|Add to Project submenus remember all files that were closed even if you didnõt 
use that menu item to open them. For example, if you double-click on a file in Windows Explorer and then 
close the file, it will be listed at the top in both File|Open and Project|Add to Project. If you then switch to 
another project, the file will still be at the top in File|Open but wonõt be in the Project|Add to Project 
submenu for the project you switched to. Files that are opened in bulk such as by using Project|Open Folder 
are not remembered by either menu. 
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Project|Add to Project Unopened 

The Add to Project Unopened command in the Project menu shows a file selection window just like 
File|Open and Project|Add to Project. Unlike these two commands, Add to Project Unopened does not 
open any files. The selected files are added to the project as closed files. 

Only managed projects can contain closed files. If the active project is unmanaged, using the Add to Project 
Unopened command automatically turns the project into a managed one, as if you had selected 
Project|Managed Project in the menu. 

Project|Add Active File 

The Add Active File command in the Project menu is only available if the active project is managed and the 
active file is an outside file. An òoutside fileó is a file that is open under the projectõs tab, but is not actually 
part of the project. When a project is closed and reopened, outside files are not remembered. Use the Add 
Active File command to make the file a part of the project, so it will be remembered by the project. 

If the active project has many outside files, you can use Project|Add Outside Files instead if you want to 
make them all part of the project. 

Project|Add Outside Files 

The Add Outside Files command in the Project menu is only available if the active project is managed and it 
has one or more outside files. An òoutside fileó is a file that is open under the projectõs tab, but is not actually 
part of the project. When a project is closed and reopened, outside files are not remembered. Use the Add 
Outside Files command to make all such files part of the project, so they will be remembered by the project. 

If you want to add some of the outside files but not all of them, use the Project|Add Active File to add them 
one by one. 

Project|Open Closed Files 

The Open Closed Files command in the Project menu is only available if the active project is managed and it 
has one or more closed files. A òclosed fileó in a managed project is a file that was closed but is still part of 
the project. The Open Closed Files command opens all such files in the active project. 

If you want to open some, but not all, closed files in a managed project, use the Files Panel. If you want to 
search through all files in a managed project, there is no need to open closed files. Simply turn on the Closed 
Files search option to search through all files that are part of the project, whether they are open or closed. 

The Open Closed Files command is not available for unmanaged projects, because closing a file in an 
unmanaged project automatically removes it from the project. For managed projects, the Open Closed Files 
command does not reopen files that were removed from managed projects with Project|Remove From 
Project and does not reopen outside files that were not part of the project when they were closed. Such files 
may still be listed in the Project|Add to Project submenu. You can use that submenu to reopen them. 
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Project|Remove from Project 

The Remove from Project command in the Project menu closes the active file and removes it from the 
project. For unmanaged projects, there is no difference between Project|Remove from Project and 
File|Close. For managed projects, files closed with Project|Remove from Project are completely removed 
from the project, while files closed with File|Close remain part of the project if they were added to the 
project. 

If you want to remove a file that is already closed from a managed project, use the Files Panel. If you want to 
remove all closed files from a managed project, use Project|Remove Closed Files. If you want to remove all 
outside files from a project, use Project|Close Outside Files. 

Files that are removed from a project are added to the File|Open and Project|Add to Project submenus that 
list recently closed files, unless the files were opened in bulk withProject|Open Folder or a similar command. 

Project|Remove Closed Files 

The Open Closed Files command in the Project menu is only available if the active project is managed and it 
has one or more closed files. A òclosed fileó in a managed project is a file that was closed but is still part of 
the project. The Remove Closed Files command removes all such files from the the active project. 

If you want to remove only some closed files from the project, use the Files Panel. 

Files that are removed from a project are added to the File|Open and Project|Add to Project submenus that 
list recently closed files, unless the files were opened in bulk withProject|Open Folder or a similar command. 

Project|Close Outside Files 

The Close Outside Files command in the Project menu is only available if the active project is managed and it 
has one or more outside files. An òoutside fileó is a file that is open under the projectõs tab, but is not actually 
part of the project. When a project is closed and reopened, outside files are not remembered. Use the Close 
Outside Files to remove all such files from the project immediately. 

Files that are removed from a project are added to the File|Open and Project|Add to Project submenus that 
list recently closed files, unless the files were opened in bulk withProject|Open Folder or a similar command. 

Project|Close All Files 

Use the Close All command in the Project menu to close all files in the active project. The result is the same 
as if you had used File|Close for each file in the project. The project itself remains open. 

If the project is unmanaged, the files are removed from the project. 

If the project is managed, files that are part of managed projects remain part of the project as closed files. The 
Files Panel and Search Panel can show and search through files that are closed but are still part of managed 
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projects. Any outside files that were open under the projectõs tab are removed from the project, because they 
were never an actual part of the project. 

Project|Reload Files from Disk 

Select Reload Files from Disk from the Project menu to revert all open files in the active project to the status 
they had when they were last saved. This can be useful if you are viewing files that are being written to other 
programs. 

If one or more of the files in the project have unsaved changes in EditPad Pro, or if you turned on the option 
to always prompt in the Open Files Preferences, then EditPad Pro will ask you to confirm which files you 
want to reload. Files that have unsaved changes in EditPad Pro will be marked as òModifiedó in the list. 
Those changes will be lost if you reload those files. Tick the checkbox next to each file that you want to 
reload. 

Project|Save Copy of Project As 

Select Save Copy of Project As to save the project under a new name, but continue updating the project 
under its original name. Use this command if you want to save a milestone copy of the project that you can 
go back to later. EditPad Pro will not keep the copy of the project updated along with the original. The new 
copy will stay as it is, until you open it or overwrite it when saving another project. By opening the copy of 
the project, you can go back to the project in the state it was in when you saved the copy. 

Project|Rename and Move Project 

Select Rename/Move Project in the Project menu to save the project under a new name, and delete the 
original project, effectively moving the project to a new location on disk. 

Project|Import File Listing  

Select Import File Listing in the Project menu to read a list of file paths from one or more text files, and then 
open the files indicated by the paths in that list. 
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In the window that appears, click the button with the green plus symbol next to the òfiles with file listingsó 
list to select one or more text files that list the files or folders you want to search through. You can use the 
green plus button repeatedly to add files from different folders to the list. The red X button deletes the 
selected file from the list. 

Click on one of the files that you added to the òfiles with file listingsó list. EditPad Pro then shows the raw 
contents of that file in the òcontents of the selected fileó box. EditPad Pro also shows the file and folder 
paths that has detected in that file in the òfile paths found in the selected fileó list. The settings on the right 
hand side of the Import File Listings screen determine how EditPad Pro detects those paths. EditPad Pro 
automatically filters out anything that does not look like a valid path. 

Choose one of the options in the òsplit file into a list of file pathsó box to tell EditPad Pro how your list of 
paths is delimited. If your list doesnõt use a consistent delimiter, select òsearch for pathsó to tell EditPad Pro 
to extract all absolute paths from the file, regardless of any other text that may occur in the file. If you want 
EditPad Pro to extract only certain paths from the file, select one of the two òcustom regexó options and type 
in a regular expression in the box below them. The òcustom regex to search for pathsó option needs a regular 
expression that matches the paths you want to mark in the file selection. EditPad Pro uses the whole regex 
match as the path unless it contains a named capturing group called òpathó. E.g. ç^F ile=(?'path'.*) » 
extracts the paths from òFileó values in an .ini file. The òcustom regex to split fileó option needs a regular 
expression that matches the delimiters between those paths. E.g. «[ \ r \ n;]+ » allows line breaks and 
semicolons as delimiters. 

If you select òabsolute pathsó, EditPad Pro only uses fully qualified paths such as c: \ folder \ file.txt  
and \ \ server \ share \ folder \ file.txt . Any relative paths in the file listing youõre importing are 
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ignored. If you want EditPad Pro to process relative paths as well then you need to select the òpaths relative 
to this folder optionó. Type in the base folder below that option, or click the (...) button to select it from a 
folder tree. Note that if your file contains text in addition to paths, you need to use one of the òcustom 
regexó options to tell EditPad Pro how to find only the actual paths. Otherwise, EditPad Pro will treat each 
word in the text as a file name. You cannot use the òsearch for pathsó option because that option finds 
absolute paths only, regardless of the òabsolute or relative pathsó setting. 

Once youõve set the options that make EditPad Pro find the paths that you want to import, you need to tell 
EditPad Pro what you want to do with the files those paths point to. Tick òcreate new projectó to open the 
files into a new, untitled project. This is the same as using Project|New Project before using Project|Import 
File Listings. 

Tick òopen the filesó to make EditPad Pro actually open all of the files. If you turn this off, then òadd files to 
the projectó is automatically turned on, and EditPad Pro adds the files to the project without opening them. 
The files will show up in the Files Panel as closed files. Since only managed projects can contain closed files, 
turning off òopen the filesó automatically changes the current or the new project that the files are added into 
a managed project. 

Tick òadd the files to the projectó to add the files to the project. If you turn this off, then òopen the filesó is 
automatically turned on, and the files will be opened as outside files, without adding them to the project. 
Since only managed projects can have files open that arenõt part of the project, turning off òadd the files to 
the projectó automatically changes the current or the new project that the files are opened into a managed 
project. 

Recently Imported File Listings 

The Import File Listings item has a submenu that lists recently imported file listings. Each time you use 
Project|Imported File Listing, the files you imported are added to top of this submenu. If you imported a 
single file, the submenu lists the full path to the file. If you imported multiple files at once, the submenu has 
one item with a comma-delimited list listing all the file names that fit within the maximum length for a menu 
item. The submenu item remembers all the settings you made in the Import File Listings window. When you 
select one of the remembered file listings from the submenu, it is imported again using the exact same 
settings. 

òRemove Obsoleteó removes all files that no longer exist from the Import File Listings submenu. This 
removes all file listings that try to import from a file that no longer exists. If a file listing imports from files 
that still exist, but no paths can be found in those files, then the file listing is removed as well. 

Project|Export File Listing  

Select Export File Listing to save a text file that lists the full paths to all the files in the active project. The 
paths are delimited by line breaks. If the project is managed then open files, closed files, and outside files are 
all added to the exported file listing. 
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Project|Delete Project 

Select Delete Project in the Project menu to close the active project and delete the .epp  file that you saved 
with Project|Save Project As. Only the .epp  project file is deleted. The files that were open in the project are 
not deleted. 

Project|Close Project 

Closes the current project and all the files in the project. If any files in the project have unsaved 
modifications, depending on the choice you made in Open Files Preferences, EditPad will ask if you want to 
save or not, automatically save, or automatically discard the changes. When you close the last project, EditPad 
automatically starts with a new untitled project, with one blank untitled file. 

If you previously saved the project with Project|Save Project As, then the closed project is added to the top 
of the Project|Open Project submenu. You can use that submenu to quickly reopen the project. When you 
open the project again, it will show up with the same set of open files as you had open when you closed the 
project. The only exception are outside files in managed projects. Since outside files arenõt part of the project, 
they arenõt remembered by it and arenõt reopened when you reopen the project. 

If you did not previously save the project, it will be closed without asking you whether you want to save it. If 
you want to work with the same set of files again, youõll have to reopen the files separately. 

Project|Close All but Current 

Closes all projects and all the files in them, except for the current project, as if you used Project|Close Project 
on each of those projects. 
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4. Search Menu 

Search|Prepare to Search 

Use the Prepare to Search command in the Search menu to enter a search term that you can then use for 
searching or for searching and replacing. Its default keyboard shortcut is Ctrl+F. Exactly what the Prepare to 
Search command does depends on the state EditPad is in and on your preferences. 

EditPad provides two search interfaces. When you start EditPad the first time, the search toolbar is docked 
to the bottom of EditPadõs window. The search toolbar provides all of EditPadõs search and replace 
commands. It has two combo boxes for entering a short single-line search term and replacement text. You 
can show or hide the search toolbar by right-clicking on any toolbar or the main menu and selecting Search. 

 

If you use the Multi-Line Search Panel command, EditPad switches to the full search panel. This panel has 
two large multi-line edit controls for entering the search term and the replacement text. It also incorporates 
the search toolbar with all the search and replace commands, but without the two drop-down lists. 

 

If  the full search panel is visible, the Prepare to Search item puts keyboard focus in the edit box for the search 
term. If the search panel is not visible but the search toolbar is visible, Prepare to Search puts keyboard focus 
in the combo box for the search term. If the search panel and search toolbar are invisible, Prepare to Search 
opens the full search panel and puts keyboard focus in the edit box for the search term. 

If the òuse the current word or the selected text as the default search textó preference is turned on, then the 
Prepare to Search command uses the selected text as the default search term, as long as the selection does not 
span multiple lines. If there is no selection, then the word under the cursor is used as the default search term. 
If there is no selection and no word under the cursor, then the last used search term stays in place. If the 
preference is turned on, the last used search term always stays in place. The Prepare to Search command 
always selects the search term. You can replace the search term directly by typing in a new one. 

If the òautomatically turn on óselection onlyò when multiple lines of text are selectedó preference is turned 
on, then the Prepare to Search command automatically turns on the Selection Only or Block search option 
when there is a selection that spans multiple lines. When the preference is off, the state of this option is 
unchanged. 
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Search|Multi -Line Search Panel 

EditPad provides two search interfaces. When used by itself, the search toolbar is docked to the bottom of 
EditPadõs window. The search toolbar provides all of EditPadõs search and replace commands. It has two 
combo boxes for entering a short single-line search term and replacement text. 

 

The full search panel has two large multi-line edit controls for entering the search term and the replacement 
text. It also incorporates the search toolbar with all the search and replace commands, but without the two 
drop-down lists. 

 

When you start EditPad for the first time, only the search toolbar is visible. You can switch to using the full 
search panel by selecting Multi-Line Search Panel in the Search menu. You can switch back to using the 
search toolbar only by using Multi-Line Search Panel again. 

When the search toolbar is visible but the full search panel is not, you can hide the search toolbar by right-
clicking on any toolbar or the main menu and selecting Search. When both the search toolbar and search 
panel are invisible, the Multi-Line Search Panel makes both visible as usual, but using Multi-Line Search Panel 
again will hide both the search toolbar and search panel again. If you want to bring back the search toolbar 
without the full search panel, right-click again on any toolbar or the main menu and select Search again. 

To summarize: EditPad has 3 modes for its search interface: toolbar and panel hidden, toolbar visible alone, 
panel with toolbar visible. The Multi-Line Search Panel command switches from one of the first 2 modes to 
the òpanel with toolbar visibleó mode, and back to whichever of the first 2 modes you were using. Right-
clicking on a toolbar and selecting Search switches between the first two modes. 

Both the search and replace edit boxes on the search panel are full-blown multi-line edit controls, just like 
EditPadõs main editor. They provide syntax coloring for regular expressions and match placeholders. Press 
Shift+Enter on the keyboard to type in and search for or replace with a newline. To type in a tab, press 
Shift+Tab. To switch from search to replace and back, press Tab. 

If you right-click on the search or replace edit box, you will see a list of the last 16 search or replace texts you 
used. Click on one to use it again. 

Search|Find First 

After using Prepare to Search or pressing Ctrl+F and entering a search term, click the Find First button on 
the search toolbar or select the Find First item in the Search menu to find the first search match. If the 
òselection onlyó option is on, Find First starts searching from the start of the search range. If òall filesó is on, 
Find First starts searching from the start of the first file in the current project. If òall projectsó is on, Find 
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First starts searching from the start of the first file in the first project. If none of these three options are on, 
Find First starts searching from the start of the current file. 

If the search term can be found, EditPad will switch to the file it was found in, and select the matched text. If 
the search term cannot be found, nothing will happen, except that the Find First button will briefly flash its 
icon to indicate it failed. 

In EditPad Pro, the Find First button on the search toolbar has a drop-down menu. This drop-down menu 
has three items that you can use to find a specific search match, counting search matches from the start. The 
Find 10th item will find the 10th search match. It start searching from the beginning to find the first search 
match, and immediately continues to find the second, third etc. until it arrives at the 10th match. The 10th 
match will then become selected. If there are less than 10 search matches, nothing will happen, and the Find 
First button will briefly flash its icon to indicate the search failed. Similarly, the Find 100th item will skip the 
first 99 search matches and select match #100. 

The Find Nth item will ask you for the number of the match you want to find. If you enter 42, EditPad will 
skip the first 41 search matches, and highlight the 42nd. 

Search|Find Next 

After using Prepare to Search or pressing Ctrl+F and entering a search term, click the Next button on the 
search toolbar or select the Find Next item in the Search menu to find the next search match. If the edit box 
for entering the search term still has keyboard focus, you can also find the next search match by pressing 
Ctrl+F again or by pressing Enter. 

Find Next starts searching from the current position of the text cursor in the current file. If the òselection 
onlyó option is on, Find Next searches until the end of the search range. If òall filesó is on, Find Next 
searches until the end of the file and then continues at the start of the next file until a search match is found. 
If òall projectsó is on, and Find Next reaches the last file in the current project, Find Next will continue with 
the next project. 

If the search term can be found, EditPad will switch to the file it was found in, and select the matched text. If 
the search term cannot be found, nothing will happen, except that the Next button will briefly flash its icon 
to indicate it failed. 

In EditPad Pro, the Next button on the search toolbar has a drop-down menu. The first item in the drop-
down menu is Find in Next File. When you select this item, EditPad will start searching from the start of the 
next file. You can use Find in Next File even when the  òall filesó option is off. If the search term cannot be 
found in the next file, and one or more of the òall filesó, òall projectsó and òloop automaticallyó options are 
on, EditPad will continue the search just like the Find Next command itself. 

The drop-down menu also has three items that you can use to find a specific search match, counting search 
matches from the start. The Find 10th Next item will skip over the next 9 search matches and highlight the 
10th. The result is the same as if you had clicked the Next button 10 times. If there are no further 10 search 
matches, the result is slightly different. Find Next 10th will then not do anything, except flash the Next 
button to indicate failure. Similarly, the Find 100th Next item will skip the next 99 search matches and select 
match #100. 
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The Find Nth Next item will ask you for the number of the match you want to find. If you enter 42, EditPad 
will skip the next 41 search matches, and highlight the 42nd. 

Search|Find Previous 

After using Prepare to Search or pressing Ctrl+F and entering a search term, click the Previous button on the 
search toolbar or select the Find Previous item in the Search menu to find the previous search match. Find 
Previous starts searching from the current position of the text cursor in the current file. If the òselection 
onlyó option is on, Find Previous searches until the start of the search range. If òall filesó is on, Find Previous 
searches until the start of the file and then continues at the end of the previous file until a search match is 
found. If òall projectsó is on, and Find Previous reaches the first file in the current project, Find Previous will 
continue with the previous project. 

If the search term can be found, EditPad will switch to the file it was found in, and select the matched text. If 
the search term cannot be found, nothing will happen, except that the Previous button will briefly flash its 
icon to indicate it failed. 

The Find Previous command is not available in regular expression mode. Regular expressions cannot search 
backwards. 

In EditPad Pro, the Previous button on the search toolbar has a drop-down menu. The first item in the drop-
down menu is Find in Previous File. When you select this item, EditPad will start searching from the end of 
the previous file. You can use Find in Previous File even when the  òall filesó option is off. If the search term 
cannot be found in the previous file, and one or more of the òall filesó, òall projectsó and òloop 
automaticallyó options are on, EditPad will continue the search just like the Find Previous command itself. 

The drop-down menu also has three items that you can use to find a specific search match, counting search 
matches from the start. The Find 10th Previous item will skip over the next 9 search matches and highlight 
the 10th. The result is the same as if you had clicked the Previous button 10 times. If there are no 10 
preceding search matches, the result is slightly different. Find 10th Previous will then not do anything, except 
flash the Previous button to indicate failure. Similarly, the Find 100th Previous item will skip the previous 99 
search matches and select match #100. 

The Find Previous Nth item will ask you for the number of the match you want to find. If you enter 42, 
EditPad will skip the 41 preceding search matches, and highlight the 42nd. 

Search|Find Last 

Select the Find Last item in the Search menu to find the last search match. If the òselection onlyó option is 
on, Find Last starts searching from the end of the search range. If òall filesó is on, Find Last starts searching 
from the end of the last file in the current project. If òall projectsó is on, Find Last starts searching from the 
end of the last file in the first project. If none of these three options are on, Find Last starts searching from 
the end of the current file. Find Last searches backwards until a match is found. 

If the search term can be found, EditPad will switch to the file it was found in, and select the matched text. If 
the search term cannot be found, nothing will happen, except that the First button on the search panel will 
briefly flash its icon to indicate it failed. Since thereõs no Last button, the First button flashes instead. 
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In EditPad Pro, the Find Last command is also available through the drop-down menu of the First button on 
the search panelõs toolbar. 

The Find Last command is also available in regular expression mode, even though regular expressions cannot 
search backwards. Instead of starting at the end of the file, EditPad Pro starts searching at the start of the file 
and searches forward, skipping over all regex matches until it finds the last one. This means the Find Last 
command will be noticeably slower on large files when used with a regular expression rather than a plain 
search term. 

Search|Replace Current 

After finding a search match with Find First, Find Next, Find Previous, or any of the other search 
commands, click the Replace button on the search toolbar or select the Replace Current item in the Search 
menu to replace the selected search match with the replacement text. 

Search|Replace and Find Next 

After finding a search match, click the Next button to the right of the Replace button on the search toolbar 
or select the Replace and Find Next item in the Search menu to replace the selected search match with the 
replacement text, and to immediately continue searching for the next search match. This button is a shortcut 
to clicking the Replace button followed by clicking the Find Next button. 

Search|Replace and Find Previous 

After finding a search match, click the Previous button to the right of the Replace button on the search 
toolbar or select the Replace and Find Previous item in the Search menu to replace the selected search match 
with the replacement text, and to immediately continue searching for the previous search match. This button 
is a shortcut to clicking the Replace button followed by clicking the Find Previous button. 

The Replace and Find Previous command is not available in regular expression mode. Regular expressions 
cannot search backwards. 

Search|Replace All 

After using Prepare to Search or pressing Ctrl+F and entering a search term and replacement text, click the 
Replace All button on the search toolbar or select the Replace All item in the Search menu to find the first 
search match. Replace All starts searching from the beginning just like Find First does. If it finds a match, it 
replaces it like Replace Current would, and then continues searching like Find Next would, replacing all 
further search matches. 

The only difference between clicking Replace All and using all the individual action buttons is that Replace 
All is silent. It will simply replace all matches without moving the selection or the text cursor. Even when 
searching through all projects or all files, the current file will remain active throughout the operation. 
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If no search matches can be found, EditPad will briefly flash the Replace All buttonõs icon to indicate failure. 
If you used the keyboard shortcut to do the Replace All with the search panel hidden, check the status bar for 
the result. 

If there are a lot of search matches, replacing them all might take a while. The status bar will indicate 
EditPadõs progress. 

In EditPad Pro, the Replace All button on the search toolbar has a drop-down menu with two items: Replace 
All Next and Replace All Previous. Replace All Next performs the search-and-replace on the part of file after 
the position of the text cursor. If a search match is already highlighted, that match is replaced too. Effectively, 
Replace All Next does in one click what you can do by clicking Replace and Find Next until no further 
matches can be found. 

The Replace All Previous button does the same, except that is searches backwards, performing the search-
and-replace on the part of the file before the position of the text cursor. If a search match is already 
highlighted, that match is replaced too. Replace All Previous is not available in regular expression mode. 
Regular expressions cannot search backwards. 

Search|Highlight All  

After using Prepare to Search or pressing Ctrl+F and entering a search term, click the Highlight button on 
the search toolbar or select the Highlight All item in the Search menu to turn on the search match 
highlighting mode. In this mode, all search matches will be highlighted. The Selection Only option is ignored. 
You can configure the òhighlighted search matchó color in Options|Configure File Types|Colors. 

When you switch between files, search matches in the newly activated line will be highlighted, regardless of 
the òall filesó setting. To stop highlighting search matches, simply click the Highlight button again. 

Search|Instant Highlight  

The Instant Find Next command doesnõt have a button on the search toolbar because it doesnõt use the 
search term youõve entered on the search panel or any of the search options. It is listed in the Search menu, 
primarily so you can assign it a keyboard shortcut in the Keyboard Preferences. The default shortcut is 
Ctrl+Alt+H, which is the most instant way of doing an Instant Highlight. If you turn on the òdouble-clicking 
a word instantly highlights all occurrences of that wordó search preference, then double-clicking a word also 
turns on Instant Highlight. 

Select Instant Highlight in the Search menu to highlight all occurrences of the selected text or the word under 
the cursor, without using the search toolbar or panel. Occurrences of the word as part of longer words are 
also highlighted. Differences in case are ignored. Highlighting persists when you switch between files. All 
search options, including Case Sensitive, Whole Words Only, and All Files, are ignored. 

Use Instant Highlight with the same selection or on the same word to turn it off. Only one search term can 
be highlighted at any time. If you use both Highlight All and Instant Highlight, using either command turns 
off the other. 
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Search|Incremental Search 

Click the Incremental button on the search toolbar or select the Incremental item in the Search menu to 
toggle incremental search mode on or off. When off, entering a search term has no immediate effect. When 
on, editing the search term will cause EditPad Pro to immediately start looking for the next search match, 
starting from the current position of the text cursor. 

While you edit the search term in incremental search mode, EditPad Pro remembers previous search matches 
as you type. If you type òTestó, EditPad Pro will search for òTó starting from the position of the text cursor. 
As you type, it will search for òTeó beginning at the start of the match for òTó, then for òTesó at the start of 
the match for òTeó, and finally for òTestó. If there is no search match, nothing happens. 

When you press Backspace, EditPad Pro will go back to the previously highlighted match for òTesó. If you 
continue pressing Backspace, it will go back to the match for òTeó, òTó, and finally go back to where the 
search started. So while typing in the search term, you can easily change your mind about the search term 
youõre looking for by backing up with the Backspace key, and typing in the new search term. Backing up does 
not cause EditPad Pro to forget match positions. If you type in òJoeó after erasing òTestó, EditPad Pro will 
search for òJó until òJoeó beginning from the original starting position. If you then back up again and retype 
òTestó, the match previously found for òTestó is highlighted. 

What does cause EditPad Pro to forget previous incremental search matches is taking any action in the main 
editor, including something as trivial as moving the text cursor or switching to another file. EditPad Pro will 
then move the starting position for the next incremental search to the new position of the text cursor. 

The incremental search mode respects all search options, including òall filesó, òselection onlyó, òloop 
automaticallyó, etc. 

Search|Instant Find Next 

The Instant Find Next command doesnõt have a button on the search toolbar because it doesnõt use the 
search term youõve entered on the search panel or any of the search options. It is listed in the Search menu, 
primarily so you can assign it a keyboard shortcut in the Keyboard Preferences. The default shortcut is 
Ctrl+Alt+ArrowDown, which is the most instant way of doing an Instant Find Next. 

Instant Find Next looks for the next occurrence in the current file of the word under the text cursor. When 
the word is found, Instant Find Next selects it. If there is no word under the text cursor, or it doesnõt occur 
again in the file, nothing happens at all. If some text is selected when you invoke Instant Find Next, and the 
selection does not span more than one line, Instant Find Next will search for the selected text rather than the 
word under the cursor. 

The purpose of Instant Find Next and Search|Instant Find Previous is to quickly òwalkó through the file, 
stopping at each spot where the word occurs. Since a successful match selects the word that was searched for, 
you can instantly search for further matches. 
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Search|Instant Find Previous 

Instant Find Previous works just like Instant Find Next, except that it searches backwards through the 
current file, starting at the current position of the text cursor, or the start of the selection (if any). If you press 
Instant Find Previous as many times as you pressed Instant Find Next, or vice versa, youõll be back where 
you started. 

Search|List All Matches 

After using Prepare to Search or pressing Ctrl+F and entering a search term, use the List All Matches 
command in the Search menu to display a list of all search matches with one line of context in a side panel. 
All matches in the current file, current project, or all files will be listed depending on the All Files, All 
Projects, and Closed Files search options. 

In the side panel, you can double-click a highlighted search match to activate the file it was found in and 
select the match. If you edit files after listing all matches, the stored match positions are adjusted so that 
double-clicking a search match highlights it, even if its position in the file has shifted. The actual search 
matches and their context are not updated when you edit files. Use the List All Matches command again to 
repeat the search. 

Search|Find on Disk 

After using Prepare to Search or pressing 
Ctrl+F and entering a search term, use the 
Find on Disk command in the Search menu 
to search through the files in a particular 
folder, even if you donõt have those files 
open in EditPad Pro. The disk-based search 
uses the search term and search options from 
the search toolbar or panel. Only the All 
Files, All Projects, and Closed Files search 
options are ignored. 

If the disk-based search includes files that 
you have open in EditPad Pro, then the Find 
on Disk command searches through the files 
open in EditPad Pro rather than through the 
files on disk. This means that if the files have 
unsaved changes in EditPad Pro, the unsaved 
changes are searched through rather than the 
original file on disk. 

The Find on Disk command shows a folder 
selection screen that is very similar to the one 
shown by Project|Open Folder. 
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You can type in the path to the folder containing the files you want to search through into the drop-down list 
at the top. If you have recently searched through files from this folder, you can select it from the drop-down 
list. EditPad Pro remembers the last 16 folders. Another way to select the folder is to browse for it using the 
folder tree. The drop-down list and folder tree are automatically kept in sync. 

Mark the option òrecurse through subfoldersó if you also want to search through files contained in subfolders 
of the folder you selected. 

If you want to search through all files in the folder (and optionally its subfolders), select the òall filesó option. 
If you want to search through only files from a certain type, you can select òfiles of typeó and pick one of the 
file types from the drop-down list. The list will contain all the file types you defined in Configure File Types. 
This will search through all files that match the file typeõs file mask. 

To search through files matching another list of extensions, select òfile maskó and type in the list of 
extensions or file masks, separated by semicolons, into the òfile maskó drop-down list. You can also select a 
recently used file mask from the drop-down list. 

If you choose the òregular expressionó option, then the regular expression must find a (partial) match in the 
name of a file for it to be included in the search. This regex is used to filter files by their names only. The text 
or regular expression that you want to use to search through the contents of the files needs to be specified on 
the search panel or in the search toolbar before you use the Find on Disk command. 

Tick òlist all matches in a side paneló to list all the search matches in all the files with one line of context in a 
side panel. This option makes Find on Disk work like Search|List All Matches, except that it searches 
through files on disk rather than files open in EditPad. 

Tick òcreate new projectó to open files with search matches into a new, untitled project. This is the same as 
using Project|New Project before using Search|Find on Disk. This option has no effect if òopen the filesó 
and òadd the files to the projectó are both turned off. 

Tick òopen the filesó to make EditPad Pro actually open the files in which search matches are found. If you 
turn this off, but turn on òadd the files to the projectó, then the files will show up in the Files Panel as closed 
files. Since only managed projects can contain closed files, turning off òopen the filesó automatically changes 
the current or the new project that the files are added into a managed project. 

Tick òadd the files to the projectó to add the files in which search matches are found to the project. If you 
turn this off, but turn on òopen the filesó, then the files will be opened as outside files, without adding them 
to the project. Since only managed projects can have files open that arenõt part of the project, turning off 
òadd the files to the projectó automatically changes the current or the new project that the files are opened 
into a managed project. 

Recently Searched Through Folders 

The Find on Disk item has a submenu that lists recently searched through folders. Each time you use 
Search|Find on Disk, the folder you search through is added to top of this submenu. Though the menu 
shows only the folderõs path, all the settings from the Find on Disk window are remembered by the menu. 
Select Maintain List in the submenu to see the settings used for each folder. When you select one of the 
remembered folders, EditPad Pro immediately searches though that folder, using the same settings for 
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displaying search matches and opening files. If you have searched through the same folder more than once, 
the folder will appear only once in the Reopen Folder menu, with the most recently used settings. 

The Find on Disk submenu does not remember the search term and other options set on the search toolbar 
or search panel. When you select a folder from the Find on Disk submenu, the present search term and 
search options are used. This way you can easily run different searches through the same folder. 

òRemove Obsolete Foldersó removes all folders that no longer exist from the Open Folders submenu. 
òRemove All Foldersó clears the Find on Disk submenu. 

Search|Fold Lines 

After using Prepare to Search or pressing Ctrl+F and entering a search term, click the Fold button on the 
search toolbar or select the Fold Lines item in the Search menu to fold all lines in which the search term 
cannot be found underneath lines in which it can be found. The result is that only lines in which the search 
term can be found will remain visible. The exception is the very first line in the file, which will remain visible 
even if it doesnõt have any search matches. All lines until the first line with a search match will be folded 
underneath the very first line in the file. 

If there are no search matches at all, EditPad will briefly flash the Count buttonõs icon to indicate failure. If 
there are a lot of search matches, folding them all might take a while. The status bar will indicate EditPadõs 
progress. 

Using Fold Lines together with Highlight All is a very quick way to get a condensed view of all the matches in 
the file. Unlike the match highlighting mode, Fold Lines is automatically disabled when you switch between 
files, or edit the search term. Click the Fold button again to refold the current file. Folding a file based on 
search matches deletes all automatic folding points, and all folding points that you created. When you disable 
the search match folding, new automatic folding points will appear. Also unlike match highlighting, which 
instantly updates itself, the folding is not updated as you insert or delete the search term while you edit the 
file. 

After folding the lines with search matches, you can use Fold|Copy Visible Lines to copy the lines with 
search matches to the clipboard, and Fold|Delete Folded Lines to delete the lines without search matches. 
However, since folding keeps the first line visible, the very first line in the file will be copied or remain 
behind, even if it doesnõt have any search matches. 

Search|Count Matches 

After using Prepare to Search or pressing Ctrl+F and entering a search term, click the Count button on the 
search toolbar or select the Count Matches item in the Search menu to count all search matches. Count 
Matches starts searching from the beginning just like Find First does. Then it continues searching like Find 
Next would, until the search fails. None of the search matches will be selected. After the search, Count 
Matches will tell you how many matches it found. 

If there are no search matches at all, EditPad will briefly flash the Count buttonõs icon to indicate failure. If 
there are a lot of search matches, counting them all might take a while. The status bar will indicate EditPadõs 
progress. 
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Search|Cut Matches 

After using Prepare to Search or pressing Ctrl+F and entering a search term, click the Cut button on the 
search toolbar or select the Cut Matches item in the Search menu to cut all search matches to the clipboard. 
All search matches are placed onto the clipboard delimited by line breaks. The search matches are then 
removed from the files in EditPad. 

Search|Copy Matches 

After using Prepare to Search or pressing Ctrl+F and entering a search term, click the Copy button on the 
search toolbar or select the Copy Matches item in the Search menu to copy all search matches to the 
clipboard. All search matches are placed onto the clipboard delimited by line breaks. 

Search Options 

EditPad offers 12 search options. By default all these have abbreviated buttons on the Search toolbar. You 
can toggle them with Alt+letter key combinations when the search toolbar or search panel has keyboard 
focus. 

Regular Expression (Regex) 
Dot Matches Newline (Dot) 
Case Sensitive (Case) 
Adapt Case (Adapt) 
Whole Words Only (Words) 
All Files (Files) 
All Projects (Projects) 
Closed Files (Closed) 
Selection Only (Block) 
Loop Automatically (Loop) 
Line by Line (Line) 
Inverted Line by Line (Invert) 

Search Option: Regular Expression (Regex) 

EditPadõs search-and-replace module includes a full-featured regular expression engine. Its regular expression 
flavor is compatible with popular regular expression flavors such as those used by Perl, Java, and .NET. In 
the regular expression flavor comparison, EditPadõs flavor is indicated as òJGsoftó. To search using a regular 
expression, simply turn on the regular expression search option by clicking the Regex button on the search 
toolbar. 

When using capturing groups in a regular expression, you can insert the groupsõ contents in the replacement 
text using backreferences \ 0, \ 1, \ 2, etc. \ 0 inserts the whole regex match, while \ 1 inserts the text matched 
by the first capturing group, \ 2 the second group, etc. EditPad Pro supports up to 99 backreferences. If you 
want to insert a backreference followed by a literal number into the replacement text, use two digits for the 
backreference. The replacement text \ 15 will replace the regex match with the contents of the first 
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backreference followed by the digit 5. You can also use dollar signs instead of backslashes. Thereõs no 
difference between \ 1 and $1 in the replacement text in EditPad. 

If you want to pad or control the case of backreferences, use the %GROUP1% syntax for match placeholders. 

If  you use «\ r » and «\ n» in your regex, remember that Windows text files use «\ r \ n» terminate lines. 
EditPadõs regular expression engine matches ç\ r » and «\ n» to a single CR and a single LF. If you want 
differences in line breaks to be handled automatically, use the full search panel and press Shift+Enter to type 
in an actual line break into your regular expression. EditPadõs regular expression engine will match each literal 
line break in your regular expression to either a CRLF pair, or a single LF, or a single CR. 

The caret and dollar always match at the start and the end of a line, in addition to the start and the end of a 
file. EditPad Pro does not have an option to change this. To match the start or the end of the file only, use 
\ A or \ z instead. The behavior of the dot can be changed with the òdot matches newlineó option. 

EditPad Pro does not have a search option to use free-spacing regular expressions. It does support the mode 
modifier «(?x) ». If you put «(?x) » at the very start of your regular expression, then any whitespace after the 
«(?x) » is ignored, unless it is escaped or inside a character class. 

Search Option: Dot Matches Newline (Dot) 

When searching for a regular expression, you can click the Dot button on the search toolbar to turn on the 
òdot matches newlineó search option. This option makes the dot match any character, including line break 
characters. 

Turning on this option is the same as putting the mode modifier «(?s) » at the start of your regular 
expression. If you do use the mode modifier «(?s) » or «(? - s) » then the mode modifier overrides the state 
of the checkbox. 

Search Option: Case Sensitive (Case) 

If you click the Case button on the search toolbar to turn on the òcase sensitiveó search option, then the 
difference between lowercase and uppercase letters is taken into account. E.g. òDogó will considered to be 
different from òdogó. Otherwise, òdogó, òDogó, òDOGó, and even òdoGó are all the same. 

Search Option: Adapt Case (Adapt) 

When the òcase sensitiveó option is off, you can click the Adapt button on the search toolbar to turn on the 
òadapt caseó search option. When you do so, EditPad Pro will adapt the casing of the replacement text to the 
casing of the search match to be replaced. EditPad Pro recognizes four casings: all uppercase, all lowercase, 
first letter capitalized, and first letter of each word capitalized. If EditPad Pro doesnõt recognize the casing, 
the replacement text is used exactly as you entered it. 

E.g. when searching for òMy DoGó and replacing with òMy CaTó, then òmy dogó will be replaced with òmy 
cató (all lowercase), òMY DOGó with òMY CATó (all uppercase), òMy dogó with òMy cató (first letter 
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capitalized) and òMy Dogó with òMy Cató (first letter of each word capitalized). If EditPad Pro doesnõt 
recognize the casing, e.g. òmy DOGó, then òMy CaTó is substituted the way you entered it. 

Search Option: Whole Words Only (Words) 

Click the Words button on the search toolbar to turn on the òwhole words onlyó search option if only entire 
words should be valid search results. If this option is on, when looking for òcató, EditPad will not consider 
the first three letters of òcategoryó a valid search match. Otherwise, it will. 

Search Option: All Files (Files) 

Click the Dot button on the search toolbar to turn on the òall filesó search option to search through all open 
files in the current project. If a search command cannot find a match in the current file, it will automatically 
continue with the next file until either a match is found, or all files have been searched through. 

The Fold Lines search command always works on the current file only, regardless of the òall filesó option. 
The Highlight All option is a global toggle that will always highlight the current file, even when you switch 
files, until you turn it off, regardless of the òall filesó option. All the other search commands respect the òall 
filesó option as explained above. 

Search Option: All Projects (Projects) 

To search through all open files in all open projects, click the Projects button on the search toolbar to turn on 
the òall projectsó search option. If a search command cannot find a match in the current file, it will 
automatically continue with the next file. When all files in the current project have been searched through, 
EditPad Pro will continue with the first file in the next project. EditPad Pro will continue searching until 
either a match is found, or all files in all projects have been searched through. 

The Fold Lines search command always works on the current file only, regardless of the òall projectsó option. 
The Highlight All option is a global toggle that will always highlight the current file, even when you switch 
files, until you turn it off, regardless of the òall projectsó option. All the other search commands respect the 
òall projectsó option as explained above. 

Search Option: Selection Only (Block) 

Click the Block button on the search toolbar to turn on the òselection onlyó search option to search only 
through the selected part of the current file. 

When you invoke a search command like Find First with this option on, the selection will be turned into the 
search range. The search range is highlighted in a different color than the selection. You can configure both 
the òselected textó and òsearch rangeó colors in the Colors Preferences. 
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If a search match is found, that search match will become selected. You can then edit the search match or any 
part of the file inside or outside the search range. As long as you donõt turn off the òselection onlyó search 
option, the search range will remain highlighted. 

When you invoke the next search command, and there already is a search range, EditPad will either search 
through the existing search range when no text is selected, or when the selection falls entirely inside the 
search range. If some of the text outside the search range is selected, EditPad will use the selection as the new 
search range. 

In practice, this mechanism is very intuitive. When you search, EditPad selects the search match, which 
always falls inside the search range. So you can click Search|Find Next and Search|Find Previous without 
paying much attention to the search range. It will stay put. When you want to search through a different part 
of the file, simply select it, make sure òselection onlyó is on, and search. You donõt need to check whether 
there was a search range already. EditPad will search through the block of text that you selected. 

Search Option: Loop Automatically (Loop) 

Click the Loop button on the search toolbar to turn on the òloop automaticallyó search option if you want 
Find Next, Find Previous, Replace and Find Next and Replace and Find Previous to automatically restart 
searching from the start or end of the file when no further search matches can be found. If the òall filesó 
option is on, EditPad will restart from the first file (find next) or last file (find previous) in the project. If òall 
projectsó is also on, EditPad will restart from the first file in the first project (find next), or the last file in the 
last project (find previous). 

When EditPad finds a match after having looped (i.e. restarted from the start or end), then the glyph on the 
search command button that you clicked will flash briefly, showing a òloopedó glyph. 

Search Option: Closed Files (Closed) 

When the option to search through all files or all projects is turned on, and one of the projectõs youõre 
searching through is a managed project that contains closed files, you can click the Closed button on the 
search toolbar to turn on the òclosed filesó option to search through the closed files in addition to searching 
through the open files. 

Commands that select found matches such as Find Next and commands that modify files such as Replace All 
automatically open closed files in which matches are found so that the found match can be selected or the file 
can be modified. Closed files in which no search matches are found are not opened. 

Search Option: Line by Line (Line) 

Click the Line button on the search toolbar to turn on the òline by lineó search option to search through each 
line separately, and to treat the entire line as the search match if part of it matches. This means that when this 
option is on, a search match can never span across multiple lines. Commands like Replace All and Copy 
Matches will replace or copy entire lines, even when the search term matches only part of the line. 
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Search Option: Inverted Line by Line (Invert) 

When using the Line by Line search option, you can turn on Inverted Line by Line to match all lines in which 
the search term cannot be found. Click the Invert button on the search toolbar to toggle this option. 

Search|History 

Click the History button on the search panel to switch between the currently displayed search term and 
search options, and the ones you used before. This way you can easily work with two search actions. E.g. if 
you need to do a search-and-replace in several blocks in a file, and you want to find the block by searching for 
another word, first search for the word and then do the search-and-replace in the first block. Then click the 
History button to instantly get back the search term. Find the second block, and click the History button 
again to get the search-and-replace search term and options. 

EditPadõs search function remembers up to 16 search settings. You can access them via the submenu of the 
History button. Pick a search term from the menu to use it again. All the Search Options will also be set the 
way they were when you last used the search term you just picked from the history. 

If you only want to recall the search text or the replacement text, without changing any of the search options, 
right-click on the search box or replace box. The right-click menu will list the last 16 search texts or 
replacement texts. 

Search|Favorites 

If you regularly use a particular search term, you should add it to your search favorites. To do so, select 
Search|Favorites|Add Search Term in the menu. Or, click on the downward pointing arrow next to the 
Favorites button on the search panel, and select Add Search Term in the drop-down menu. The search text, 
replacement text, and all search options will be stored in the favorites. To make it easy to differentiate 
between search terms, youõll be asked for a label when adding a favorite search term. 

If  you click directly on the Favorites button rather than the arrow next to it, the Organize Favorites screen 
will appear. Select a search term and click on the Use button to set the search text, replacement text and 
search options to those stored in the favorites item. Click the Remove button to delete a favorite. 

With the New Folder and Rename Folder, you can organize your favorite search terms into folders. 
Organizing favorites into folders makes it easier to retrieve the search term you want. To move favorites into 
a folder, simply drag-and-drop them with the mouse. 

Search|RegexBuddy 

Use regular expressions with EditPad Proõs search and replace to automate many editing task that would be 
tedious to do manually. The regex syntax is quite terse, making complex regular expressions sometimes 
difficult to interpret. 

To alleviate this complexity, we have developed a new product called RegexBuddy. RegexBuddy makes it very 
easy to write and edit regular expressions. Use RegexBuddyõs detailed and descriptive regex tree, and the easy-
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to-grasp regex building blocks instead of or in combination with the regex syntax to define your search 
patterns. 

Click the RegexBuddy button on the search panel or select the RegexBuddy item in the Search menu to start 
RegexBuddy. The search and replace texts you entered in EditPad Pro are automatically sent to RegexBuddy 
for editing. When you have prepared the new regular expression and replacement text, click the Send button 
in RegexBuddy. RegexBuddy will then close and send the new texts to EditPad Pro. If you change your mind, 
close RegexBuddy without clicking the Send button. 

You can also use RegexBuddy to test your search patterns in a safe and intuitive sandbox. Very handy is the 
ability to collect your own libraries of regular expressions. Or use RegexBuddyõs standard library of regular 
expressions for common search patterns. 

You can use RegexBuddy in combination with EditPad Pro, as well as with any other application you use 
regular expressions with. If you are a programmer, RegexBuddy has full support for a variety of programming 
languages and regex libraries. 

See http://www.regexbuddy.com for more information about RegexBuddy. 

Please note that RegexBuddy is a separate product. If you want to use RegexBuddy with EditPad Pro, you 
will need to purchase both products. 

Search|RegexMagic 

Use regular expressions with EditPad Proõs search and replace to automate many editing task that would be 
tedious to do manually. The regex syntax is quite terse, making complex regular expressions sometimes 
difficult to interpret. 

To make it easy to create regular expressions, we have developed RegexMagic. Instead of dealing with the 
cryptic regular expression syntax, use RegexMagicõs powerful patterns for matching characters, text, numbers, 
dates, times, email addresses, URLs, card numbers, etc. RegexMagic can detect these patterns when you mark 
your sample text. You can combine multiple patterns to match exactly what you want. 

Click the RegexMagic button on the search panel or select the RegexMagic item in the Search menu to start 
RegexMagic. When you have generated the new regular expression and replacement text, click the Send 
button in RegexMagic. RegexMagic will then close and send the new regulare expression to EditPad Pro. If 
you change your mind, close RegexMagic without clicking the Send button. 

Use RegexMagic in combination with EditPad Pro, as well as any other application you use regular 
expressions with. RegexMagic supports all popular regular expression flavors. If you are a programmer, 
RegexMagic has full support for a variety of programming languages and regex libraries. 

See http://www.regexmagic.com for more information about RegexMagic. 

Please note that RegexMagic is a separate product. If you want to use RegexMagic with EditPad Pro, you will 
need to purchase both products. 
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Match Placeholders 

Match placeholders can be used to insert search matches or match counts in the search text or replacement 
text. 

Placeholder Meaning and Examples Availability 

%LINE% The line the search match was found on. Replacement text. 

%LINEN% The number of the line the match was found on. Replacement text. 

%MATCH% The search match. Replacement text. 

%MATCHN% The number of the search match. Counts the number of 
search matches already found. If used in the search 
term, %MATCHN% will be zero upon the first search 
attempt. If used in the replacement text, %MATCHN% will 
be one for the first replacement. 

Search term and 
replacement text. 

%GROUP1%, 
%GROUP2%, etc. 

%GROUP1% is a backreference to a capturing group, 
equivalent to «\ 1è in a regular expression or ò\ 1ó or ò$1ó in 
the replacement text. The advantage of %GROUP1% is that 
you can use the padding and case conversion specifiers listed 
below. 

Search term and 
replacement text, but 
only when using regular 
expressions with 
numbered capturing 
groups. 

%GROUPNAME%, 
%GROUPanother%, 
etc. 

%GROUPNAME% is a backreference to a named capturing 
group, equivalent to «\ k'NAME' » or «(?P=NAME)» in a 
regular expression and to ò${NAME}ó or ò\ g<NAME>ó in the 
replacement text. The NAME part of the placeholder is case 
sensitive. The advantage of %GROUPNAME% is that you 
can use the padding and case conversion specifiers listed 
below. 

Search term and 
replacement text, but 
only when using regular 
expressions with 
named capturing 
groups. 

Padding 

You can add additional specifiers to all of the above placeholders. You can pad the placeholderõs value to a 
certain length, and control the casing of any letters in its value. The specifiers must appear before the 
second % sign in the placeholder, separated from the placeholderõs name with a colon. E.g. %MATCH:6L% 
inserts the match padded with spaces at the left to a length of 6 characters. You can add both padding and 
case placeholders. %MATCH:U:6L% inserts the padded match converted to upper case. 

Padding specifiers start with a number indicating the length, followed by a letter indicating the padding style. 
The length is the number of characters the placeholder should insert into the regular expression or 
replacement text. If the length of the placeholderõs value exceeds the requested length, it will be inserted 
unchanged. It wonõt be truncated to fit the length. If the value is shorter, it will be padded according to the 
padding style you specified. 

The L or òleftó padding style puts spaces before the placeholderõs value. This style is useful for padding 
numbers or currency values to line them up in columns. The R or òrightó padding style puts spaces after the 
placeholderõs value. This style is useful for padding words or text to line them up in columns. The C or 
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òcenteró padding style puts the same number of spaces before and after the placeholderõs value. If an odd 
number of spaces is needed for padding, one more space will be placed before the value than after it. 

The Z or òzeroó padding style puts zeros before the placeholderõs value. This style is useful for padding 
sequence numbers. 

Case Conversion 

Case conversion specifiers consist of a letter only. The specifier letters are case insensitive. Both òUó and òuó 
convert the placeholderõs value to uppercase. L converts it to lowercase, I to initial caps (first letter in each 
word capitalized) and F to first cap only (first character in the value capitalized). E.g. %MATCH:I% inserts 
the match formatted as a title. 

Instead of a case conversion specifier, you can use the case adaptation specifier. It consists of A followed by a 
digit (not to be confused with a number followed by A, which is a padding specifier). This specifier is only 
available in a replacement text corresponding with a regular expression. You can use the specifier to give the 
placeholder the same casing style as the regular expression match or the text matched by a capturing group. 
Specify zero for the whole regex, or the backreference number of a capturing group. E.g. %MATCH:A2% 
inserts the whole regular expression match, converted to the case used by the second capturing group. The 
case adaptation specifier detects and adapts to uppercase, lowercase, initial caps and first cap. If the 
referenced capturing group uses a mixed casing style, the placeholderõs value is inserted unchanged. 

Arithmetic 

Arithmetic specifiers perform basic arithmetic on the placeholderõs value. This works with any placeholder 
that, at least prior to padding, represents an integer number. If the placeholder does not represent a number, 
the arithmetic specifiers are ignored. For placeholders like %MATCH% that can sometimes be numeric and 
other times not, the arithmetic specifiers are used whenever the placeholder happens to represent an integer. 

An arithmetic specifier consists of one or more operator and integer pairs. The operator can be +, - , * , or /  
to signify addition, subtraction, multiplication, or integer division. It must be followed by a positive integer. 
Arithmetic specifiers are evaluated strictly from left to right. When %MATCHN% evaluates to 
2, %MATCHN:+1*2% evaluates to 6 because 2+1=3 and 3*2=6. Multiplication and division do not take 
precedence over addition and subtraction. Integer division drops the fractional part of the divisionõs result, 
so %MATCHN:/3% evaluates to 0 for the first two matches. 
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5. Go Menu 

Go|Go to Line or Offset 

When editing a text file, the Go to Line item in the Go menu will ask you for a line number, and then move 
the text cursor to that line. You can enter the line number as a decimal number (just enter the number itself) 
or as a hexadecimal number (as 0xFF or FFh). 

When editing a file in hexadecimal mode, the Go to Offset command will ask you for a file offset, counting 
the number of bytes from the start of the file. You can enter the offset in hexadecimal, decimal, octal or 
binary notation. You donõt need to format the number in any way (e.g. just enter FF for a hexadecimal offset). 
Just click the radio button with the notation youõre using. 

Whether going to a line or offset, you can prefix the line or offset number with a plus or minus sign. The sign 
makes the move relative to the current line or offset. If the cursor is at line 150, and you go to ò100ó, the 
cursor is moved to line 100. If you enter ò-100ó it is moved to line 50, while +100 moves it to line 250. You 
can prefix numbers in any of the four notations with a sign. E.g. entering a hexadecimal offset ò-Fó moves 
the cursor fifteen bytes to the left. 

Go|Go to Matching Bracket 

On the Colors & Syntax tab in the file type configuration, you can make EditPad Pro highlight matching 
brackets such as ( and ) for certain file types. When the text cursor is on a character that is considered a 
bracket by the syntax coloring scheme, then both that bracket and its matching counterpart are highlighted. 
In that situation, you can select Go to Matching Bracket from the Go menu to move the text cursor to the 
matching bracket. 

Go|Previous Editing Position 

Select Previous Editing Position in the Go Menu to move the text cursor to the position in the current file 
where you last inserted or deleted some text. This makes it very comfortable to scroll through a file to look 
something up while editing, since you can always jump back to the editing position where you left off to 
continue editing. 

If you use the Go to Previous Editing Position command a second time right after the first time, the cursor 
will be moved to the editing position before the previous one. If you use it a third time, the cursor will be 
moved to the editing position before that. You can use the command up to 16 times to revisit the last 16 
spots in the file where you made changes. 

If you go back too far, use the Go|Next Editing Position command to move forward through the most 
recent editing positions. 

EditPad remembers the last 16 editing positions for all files that you have open. The Go to Previous Editing 
Position command never switches between files. You can use Go|Back in Edited Files and Go|Forward in 
Edited Files to switch between recently edited files. 
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Go|Next Editing Position  

If you have used Go|Previous Editing Position to go back to a position where you previously made a change 
in the active file, then you can use the Next Editing Position command in the Go menu to move forward in 
the list of recent editing positions. 

Go|Back in E dited Files 

Select Back in Edited Files in the Go menu to activate the last file that you made a change to. If that file is 
already active, the file you last made a change to other than the active file will be activated. When you have 
many files open, you can use this command to quickly go back to the file you were editing after youõve looked 
at other files. E.g. if you want to copy and paste something from another file into the file youõre editing, 
switch to the other file, copy the text you want to paste, and then use Go|Back in Edited Files to instantly go 
back to the spot where you want to paste. 

If you use the Previously Edited File command a second time, EditPad will activate the second most recently 
edited file. EditPad remembers up to 16 files. You can also use the submenu of the Back in Edited Files 
command to directly select the file you want to go back to. 

Essentially, the Back in Edited Files and Forward in Edited Files commands work like the Back and Forward 
buttons in a web browser. But they only remember files that youõve actually edited, not every file youõve 
viewed. 

Go|Forward in Edited Files 

If you have used Go|Back in Edited Files to go back to a previously edited file, then you can use the Forward 
in Edited Files command in the Go menu to move forward in the list of recently edited files. You can also 
select a particular file to go to in the submenu of the Forward in Edited Files command. 

Go|Next File  

The Go|Next File menu item activates the next file tab in the current project. If the last file in the project is 
active, then the first file is activated. 

If you record this command as part of a macro and the macro plays back the Go|Next File command when 
the last file is already active, then macro playback is stopped. The first file is not activated. This makes it 
possible to record a macro that operates on all files by recording Go|Next File as the last command in the 
macro. Then you can play back the macro and repeat it any number of times, knowing that it will stop at the 
last file. 

The Next File and Previous File commands always switch between files in the order their tabs have. If you 
want to switch between recently edited files, use the Go|Back in Edited Files and Go|Forward in Edited 
Files commands. If you want to switch between recently viewed files, regardless of whether youõve edited 
them, use the Ctrl+Tab key combination with the "use most recent order when switching tabs with 
Ctrl+Tab" preference turned on. If you quickly want to go to a specific file, use the Files Panel. 
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Go|Previous File 

The Go|Previous File menu item activates the previous file tab in the current project. If the first file in the 
project is active, then the last file is activated. During macro playback, if the first file is active, macro playback 
is stopped without switching between files. See Go|Next File for details. 

Go|Sort File Tabs Alphabetically 

Pick Sort File Tabs Alphabetically from the Go menu to sort the tabs of all files in the current project 
alphabetically by their file names. Note that the tabs will be sorted only at the moment you click on Sort File 
Tabs Alphabetically. If you open more files, the alphabetical order will not be maintained. Tabs for newly 
opened files are either placed to the immediate right hand side of the tab that was active when you opened 
the additional files, or after the last file tab. You can configure this in the Tabs Preferences. 

You can also rearrange the tabs in any order you want by dragging them with the mouse. To drag a tab, click 
on it, hold the mouse button down, and move the mouse to the left or right. The tab will follow the mouse 
pointer until you release the mouse button. If you drag the tab to the left edge of the leftmost tab, and there 
are more tabs, presently invisible, to the left of that tab, then all the tabs will scroll to the right, allowing you 
to move the tab you are dragging further to the left. Similarly, you can drag the tab to the right edge of the 
rightmost tab to make the tabs scroll to the left. 

Go|Next Project  

The Go|Next Project item activates the next project tab. If the last project is active, then the first project will 
be activated. During macro playback, if the last project is active, macro playback is stopped without switching 
between projects. 

If you like to use the mouse, you can quickly switch between projects by clicking on their tabs, or by double-
clicking on the projectõs node in the Files Panel. 

Go|Previous Project 

The Go|Previous Project menu item activates the previous project tab. If the first project is active, then the 
last project is activated. During macro playback, if the first project is active, macro playback is stopped 
without switching between projects. 

If  you like to use the mouse, you can quickly switch between projects by clicking on their tabs, or by double-
clicking on the projectõs node in the Files Panel. 

Go|Sort Project Tabs Alphabetically 

Pick Sort Project Tabs Alphabetically from the Go menu to sort the tabs of all projects alphabetically by their 
names. Note that the tabs will be sorted only at the moment you click on Sort Project Tabs Alphabetically. If 
you open more projects, the alphabetical order will not be maintained. Tabs for newly opened projects are 
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always placed to the immediate right hand side of the tab that was active when you opened the additional 
files. 

You can also rearrange the tabs in any order you want by dragging them with the mouse. To drag a tab, click 
on it, hold the mouse button down, and move the mouse to the left or right. The tab will follow the mouse 
pointer until you release the mouse button. If you drag the tab to the left edge of the leftmost tab, and there 
are more tabs, presently invisible, to the left of that tab, then all the tabs will scroll to the right, allowing you 
to move the tab you are dragging further to the left. Similarly, you can drag the tab to the right edge of the 
rightmost tab to make the tabs scroll to the left. 
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6. Block Menu 

Block|Duplicate  

Select Duplicate from the Block menu to insert a copy of the selected text at the current position of the text 
cursor. The newly inserted copy will become the selected text. 

This command is intended to be used with persistent selections. You can move the text cursor without 
clearing the selection only when selections are persistent. 

Selecting text, moving the text cursor, and invoking Block|Duplicate has the same effect as selecting text, 
invoking Edit|Copy, moving the text cursor, and invoking Edit|Paste. The only difference is that 
Block|Duplicate does not use the clipboard, so the contents of the clipboard are preserved. 

The option òpaste whole lines when lines are copied as a wholeó affects how text is duplicated when you have 
selected complete lines. Selecting a complete line means to select everything from the start of the line to the 
end of the line, including the line break at the end of the line. Selecting multiple lines completely means 
selecting everything from the start of the first line in the block until the end of the last line in the block, 
including the line break at the end of the last line. When the option òpaste whole lines when lines are copied 
as a wholeó is on, whole lines are always duplicated as if the cursor were at the start of the line when you 
invoke Block|Duplicate. Thus, whole lines are always duplicated as a whole before the line that the cursor is 
on when duplicating. This makes it easy to duplicate blocks of lines without worrying about the horizontal 
position of the text cursor. If this option is off, the selected lines are duplicated at the exact spot the text 
cursor is at, even when whole lines are selected. 

If you use the menu item or toolbar button to invoke this command, it will be invoked on EditPadõs main 
editor, where you edit files. If you press the shortcut key on the keyboard, it will be invoked on whichever 
editor is showing the text cursor (vertical blinking bar), whether thatõs the main editor, the search box or the 
replace box. 

Block|Move  

Select Move from the Block menu to delete the selected text and insert it again at the current position of the 
text cursor. Block|Move will only become enabled when you have enabled persistent selections in the Editor 
Preferences. Only when selections are persistent, you can move the text cursor without clearing the selection. 

Selecting text, moving the text cursor, and invoking Block|Move has the same effect as selecting text, 
invoking Edit|Cut, moving the text cursor, and invoking Edit|Paste. The only difference is that Block|Move 
does not use the clipboard, so the contents of the clipboard are preserved. 

The option òpaste whole lines when lines are copied as a wholeó affects how text is moved when you have 
selected complete lines. Selecting a complete line means to select everything from the start of the line to the 
end of the line, including the line break at the end of the line. Selecting multiple lines completely means 
selecting everything from the start of the first line in the block until the end of the last line in the block, 
including the line break at the end of the last line. When the option òpaste whole lines when lines are copied 
as a wholeó is on, whole lines are always moved as if the cursor were at the start of the line when you invoke 
Block|Move. Thus, whole lines are always moved as a whole before the line that the cursor is on when 
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moving. This makes it easy to move blocks of lines without worrying about the horizontal position of the text 
cursor. If this option is off, the selected lines are moved to the exact spot the text cursor is at, even when 
whole lines are selected. 

If you use the menu item or toolbar button to invoke this command, it will be invoked on EditPadõs main 
editor, where you edit files. If you press the shortcut key on the keyboard, it will be invoked on whichever 
editor is showing the text cursor (vertical blinking bar), whether thatõs the main editor, the search box or the 
replace box. 

Block|Swap Selections 

If you have used View|Split Editor to split EditPad Proõs editor in two, you can select a different part of the 
active file in each of the split editors. You can then use the Swap Selections item in the Block menu to swap 
the two selected blocks. If your file contains the sentence òHarry met Sallyó and you select òHarryó in one 
view and òSallyó in the other view, then Block|Swap Selections changes the sentence into òSally met Harryó. 

Block|Indent  

Select Indent from the Block menu to insert a certain number of spaces at the start of each line in the selected 
portion of the current file. How many spaces are inserted depends on the òblock indentó setting for the type 
of file you are editing. You can change this setting on the Editor page in the file type configuration. If the 
òblock indentó setting is an integer multiple of the òtab sizeó setting, and the option òtab inserts spacesó is 
off, Block|Indent will use tab characters instead of spaces to indent the selection. 

If the selection spans more than one line, you can also indent it by pressing Tab on the keyboard. The 
difference between using Block|Indent and the Tab key is that Block|Indent uses the òblock indentó setting 
while Tab uses the òtab sizeó setting to determine the amount of indent. If òtab inserts spacesó is off, 
pressing tab will indent the selection by inserting exactly one tab character at the beginning of each paragraph. 

Note that if word wrap is on, only the first line of each paragraph will be indented. Wrapped lines are only 
indented along with the first line if youõve turned on Options|Indent Wrapped Lines. 

If a rectangular block is selected, Block|Indent works differently. Instead of indenting the selected lines by 
inserting spaces or tabs at the start of the line, it will insert the spaces immediately before the first column in 
the selection, effectively shifting the block a number of spaces to the right. 

Block|Outdent  

Select Outdent from the Block menu to outdent or unindent each line in the selected portion of the current 
file. EditPad does this by deleting a certain number of spaces from the start of each line. How many spaces 
are inserted depends on the òblock indentó setting for the type of file you are editing. You can change this 
setting on the Editor page in the file type configuration. If there are not that many spaces at the beginning of 
a certain line, all the spaces at the beginning of that line will be deleted. But the other lines will still be 
outdented by the specified amount. 
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If the selection spans more than one line, you can also outdent it by pressing Shift+Tab on the keyboard. The 
difference between using Block|Outdent and the Tab key is that Block|Outdent uses the òblock indentó 
setting while Tab uses the òtab sizeó setting to determine the amount. 

If a rectangular block is selected, Block|Outdent works differently. Instead of deleting spaces or tabs at the 
start of the line, it will delete spaces and tabs immediately to the left of the first column in the selection, 
effectively shifting the block a number of spaces to the left. Spaces inside the selected block will not be 
deleted. 

Block|Move Lines and Columns 

The Move Lines and Columns submenu of the Block menu lists various commands for shifting blocks of text 
around. 

When youõve made a linear selection (a selection that follows the flow of the text), you can only move lines. 
Lines will be moved entirely. If the first and/or last line in the selection are only partially selected, the 
selection will first expand itself to include those lines entirely. When moving the block one line up, the block 
and the line above it will swap places. After the action, the unselected line that was above the block will be 
below it. Moving the block one line down does the opposite. 

When youõve made a rectangular selection, only the selected columns are moved. When moving the 
rectangular block one line up, the columns spanning the width of the selection in the line above the selection 
are removed. Then the selected block is moved up one line, filling up the space created by removing part of 
the line that was above the selection. The removed characters are then reinserted in the empty space created 
on the line that use to be the last line in the selection. If the line above the block did not have any characters 
to remove, spaces are inserted into the last line instead. The original block will remain selected, now 
positioned one line higher in the file. Moving a rectangular block one line down does the opposite. 

Rectangular selections can also be shifted to the left or the right. When shifting a block to the left, the 
character immediately to the left of the block on each line partially selected by the block is removed. This 
character is then reinserted on the same line immediately to the right of the block. The original block will 
remain selected, now positioned one column closer to the left. When shifting a block to the right, the 
character immediately to the right of the block is removed, and reinserted to the left of the block. If there is 
no character to the right of the block on a particular line, a space is inserted to the left of the block instead. 
You can shift a block as far out to the right as you want. 

If no text is selected at all, you can still use the commands to move lines up or down. Then, the line 
containing the text cursor will be moved. 

Block|Comment  

Select Comment from the Block menu to comment out a piece of code in a source code file. 

If the current file is being syntax colored by a syntax coloring scheme that contains a character string for 
single line comments, Block|Comment will automatically comment out the using those characters. If youõve 
made a selection that flows along with the text, the comment characters will be inserted at the very start of 
the line. If youõve made a rectangular selection, the comment characters will be inserted on each line spanned 



 
 

62 

by the selection, at the leftmost column in the selection. This is exactly what Block|Prefix also does, except 
that Block|Comment automatically uses the characters to comment out something based on the syntax 
coloring scheme. 

If the syntax coloring scheme does not define characters for single line comments, but does define characters 
for multi-line comments, Block|Comment will use the characters that open and close a comment on each 
line in the selection. If the selection is rectangular, theyõre inserted immediately before and after the selected 
columns. Otherwise, theyõre inserted at the start and end of each selected line. 

If the current file type does not use a syntax coloring scheme, or the scheme does not define any characters to 
comment out something, Block|Comment will ask you for the characters to be inserted at the start of each 
line, just like Block|Prefix would. 

If you did not select any text before using the Block|Comment command, or the selection does not span 
more than one line, Block|Comment will place the comment characters at the very start of the line 
containing the text cursor. The text cursor is then moved to the next line. If youõve assigned a keyboard 
shortcut to Block|Comment, you can quickly comment out a bunch of lines this way. 

To remove the comment characters inserted by Block|Comment, use Block|Uncomment or Block|Toggle 
Comment. 

Block|Uncomment  

Select Uncomment from the Block menu to remove the comment characters added by Block|Comment. 
When youõve made a selection that flows with the text, Block|Uncomment will remove the comment 
characters from the very start of the line only. Comment characters in the middle of a line are left. When 
youõve made a rectangular selection, only comment characters starting at the first selected column will be 
removed. Comment characters at other columns are left. 

If the syntax coloring scheme does not define opening and closing characters for comments, 
Block|Uncomment will try to remove the pair from the start and the end of each line when the selection 
flows with the text. When making a rectangular selection, it should include both the opening characters and 
closing characters on each line. Only comment characters inside and at the edge of the selected block will be 
removed. 

Though Block|Uncomment requires you to be a bit precise when selecting the block to be uncommented, 
this makes it possible to comment out blocks that already have comments in them, and then uncomment 
those blocks while leaving the original comments. 

If you did not select any text before using the Block|Uncomment command, or the selection does not span 
more than one line, Block|Uncomment will attempt to remove comment characters at the very start of the 
line containing the text cursor. Whether any comment characters were removed or not, it will then move the 
text cursor to the next line. If youõve assigned a keyboard shortcut to Block|Uncomment, you can quickly 
uncomment a bunch of lines this way. 
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Block|Toggle Comment  

The Toggle Comment command in the Block menu combines the functionality of Block|Comment and 
Block|Uncomment. On each line in the selection, it will attempt to remove the comment characters exactly 
like Block|Uncomment would. If there are no comment characters to be removed, it will add them on that 
line just like Block|Comment does. 

If you did not select any text before using the Block|Toggle Comment command, or the selection does not 
span more than one line, Block|Toggle Comment will add or remove the comment character at the start of 
the line containing the text cursor. The text cursor is then moved to the next line. If youõve assigned a 
keyboard shortcut to Block|Uncomment, you can quickly uncomment a bunch of lines this way. 

The advantage of Block|Toggle Comment is that it allows you to use the same keyboard shortcut for both 
commenting and uncommenting lines. 

Block|Prefix  

Select Prefix in the Block menu to prefix the selected block with one or more characters.   If youõve made a 
selection that flows along with the text, the characters will be inserted at the very start of each line in the 
selection. If youõve made a rectangular selection, the comment characters will be inserted on each line 
spanned by the selection, at the leftmost column in the selection. The inserted characters will become part of 
the selection. 

Block|Suffix  

Select Suffix in the Block menu to suffix the selected block with one or more characters.   If youõve made a 
selection that flows along with the text, the characters will be inserted at the end of each line in the selection. 
If youõve made a rectangular selection, the comment characters will be inserted on each line spanned by the 
selection, after the rightmost column in the selection. The inserted characters will become part of the 
selection. 

Block|Fill Columns  

Select Fill Columns in the Block menu to fill a rectangular block with one or more characters. If you enter 
less characters than the width of the selection, the characters you entered will be repeated on each line as 
many times as necessary. If the number of selected columns is not an integer multiple of the number of 
characters you entered, the last repetition of the inserted characters will be truncated at the last selected 
column. The same characters will be inserted on each line. 

If some of the lines already had text in the selected columns, that text is overwritten by the filled block. If 
some of the lines were shorter than the selected columns, spaces will be inserted to extent those lines until the 
filled block. 
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Block|Rectangular Selections 

There are several ways to select text in EditPad using the keyboard or the mouse. Whichever way you choose, 
it involves marking a starting and an ending position for the selection. All the text between the starting and 
the ending position becomes selected, following the flow of the text like you would follow it when reading it 
out loud. This is how almost all Windows programs select text, and is appropriate in most situations. 

But in some situations, such as when editing text files with information organized in tables, it is more useful 
to make a rectangular selection, also called a column selection. A rectangular selection is much like a selection 
of cells in a spreadsheet application, except that in EditPad you select characters instead of cells. 

Before you can make rectangular selections, a few conditions must be met. First, you need to use a fixed-
width font such as Courier New. You can change the font in Options|Font. Characters are only properly 
aligned into columns when using a fixed-width font, a requirement to make rectangular selections. 

Second, word wrap must be off. You can turn it off using Options|Word Wrap. When long lines are 
wrapped, editing a long line will cause the text to be rewrapped. This is not a problem when the selection 
flows along with the text. But when using rectangular selections, this rewrapping would cause the selection to 
change. 

Many text editors do not support rectangular selections. Those that do, are usually IDEs or editors from the 
DOS world that do not support word wrapping or variable-width fonts. EditPad is a flexible editor and 
supports both rectangular selections as well as modern conveniences like word wrap and variable-width fonts, 
but not at the same time for reasons explained above. 

There are two ways to make a rectangular selection. First, you can make it the usual way using the keyboard 
or the mouse, while keeping the Alt button depressed on the keyboard. Second, you can pick Rectangular 
Selections from the Block menu. This will invert the meaning of the Alt key while making a selection. After 
choosing Rectangular Selections in the Block menu, a selection made the normal way will be rectangular, and 
a selection made while pressing Alt will flow along with the text. 

If you did not choose a fixed-width font or turn off word wrap, then the selection will always flow along with 
the text. If you pick Block|Rectangular Selections from the menu, EditPad Pro will warn you that rectangular 
selections are presently not possible. 

Most commands like copy and paste work just the same when using rectangular selections or text-flow 
selections. Notable exceptions are Block|Indent and Block|Outdent. Some commands, like Block|Fill 
Columns only work with rectangular selections. 

Block|Begin Selection 

Select Begin Selection from the Block menu to tell EditPad Pro to remember the current position of the text 
cursor. Doing this will not have any visible effect. After using Block|Begin Selection, you can use Block|End 
Selection to select text starting at the position remembered by Block|Begin Selection. If you have more than 
one file open in EditPad Pro, Begin Selection will remember the position separately for each file. Selecting 
Begin Selection when working with one file does not wipe out the position remembered for any other file. 
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These commands are very useful when you want to make a very large selection, or if you want to perform a 
search to find the start and the end of the selection. You can do whatever you want between invoking Begin 
Selection and invoking End Selection, including selecting part of the text in any way. The position stored by 
Begin Selection is remembered until you use Begin Selection again. 

The Begin Selection command works slightly differently when selections are persistent. Then it is possible 
that part of the file is already selected, without the text cursor being positioned at the end of the selection. In 
that case, Begin Selection moves the starting position of the selection to the current position of the text 
cursor, and nothing is remembered. If the new starting position is further away from the ending position than 
the old one, the selection will be expanded. If the new starting position is below the ending position when the 
old one was above it, or vice versa, the selection will be pivoted around the ending position. If the new 
starting position is inside the old selection, the selection will be shrunk. 

If there is no selection, Begin Selection remembers the position for use with End Selection, whether 
selections are persistent or not. 

If you use the menu item or toolbar button to invoke this command, it will be invoked on EditPadõs main 
editor, where you edit files. If you press the shortcut key on the keyboard, it will be invoked on whichever 
editor is showing the text cursor (vertical blinking bar), whether thatõs the main editor, the search box or the 
replace box. 

Block|End Selection 

After using Block|Begin Selection, you can select End Selection from the Block menu to select the text 
between the current position of the text cursor and the position stored by Begin Selection. You can use End 
Selection as many times as you want after using Begin Selection. The selection will continue to start at the 
same position, until you use Begin Selection again. If you want to make a rectangular selection, select 
Block|Rectangular Selections from the menu before selecting End Selection. 

The End Selection command works slightly differently when selections are persistent. Then it is possible that 
part of the file is already selected, without the text cursor being positioned at the end of the selection. In that 
case, End Selection moves the ending position of the selection to the current position of the text cursor, and 
nothing is remembered. If the new ending position is further away from the starting position, the selection 
will be expanded. If the new ending position is above the starting position when the old one was below it, or 
vice versa, the selection will be pivoted around the starting position. If the new ending position is inside the 
old selection, the selection will be shrunk. 

If there is no selection, Begin Selection remembers the position for use with End Selection, whether 
selections are persistent or not. 

If you use the menu item or toolbar button to invoke this command, it will be invoked on EditPadõs main 
editor, where you edit files. If you press the shortcut key on the keyboard, it will be invoked on whichever 
editor is showing the text cursor (vertical blinking bar), whether thatõs the main editor, the search box or the 
replace box. 
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Block|Expand Selection 

The Expand Selection command in the Block menu is only useful when selections are persistent. Persistent 
selections allow you to move the text cursor away from the end of the selection. The Expand Selection 
command will create a new selection that includes the old selection, and all text between the old selection and 
the position of the text cursor. The position of the text cursor will be the new ending point of the selection. 

The most significant difference between Block|End Selection and Block|Expand Selection is that End 
Selection will pivot the selection if youõve moved the text cursor above the spot where you started making the 
selection while you ended the selection below the starting position, or vice versa. This causes the old selection 
to be completely deselected, as the starting position stays put. Only the text between the old starting position 
and the new ending position is selection. Expand Selection will always expand the selection. If the new 
ending position is above the old starting position while the old ending position was below it, or vice versa, 
Expand Selection simply makes the old ending position the new starting position. 

Whether selections are persistent or not, you can achieve the same effect by pressing Shift on the keyboard 
while clicking with the mouse at the position where the new selection should end. The advantage of 
Block|Expand Selection is that you can assign it a keyboard shortcut, and expand the selection with the 
keyboard. 

Block|Between Matching Brackets 

The Between Matching Brackets command is only available when bracket matching is enabled in the syntax 
coloring section of the file type configuration for the active fileõs file type. The syntax coloring scheme 
determines exactly which brackets are matched. See that section in this help file to learn how bracket 
matching works in EditPad Pro. 

When you invoke the Between Matching Brackets command in the Block menu, EditPad Pro selects the text 
between the nearest pair of matching brackets that surround the text cursor. If some text was already selected, 
Between Matching Brackets expands the selection to touch the nearest pair of matching brackets surrounding 
the selection. The brackets are not included in the selection. If the selection already touches the nearest pair 
of matching brackets, then Between Matching Brackets expands the selection to include the brackets. 
Repeating the command expands it to touch the next nearest pair of matching brackets. You can repeat the 
command as long as there is a pair of brackets surrounding the selection. 

Block|Unselect  

Use the Unselect command in the Block menu to remove the selection without moving the text cursor. Only 
the selection is removed. The text that was selected remains. 

Block|Go to Beginning  

Select Go to Beginning in the Block menu or press the corresponding keyboard shortcut to quickly move the 
text cursor to the start of the selection. This command is only useful when selections are persistent, and 
youõve moved the text cursor away from the selection. 
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Block|Go to End  

Select Go to End in the Block menu or press the corresponding keyboard shortcut to quickly move the text 
cursor to the end of the selection. This command is only useful when selections are persistent, and youõve 
moved the text cursor away from the selection. 

Block|Insert File  

Select Insert File from the Block menu to insert the contents of another file into the file you are currently 
editing. You will be asked to select the file. The text will be inserted at the current position of the text 
cursor.If you select more than one file at the same time, their contents will be inserted in alphabetical order of 
the names of the files 

Block|Write  

Select Write from the Block menu to saves the selected portion of the file you are editing into another file. If 
the other file already exists, EditPad will show a warning and if you confirm, the other file will be overwritten 
with the selected portion of the current file. If you want to add the selection to the file rather than overwrite 
it, use Block|Append instead. 

If you do not specify an extension for the filename, EditPad will add one depending on the selection you 
made in the filters (the bottommost drop-down list) in the Block|Write dialog box. If the active filter is òany 
fileó (*.*), no extension will be added. If any other filter is active, the default extension for that file type will 
be added to the filename. The default extension is the first extension listed in the Extensions setting of the 
file typeõs settings. 

Block|Append  

Select Append from the Block menu to save the selected portion of the file you are editing into another file. 
If the other file already exists, the selection will be added to the end of that file. If it does not yet exist, it will 
be created. 

Block|Print  

Select Print from the Block menu to print the selection portion of the current file, rather than the entire file. 
A preview of the printout will be shown first. It will allow you to make some changes like which font to print 
with, which pages should be printed. You can also access the printer setup through the preview window. 

There are two key differences between selecting Block|Print in the menu, versus selecting File|Print and 
turning on the òselection onlyó in the print preview. The checkbox works at the level of a single line. If a line 
is partially selected, it will be printed entirely. Block|Print, however, sends the exact selection to the print 
preview, and ultimately the printer. If you want to print a rectangular block, Block|Print is definitely more 
useful. 
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Syntax coloring will also be printed differently. Since File|Print sends the whole file to the print preview, the 
printed lines will be colored the same whether youõre only printing the selected lines, or youõre printing the 
whole file. Block|Print only sends the selection to the print preview, and the syntax coloring will treat the 
selection as if it is a complete file. If your selection cuts through syntactic elements, they wonõt be colored 
properly in the printout when using Block|Print. In that case, you can turn off the òsyntax coloringó in the 
print preview to print without syntax coloring. 
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7. Mark Menu 

Mark|Go to Next Bookmark  

Select Go to Next Bookmark in the Mark menu to move the text cursor to the first bookmark after the 
cursor in the active file. Repeat this command to move through the bookmarks in the order they have in the 
file, regardless of the numbers on the bookmarks. 

Mark|Go to Previous Bookmark 

Select Go to Next Bookmark in the Mark menu to move the text cursor to the nearest bookmark before the 
cursor in the active file. Repeat this command to move through the bookmarks in the order they have in the 
file, regardless of the numbers on the bookmarks. 

Mark|Set Any Bookmark 

Use the Set Any Bookmark command in the Mark menu to set a bookmark at the current position of the 
cursor. The number on the bookmark will be the lowest-numbered bookmark that isnõt used yet in the active 
file. When Mark|Project-Wide Bookmarks is active, the number will be the lowest-numbered bookmark that 
isnõt used yet in the active project. 

If all 10 numbered bookmarks have been set, the Set Any Bookmark command sets a numberless bookmark. 
You can place as many numberless bookmarks as you like. Numberless bookmarks cannot be jumped to 
directly with the Go to Bookmark X commands. You can jump to them with the Go to Next Bookmark and 
Go to Previous Bookmark commands. 

Unlike the Set Bookmark X commands, the Set Any Bookmark command never removes a bookmark from 
another location. It always sets a new bookmark if the line the cursor is on doesnõt have a bookmark yet. If 
the line the cursor is on does have a bookmark, that bookmark is removed and no new bookmark is set. 
Using Set Any Bookmark again on a line that already has a numberless bookmark is the only way to remove 
individual numberless bookmarks. 

Though bookmarks are shown in the left margin, they are placed at character positions. Bookmarks stay with 
the character they were placed at when you edit the file. If you delete the character, the bookmark shifts to 
the nearest remaining character. 

Bookmarks are not saved into a file when you use File|Save. EditPad Pro does automatically remember the 
bookmarks you set for all files that are listed in the reopen menu, and all files you added to your favorites. 
Projects also store the bookmarks for all the files in the project. When opening files by opening a project, the 
filesõ bookmarks are restored from the project file. When opening a file without opening a project, its 
bookmarks are retrieved from the reopen menu or the favorites if the file is listed there, even if you didnõt use 
the reopen menu or the favorites menu to open the file. 
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Mark|Proj ect-Wide Bookmarks 

By default, bookmarks are separate for each file. You can use Mark|Set Bookmark X to set the same 
bookmark in each file. Mark|Go to Bookmark X will only jump to bookmarks in the current file. The Mark 
menu will list the bookmarks for the current file. 

If you select the Project-Wide Bookmarks item in the Mark menu to make bookmarks project-wide, you will 
only have one set of 10 numbered bookmarks for all files in the current project. The Mark menu will show 
the bookmarks for the current project. If you set a bookmark, that bookmark will be set at the position of the 
text cursor in the current file, and removed from all other files in the project. When jumping to a numbered 
bookmark, all the files in the current project will be searched through to find the bookmark. The file it was 
found in will be activated. 

If you set the same bookmark in multiple files in the project with project-wide bookmarks turned off, and 
then turn on project-wide bookmarks, nothing will happen initially. The bookmark will remain set in all the 
files it is set in. If you try to jump to the bookmark, and it exists in the current file, EditPad Pro will jump to 
the bookmark in the current file. If not, it will search through the files in the project and jump to the first file 
it finds. Since this makes it hard to predict where youõll end up if you jump to the bookmark, you should set it 
again after turning on project-wide bookmarks. Setting the bookmark again will then remove it from all the 
other files in the project, giving it one place to jump to. 

Whether to use separate bookmarks for each file or project-wide bookmarks depends on your personal 
editing style, and the task at hand. When working with a handful of very large files, using separate bookmarks 
gives you 10 numbered bookmarks for each file. You can use the tabs to switch between files. When youõre 
working with a very large number of files and you repeatedly need to switch between them, project-wide 
bookmarks allow you to instantly switch to a particular spot in a particular file. 

Regardless of the state of the Project-Wide Bookmarks option, you can use the Mark|Set Any Bookmark 
command to set as many numberless bookmarks in as many files as you like. The Project-Wide Bookmarks 
option only affects numbered bookmarks, of which you can have no more than 10. 

Mark|Go to Bookmark 1, 2, 3... 

You can quickly jump to any bookmark by pressing Ctrl+1, Ctrl+2, Ctrl+3, etc... on the keyboard. Jumping 
to a bookmark positions the text cursor on the line on which you set the bookmark with the given number 
through Mark|Set Bookmark. If the requested bookmark does not exist, nothing happens. 

If you remember you set a bookmark but donõt remember which number, open the Mark menu. The 10 Go 
to Bookmark X items in the menu will display the first few words on the line on which each of the 
bookmarks is set. 

Bookmarks can be either separate for each file, or project-wide. When bookmarks are project-wide, the Go to 
Bookmark command searches for the bookmark in all files in the active project. If the bookmark is found in 
another file, it will activate that file. When bookmarks are separate for each file, the Go to Bookmark 
command will never switch to another file. 
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Mark|Set Bookmark 1, 2, 3... 

You can place up to ten numbered bookmarks in every file open in EditPad Pro using the ten Set Bookmark 
X commands in the Mark menu. You can quickly do so by pressing Shift+Ctrl+1, Shift+Ctrl+2, etc. on the 
keyboard. When you place a bookmark, you will see a green square with a white number in the left margin, 
indicating the bookmarkõs position. You can remove a bookmark by setting the bookmark again on the same 
paragraph. Setting a previously set bookmark removes it from its previous location. 

If there is already a bookmark on the line the cursor is on, that bookmark is removed. If that bookmark had 
the same number as the one youõre setting, then no bookmark is set. If the removed bookmark was 
numberless or had a different number, it is replaced with the bookmark number of the Set Bookmark X 
command youõve invoked. 

Though bookmarks are shown in the left margin, they are placed at character positions. Bookmarks stay with 
the character they were placed at when you edit the file. If you delete the character, the bookmark shifts to 
the nearest remaining character. 

Bookmarks are not saved into a file when you use File|Save. EditPad Pro does automatically remember the 
bookmarks you set for all files that are listed in the reopen menu, and all files you added to your favorites. 
Projects also store the bookmarks for all the files in the project. When opening files by opening a project, the 
filesõ bookmarks are restored from the project file. When opening a file without opening a project, its 
bookmarks are retrieved from the reopen menu or the favorites if the file is listed there, even if you didnõt use 
the reopen menu or the favorites menu to open the file. 

Mark|Remove All Bookmarks 

The Remove All Bookmarks command in the Mark menu removes all the bookmarks from the active file. If 
Mark|Project-Wide Bookmarks is enabled, it also removes all the bookmarks from all the other files in the 
active project. 

If you want to remove a single bookmark, place the cursor on the line that the bookmark is on and use the 
Mark|Set Any Bookmark command. 
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8. Fold Menu 

Fold|Fold  

Select Fold in the Fold menu to fold the selected lines. The first line in the selection will remain visible, while 
the others will be hidden. They are òfoldedó underneath the first line. A square with a plus symbol in it will 
appear to the left of the folded line. If you click it, the hidden lines will become visible again. A square with a 
minus will mark the first line, with a vertical line extending down from it to mark the previously folded range. 
Click the minus button again to refold the range. 

If you did not select part of the text, and the text cursor is inside a foldable range indicated by a vertical line 
in the left margin, the Fold command will fold that folding range. 

While folded lines are invisible, they are still fully part of the file, and still take part in all editing actions. E.g. if 
you select a block that includes one or more folded sections and copy the block to the clipboard with 
Edit|Copy, all selected lines, including lines hidden by folding, will be copied to the clipboard. Folding only 
affects the display. The only editing commands that take the folding into account are Edit|Delete Line, 
Fold|Copy Visible Lines and Fold|Delete Folded Lines. 

On the Navigation page in the file type configuration, you can choose if and how EditPad Pro should add 
automatic folding points. Automatic folding points appear as an unfolded range that you can fold with the 
mouse or the Fold command. 

Fold|Unfold  

Select Unfold in the Fold menu to unfold a section previously folded with Fold|Fold. The Unfold command 
will only become enabled when youõve placed the text cursor on the first (still visible) line of a folded section. 
The unfolded section will remain marked as a folding point, so you can easily re-fold it. 

If youõve made a selection, then all folding points inside the selection will be unfolded. 

If the current file type uses automatic folding points, then unfolded ranges will automatically disappear when 
you edit the file. They will be replaced by new automatic folding points. Folded ranges will remain folded 
until you unfold them. 

Fold|Toggle Fold  

If the text cursor is inside a foldable range (as indicated in the left margin), the Toggle Fold command in the 
Fold menu unfolds the foldable range if it was folded, and folds it it wasnõt folded. This is the same as 
clicking the plus or minus button in the left margin. 

If the text cursor is not inside a foldable range, and some text is selected, the Toggle Fold command folds the 
selected text by creating a new folding range, just like the Fold command in the Fold menu does. 
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Fold|Fold Unselected 

The Fold Unselected command in the Fold menu folds all existing folding ranges that do not span any 
selected text. If you did not select any text, the Fold Unselected command folds all folding ranges that do not 
contain the text cursor. 

The Fold Unselected command does nothing with the folding ranges that are (partially) selected. Use 
Fold|Unfold to unfold those. Using Fold|Fold Unselected followed by Fold|Unfold makes it easy to see the 
structure of the whole file while focusing on the part of the file that youõre editing. 

Fold|Remove Fold 

Select Remove Unfold in the Fold menu to unfold a section previously folded with Fold|Fold, and delete the 
folding point in the process. The Remove Fold command will only become enabled when youõve placed the 
text cursor on the first (still visible) line of a folded section. 

If youõve made a selection, then all folding points inside the selection will be removed. 

If the current file type uses automatic folding points, then automatically added folding points that you 
removed will automatically reappear when you edit the file. 

Fold|Go to Next Fold 

Select Go to Next Fold in the Fold menu to move the text cursor to the first line of the nearest folding range 
after the cursor. This folding range remains folded or unfolded, as it was. 

If the current file type uses automatic folding points, then automatically added folding points that you 
removed will automatically reappear when you edit the file. 

Fold|Go to Previous Fold 

Select Go to Previous Fold in the Fold menu to move the text cursor to the first line of the nearest folding 
range before the cursor. This folding range remains folded or unfolded, as it was. 

Fold|Fold All  

The Fold All command in the Fold menu will fold all automatic folding points, and any unfolded section still 
marked with a folding point. 
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Fold|Unfold All  

The Unfold All command in the Fold menu unfolds all sections that you have folded with the Fold 
command. 

Fold|Toggle All Folds  

If some of the foldable ranges in the file are folded, then the Toggle All Folds command in the Fold menu 
unfolds all those ranges, just like Fold|Unfold All does. If all of the foldable ranges in the file are already 
unfolded, then the Toggle All Folds command folds them all, just like Fold|Fold All does. 

Fold|Remove All 

The Unfold All command in the Fold menu removes all folding points that you added with the Fold 
command. 

Fold|Copy V isible Lines 

The Copy Visible Lines item in the Fold menu copies the selected text to the clipboard. There are two key 
differences between the Copy Visible Lines command, and the regular Copy command in the Edit menu. 

If the selection is not rectangular, and certain lines are only partially selected, the Copy Visible Lines 
command will copy those lines entirely. The Copy command copies partially selected lines partially. 

If certain lines were folded, the Copy Visible Lines command will not copy the lines that were made invisible 
by the folding. The regular Copy command does copy them. 

Text copied by the regular Copy command does preserve folding ranges when pasted back into EditPad Pro. 
All the text will be pasted, and will remain folded under the pasted folding range. If you paste into another 
application, then all the text appears without the folding range. 

Text copied by the Copy Visible Lines command is always pasted without any folding ranges. 

Fold|Delete Folded Lines 

Select the Delete Folded Lines item in the Fold menu to delete all lines in the current selection that were 
made invisible by folding them. 
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9. Tools Menu 

The Tools menu lists all the tools that are defined for the file type of the active file. Select one from the menu 
and it will be run immediately. 

Use the Configure Tools item to configure the tools to be added to the Tools menu. If you have not yet 
defined any tools, this will be the only choice you can make in the Tools menu. 

Tools can be configured to display their output in a message panel inside EditPad Pro. After running a tool 
you can use the Message Panel item in the Tools menu to show or hide this panel. 

Configure Tools 

EditPad Pro has the capability to run any external command or tool. A tool can be any executable program or 
application, a script run by an interpreter, or even a URL. 

To configure tools, select Configure Tools in the Tools menu. The tool configuration screen will appear. The 
screen is divided into two parts. At the left hand, youõll see a list of currently defined tools. If you havenõt 
defined any tools yet, this list will be empty. At the right hand are three tabs that hold the settings for the tool 
thatõs currently selected in the list at the left. The tabs donõt appear until youõve added at least one tool. 
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To change a toolõs settings, simply click on it in the list and make the changes you want. To create a new tool, 
click the New button below the list and set the options as you want them. To delete a tool, click on it and 
click the Delete button. The order of the tools in the list is the order in which they will be shown in the Tools 
menu. Select a tool and click the Up or Down button to move it. 

You can select multiple tools by holding down the Shift or Control key on the keyboard while clicking in the 
list of tools. The controls under the tabs will indicate the settings for all tools. If an edit box or drop-down list 
shows a value, that means all the selected tools use the same value. Otherwise, the edit box will be blank. If a 
checkbox is checked or cleared, that means it is checked or cleared for all the selected tools. Otherwise, the 
checkbox will be filled with a square. If you make a change to any setting, that change is applied to all the 
selected tools. 

You can save tool configurations into a file that you can share with other people. To save one or more tools, 
select them in the list and click the Export button below the list. Youõll be asked for a name of the .ini file 
into which all the tools will be saved. To load a tool configuration file youõve received from somebody, click 
the Import button. The loaded tools will be added to the list. 

For each tool, you can specify three sets of options: 
Definition: Basic settings you need to make for every tool, so EditPad Pro knows which tool to run. 
Files: Options for opening and saving files to be passed on the toolõs command line. 
Standard I/O: Options for transferring text to and from console applications. Console applications are 
applications that use a textual interface or DOS box rather than a graphical interface like EditPad Pro.  

Tool Definition  

When adding a tool to EditPad Proõs Tools menu, there are three pages of settings that you can make for 
each tool. On the òDefinitionó page you can set the basic options needed to add any application to EditPad 
Proõs Tools menu.  

òCaptionó is the caption that this toolõs menu item in the Tools menu will have. If you want to make a certain 
character a hotkey in the menu, precede it with an ampersand (&). The character that follows the ampersand 
will be shown underlined in the menu (unless you disabled the underlining of hotkeys in Windows). 

Check òadd to Tools toolbaró if you want a button for the tool to appear on the Tools toolbar. This toolbar 
is hidden by default. You can make it visible by right-clicking on the main menu or any toolbar and selecting 
Tools. 

Check òshow caption tool toolbaró if you want the toolbar button for the tool to show the caption that you 
specified. If not, only the toolõs icon is shown. The icon is automatically loaded from the file or application 
you specify on the command line. Showing the caption can be useful if you have multiple tool configurations 
for the same application. It does make the tool take up much more space on the toolbar. Items in the Tools 
menu always show the caption. 

òHintó is the text that will be shown in the status bar when the mouse is pointing at this toolõs menu item in 
the Tools menu. You may leave this blank if the caption is descriptive enough. 
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If you will use the tool often, you can assign a keyboard shortcut key combination to it. Click on the 
òshortcut keyó field, and then press the shortcut key combination you want on the keyboard. E.g. if you press 
F2 on the keyboard, the òshortcut keyó field will display F2. The menu item for the tool in the Tools menu 
will also indicate F2. When you press F2 on the keyboard while working with EditPad Pro, the tool will be 
run. To remove the shortcut from the tool, click in the òshortcut keyó field and press the backspace key on 
the keyboard. 

For the òCommand Lineó, you need to type in what you would type in if you would launch the tool from the 
Run item in the Windows Start menu. It is best to include the full path to the executable and any file 
parameters. Note that you must not use <, > or | characters for file redirection. If you need file redirection, 
use the Standard I/O page. If the path to the toolõs executable has spaces in it, you must enclose it in double 
quotes. Click the Browse button to browse for the executable file. 

If you specify a document file instead of an executable file as the command line, then EditPad Pro will launch 
the documentõs associated application, and pass the document file as a parameter. Windows Explorer does 
the same when you double-click on a document. 

If you specify a URL as the command line, then EditPad Pro opens the URL in the web browser configured 
in the System Preferences. 

òWorking Folderó is the folder that will appear to be the current one to the tool when it is run by EditPad 
Pro. 
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You can use special path placeholders to use the full path to the file you are currently editing, or parts of the 
file name or path in the command line or in the working folder. If you have marked any of the four 
temporary file options (see below), you can also use placeholders for the path and file name of the temporary 
file. There are also path placeholders that allow you to select one of the files open in EditPad Pro or a file on 
disk to be passed on the command line. Note that many applications cannot handle file names with spaces in 
them on the command line, unless they are enclosed by double quotes. So it is best to always put double 
quotes around paths you compose using path placeholders, like I did in the above screen shot. 

Click the Placeholders button to get a screen listing all path placeholders, making it easy to use them on the 
command line. The screen will use the file and project you currently have open in EditPad as example paths. 
If the active file or project are untitled, the example will be a dummy path. The temporary file placeholders 
will only be available if youõve turned on at least one of the options to open or save a temporary file. 

When running EditPad Pro from a removable drive, the drive will get a different drive letter each time it is 
inserted into another computer. In that situation, you should reference other applications stored on the same 
device using the %EPPDRIVE% and %EPPPATH% path placeholders. Then your tools will always 
reference the files on your drive, regardless of the drive letter it gets. 

Since most tools will only make sense when used on a file of a certain type, you can select the file types this 
tool applies to in the list at the right. Do this by marking the appropriate checkboxes. Not marking any 
checkbox has the same effect as marking all of them. The Tools menu will show all the tools that apply to the 
type of file you are currently editing. 

Command Line Placeholders for Tools 

EditPad Pro supports a range of placeholders that you can use on a toolõs command line to pass information 
about or parts of the file youõre editing in EditPad Pro. 

%POS%: Number of bytes before the position of the text cursor. Depending on the fileõs encoding, the 
number of bytes may not equal the number of characters. 
%LINE%: Number of the line the text cursor is on. %COL%: Number of the column the text cursor is 
on. %LINETEXT: Text of the line the text cursor is on. %CHAR%: The character immediately to the right 
of the text cursor. %WORD%: The word under the text cursor. %SELSTART%: Number of bytes before 
the start of the selection. %SELSTOP%: Number of bytes before the end of the selection. 
Subtracting %SELSTART% from %SELSTOP% gives the length of the selection in 
bytes. %ENCODING%: Encoding used by the active file, such as utf - 8, windows - 1252 , iso - 8859 - 1, 
etc.  

Path Placeholders 

You can use path placeholders to use part or all of the path and the file name of the file you are currently 
editing. You can use them in the command line and working folder for tools. This way, you can have a tool 
work with the file you are editing in EditPad Pro. In the examples below, the file being edited is 
C:\ data\ files\ web\ log\ foo.bar.txt. If the current file is untitled, all the placeholders below will be replaced 
with nothingness. 
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If you want to use the path or name of the temporary file that EditPad Pro can open or save when running a 
tool, simply prepend TEMP to the name of the placeholder. E.g. %TEMPFILE% is the full path and 
filename to the temporary file. %TEMPPATH% is the folder the temporary file is in. 

If the file was opened via FTP, use %FTPFILE% to specify the full path to the file on the FTP 
server. %FTPSERVER% is the domain name of the server, and %FTPURL%: the full ftp://  URL to the 
file. 

If you want to pass more than one file on the toolõs command line, you can use %PICK1FILE% 
through %PICK9FILE% to specify (parts of) the paths to up to 9 files that you have already open in EditPad 
Pro. If you use these placeholders, each time you run the tool a window will pop up for you to select the 
file(s) to be passed on the command line from the files you have open in EditPad Pro. The files you select 
will be saved automatically so the tool can get their current contents. If you donõt want the files to be saved, 
use %TEMP1FILE% through %TEMP9FILE% instead. These placeholders show the same file picker for 
files open in EditPad Pro. They donõt save the files but save temporary copies instead. The paths to the 
temporary copies are passed to the tool. 

If you want to pass any file, regardless of whether it is open in EditPad Pro or not, use %DISK1FILE% 
through %DISK9FILE%. These placeholders show a regular open file dialog so you can select a file from 
disk. If you select a file that is open in EditPad Pro, any unsaved changes are not saved. 

All the %FILE% placeholders described in this section represent a whole series of placeholders that hold 
various parts of the fileõs path. 

Placeholder Meaning Example 

%FILE% 
The entire path plus filename to 
the file 

C:\ data\ files\ web\ log\ foo.bar.txt 

%FILENAME% The file name without path foo.bar.txt 

%FILENAMENOEXT% 
The file name without the 
extension 

foo.bar 

%FILENAMENODOT% 
The file name cut off at the first 
dot 

foo 

%FILEEXT% 
The extension of the file name 
without the dot 

txt 

%FILELONGEXT% 
Everything in the file name after 
the first dot 

bar.txt 

%PATH% 
The full path without trailing 
delimiter to the file 

C:\ data\ files\ web\ log 

%DRIVE% 
The drive the file is on, without 
trailing delimiter 

C: for DOS paths; \ \ server for UNC paths; 
blank for UNIX paths 

%FOLDER% 
The full path without the drive 
and without leading or trailing 
delimiters 

data\ files\ web\ log 

%FOLDER1% First folder in the path data 

%FOLDER2% Second folder in the path files 

(...etc...) 
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%FOLDER99% 99th folder in the path. (nothing) 

%FOLDER<1% Last folder in the path log 

%FOLDER<2% 
Second folder from the end in 
the path 

web 

(...etc...) 

%FOLDER<99% 
99th folder from the end in the 
path. 

(nothing) 

%PATH1% 
First folder in the path, without 
delimiters 

data 

%PATH2% 
First two folders in the path, 
without leading or trailing 
delimiters 

data\ files 

(...etc...) 

%PATH99% 
First 99 folders in the path, 
without leading or trailing 
delimiters 

data\ files\ web\ log 

%PATH<1%  
Last folder in the path, without 
delimiters 

log 

%PATH<2% 
Last two folders in the path, 
without leading or trailing 
delimiters 

web\ log 

(...etc...) 

%PATH<99% 
Last 99 folders in the path, 
without leading or trailing 
delimiters 

data\ files\ web\ log 

%PATH-1% 
Path without the drive or the first 
folder 

files\ web\ log 

%PATH-2% 
Path without the drive or the first 
two folders 

web\ log 

(...etc...) 

%PATH-99% 
Path without the drive or the first 
99 folders. 

(nothing) 

%PATH<-1% 
Path without the drive or the last 
folder 

data\ files\ web 

%PATH<-2% 
Path without the drive or the last 
two folders 

data\ files 

(...etc...) 

%PATH<-99% 
Path without the drive or the last 
99 folders. 

(nothing) 
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Combining Path Placeholders 

You can string several path placeholders together to form a complete path. If you have a file 
c:\ data\ test\ file.txt then d:\ %FOLDER2%\ %FILENAME% will be substituted with d:\ test\ file.txt. 
However, if the original file is c:\ more\ file.txt then the same path will be replaced with d:\ \ file.txt 
because %FOLDER2% is empty. The result is an invalid path. 

The solution is to use combined path placeholders, like this: d:\ %FOLDER2\ FILENAME%. The first 
example will be substituted with d:\ test\ file.txt just the same, and the second will be substituted with 
d:\ file.txt, a valid path. You can combine any number of path placeholders into a single path placeholder, 
separating them either with backslashes (\ ) or forward slashes (/). Place the entire combined placeholder 
between two percentage signs. 

A slash between two placeholders inside the combined placeholder is only added if there is actually something 
to separate inside the placeholder. Slashes between two placeholders will never cause a slash to be put at the 
start or the end of the entire resulting path. In the above example, the backslash inside the placeholder is only 
included in the final path if %FOLDER2% is not empty. 

A slash right after the first percentage sign makes sure that the resulting path starts with a slash. If the entire 
resulting path is empty, or if it already starts with a slash, then the slash is not added. 

A slash right before the final percentage sign makes sure that the resulting path ends with a slash. If the entire 
resulting path is empty, or if it already ends with a slash, then the slash is not added. 

Mixing backslashes and forward slashes is not permitted. Using a forward slash inside a combined 
placeholder, will convert all backslashes in the resulting path to forward slashes. This is useful when creating 
URLs based on file names, as URLs use forward slashes, but Windows file names use backslashes. 

Example: If the original path is c:\ data\ files\ web\ log\ foo.bar.txt 

%\ FOLDER1\ % => \ data\  
%\ FOLDER5\ % => (nothing) 
%PATH-2\ FILENAME%  => web\ log\ foo.bar.txt 
%PATH-2/FILENAME%   => web/log/foo.bar.txt  
%PATH-4\ FILENAME%  => foo.bar.txt 
%DRIVE\ PATH-2\ FILENAME%  => c:\ web\ log\ foo.bar.txt  
%DRIVE\ PATH-4\ FILENAME%  => c:\ foo.bar.txt  
%\ FOLDER1\ FOLDER4\ % => \ data\ log\  
%\ FOLDER1\ FOLDER5\ % => \ data\  

Tool Files 

When adding a tool to EditPad Proõs Tools menu, there are three pages of settings that you can make for 
each tool. On the òFilesó page you can choose if EditPad Pro should save the current file or selection, or 
open files modified by the tool. 
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Mark òsave the current file if it has unsaved changesó if EditPad Pro should automatically do a File|Save 
before the tool is run. If the file is untitled, you will be prompted for a file name. You can use the %FILE% 
path placeholder to pass the file on the toolõs command line. 

Mark òsave the current file into a new temporary fileó if EditPad Pro should automatically do a File|Save 
Copy As and save the file under a new, temporary name before the tool is run. This is useful if the tool will 
modify the fileõs contents but you do not want to lose the original, or if you want to test changes you made to 
a file with a tool without having to save those changes first. The temporary file will be deleted after the tool 
has finished running. 

Mark òsave the selected part of current file into a new temporary fileó if EditPad Pro should automatically do 
a Block|Write before the tool is run. You can use this to allow the tool to read or modify the selection. You 
cannot use this option in combination with saving the entire file into a temporary file, but you can use it in 
combination with both òopen temporary fileó (see above) and òreplace selectionó (see below). The temporary 
file will be deleted after the tool has finished running. 

Turn on òreload the current fileó to force EditPad Pro to reload the file that was active when you invoked the 
tool as soon as the tool has finished running. You should do so if the tool will modify the current file, even if 
youõve turned on the option to reload modified files in the Open Files Preferences. Otherwise, EditPad Pro 
may not notice the file has changed until you switch between tabs in EditPad or between EditPad and 
another application. 

Mark òopen the temporary file into a new tabó if the tool will create or modify the temporary file and you 
want to see the changes in EditPad. If this option is checked, EditPad will open the file into a new tab and 
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then delete the temporary file from disk. If you want to save the toolõs result, use File|Save As. You can 
select the file type that EditPad Pro should use for the file. Select òsame as current fileó if the tool doesnõt 
output a specific file type. 

Mark òopen the temporary file into the message paneló if the tool will create or modify the temporary file and 
you want to see the changes in a side panel in EditPad. If this option is checked, EditPad will open the file 
into the message panel and then delete the temporary file from disk. You can select the syntax coloring 
scheme that the message panel should use. This scheme can be a scheme that is not used by any file type. 

Mark "replace the fileõs contents with the (altered) contents of the temporary file" to make EditPad Pro delete 
all text in the active file and then do a Block|Insert File using the temporary file, after the tool has finished 
running. 

Mark "replace the selection with the (altered) contents of the temporary file" if EditPad Pro should 
automatically delete the current selection and do a Block|Insert File using the temporary file, after the tool 
has finished running. Together with the òsave the selected part of current file into a new temporary fileó 
option, you can add a tool to EditPad Proõs menu that modifies the current selection. You could write a script 
to add special functionality that EditPad Pro does not provide. 

If youõve turned on at least one of the options to either open or save a temporary file, you can use 
the %TEMPFILE% path placeholder to pass the temporary fileõs name on the toolõs command line. All of 
the options will work on a single temporary file for each tool. 

Tool Standard I/O 

When adding a tool to EditPad Proõs Tools menu, there are three pages of settings that you can make for 
each tool. If you are adding a console or text mode application to EditPad Proõs Tools menu, then you can 
instruct EditPad Pro to communicate with the application via the options on the "Standard I/O" page. 
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By default, console applications read input from the keyboard and write output to the screen. On the DOS 
and Windows command line, you can use the less than and greater than symbols to redirect standard input 
and output. The command line "sometool <input.txt >output.txt" will cause sometool to read from input.txt 
and write to output.txt. 

You cannot use these symbols on the command line when configuring EditPad Pro to run a console 
application. However, you do have a variety of options for redirecting standard I/O on the "Standard I/O" 
page. 

What to Send to Standard Input 

If a tool expects data via standard input (i.e. it expects a DOS/Windows command line like "sometool 
<input.txt"), EditPad Pro is capable of sending either the current file entirely, or only the selected part of the 
current file. The current file is whichever file youõre editing at the moment you run the tool by selecting it in 
the Tools menu. 

If the tool is a text-based console application that accepts input from the keyboard, anything EditPad sends 
to the toolõs standard input will be processed by the tool as if you typed it on the keyboard. This does not 
work with graphical applications, since those do not use standard input to retrieve keyboard input. 

Before running the tool, EditPad Pro makes an internal copy of the text it needs to send to standard input. If 
the tool takes a long time to run, editing or closing the file EditPad is sending to the tool will not affect the 
toolõs execution. 
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How to Capture Standard Output 

If a text-based console application writes its output to the screen, or if an application outputs data to a file 
with a command line like "sometool >output.txt", EditPad Pro can capture that output in various ways: 

¶ Ignore: The toolõs standard output will be lost. Select this option if the tool doesnõt output anything 
useful to the screen, or if itõs a graphical application that doesnõt support standard output.  

¶ Replace selected text: EditPad will replace the selected part of the file that was active when you 
invoked the tool with the toolõs output. If there is no selection, the toolõs output will be inserted at 
the text cursor position. This option is particularly useful in combination with the option to send the 
selected text to standard input. That way, an external tool can provide text processing functions not 
provided by EditPad Pro itself.  

¶ Into message pane: EditPad will capture the toolõs output into a separate pane. Since EditPad Pro has 
only one message pane, the output of any previous tools that was captured into the message pane will 
be lost. Choose this option when a tool outputs status or error messages that you want to inspect but 
not keep. The message pane supports syntax coloring. EditPad Pro ships with a few òTool Errorsó 
and òTool Outputó syntax coloring schemes that make the output of some popular tools a bit more 
readable. You can use the Syntax Coloring Scheme Editor to create your own schemes, or you can 
download schemes in the Colors and Syntax tab in the File Type Configuration.  

¶ Into new tab: EditPad will create a new file tab to capture the toolõs output. If you run the tool more 
than once, a new tab will be created each time. Select this option if the tool outputs a lot of data or a 
complete file. You can edit, save and close the new tab like any other file youõd edit in EditPad.  

¶ Append to existing tab: EditPad will create a new tab to capture the toolõs output, and continue using 
that tab each time you run that tool, appending additional data each time. Choose this option if you 
want to save the results of multiple invocations of a tool into a single file.  

¶ Replace existing tab: EditPad will create a new tab to capture the toolõs output, and replace that tabõs 
contents whenever you run the tool again. Make this choice if the tool outputs too much information 
to neatly fit into the message pane, and you only want to keep the results of the last invocation of the 
tool.  

If you choose one of the three options to capture the output into a tab, you can make three additional 
settings for that tab: 

¶ Mark the tab as òmodifiedó if it contains data:  Turn on this option if you usually want to save the 
captured output into a file. If you close the file without saving, EditPad Pro will prompt just like 
when you close an unsaved file. Turn off this option if you usually want to discard the output. Note 
that if you edit the output, the tab will still become marked as modified.  

¶ Close the tab if it remains empty: This option is particularly handy when youõve chosen the òinto new 
tabó capturing option. It automatically closes the tab if nothing was captured, so your workspace 
doesnõt get cluttered with empty tabs.  

¶ File type for tab: Since standard output doesnõt have a file name, EditPad Pro cannot use the file 
masks from the file type configuration to determine the outputõs file type. Therefore, you can select 
one of the file types from the list. Choose the òsame as current fileó option for text processing tools 
that return a modified version of the file youõre editing.  

If you close the tab EditPad Pro is using to capture standard output while the tool is still running, the toolõs 
output will be lost. However, the tool will keep running until normal completion. EditPad Pro will keep 
clearing the toolõs standard output without saving it anywhere. 
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How to Capture Standard Error 

Standard error works just like standard output. While standard output is intended for console applications to 
produce their output, standard error is intended for their error messages. Not all console applications respect 
this distinction. Some may send error messages to standard output. When the application is run from a 
command prompt with output appearing on the screen, standard output and error are automatically 
combined onto the single screen. This makes some programmers forget to make their console applications 
distinguish between standard output and error. 

Therefore, EditPad Pro offers the òcombine with outputó option. EditPad Pro will then mingle standard 
error with standard output, just like a console screen would. The combined output will end up in whichever 
location (tab or message pane) you selected for standard output. 

All the other choices for standard error are identical to those for standard output. If you select one of the 
three tab options for both standard output and standard error, you will get two new tabs: one for standard 
output, and one for standard error. 

Since EditPad Pro has only one message pane, the only way to capture both standard output and standard 
error into the message pane is by selecting the òmessage paneó option for standard output, and the òcombine 
with outputó option for standard error. 

Tools|Message Panel 

On the Files tab in the tool configuration you can choose to load a temporary file created or modified by a 
tool into the Message panel. On the I/O tab you can choose to have the toolõs standard output and/or error 
redirected to the Message panel. The Message panel is a side panel in EditPad Pro. It has just one read-only 
edit box for displaying tool output. You can right-click the edit box to select and copy the text, and to toggle 
word wrap. 

If youõve closed the Message panel after running a tool, you can use the Message Panel item in the Tools 
menu to make it visible again. This item only appears in the Tools menu after youõve run a tool that uses the 
Message Panel. You cannot make the Message Panel visible if it hasnõt been used by a tool yet. 
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10. Macros Menu 

Via the Macros menu you can record and play back keystroke macros. With keystroke macros, you can 
automate repetitive editing tasks. 

Macros that you have already recorded appear at the top of the Macros menu. Selecting a macro in the menu 
executes it once. Select Organize Macros in the Macros menu if you want to run a macro multiple times. 

Macros|Record Macro 

To record a macro, select the Record Macro item in the Macros menu. EditPad Pro will ask you to enter a 
name for the macro. When you confirm the macroõs properties, recording begins immediately. 

When youõre done recording the macro, select the Stop Recording item in the Macros menu. Youõll notice itõs 
the only available command during recording. You cannot play back and record macros at the same time. 

To play back a macro, simply select it from the Macros menu or press its keyboard shortcut. The macro will 
be executed once. Select Organize Macros in the Macros menu if you want to run a macro multiple times. 

EditPad Pro automatically saves macros. You wonõt be prompted for a file name. If you want to save a macro 
into a file so you can share it with other people, use the Export command in the Organize Macros screen. 

How EditPad Pro Records Macros 

Before you start recording and playing back macros, itõs important that you understand exactly what EditPad 
Pro records. If you understand macros, theyõre a powerful and quick way to automate otherwise tedious and 
repetitive editing tasks. If you donõt understand macros, theyõre a quick way to completely mess up your files. 

Mouse Clicks Are Not Recorded 

Clicks are relative to the position and size of EditPadõs windows, to the location where youõve scrolled, etc. A 
click at a certain position on the screen may have a totally different meaning from one situation to the next. 
Therefore, mouse clicks are not recorded. If you move the mouse over the text editing area, the mouse 
pointer will indicate you canõt click. If you try, the click will have no effect at all. 

Menu item commands and button commands are recorded. You can invoke them with the mouse while 
recording a macro. EditPad Pro will record the command that you clicked on, rather than the click itself. 

Only Your Actual Actions Are Recorded 

EditPad Pro only records exactly those keystrokes that you type, or exactly those commands that you invoke 
when running a macro. E.g. if you select the Search|Find Next menu item while recording a macro, the 
macro only records that you selected Search|Find Next. It does not record the search term, the search 
options, etc. If you play back the macro, it will simply execute Search|Find Next again. If youõve changed the 
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search term or search options since recording the macro, the new term and options will be used for the 
search. 

By recording only your actual actions, you can make generic macros. E.g. if you want a macro that deletes 
every line with a search match, you can record Search|Find Next and Edit|Delete Line. You can then use 
that macro to delete the matches of any search term. Simply enter the correct search term before running the 
macro. 

This also applies to any keystrokes you type into the editor, search box or replace box. The macro will record 
the actual keystrokes. Their effect may be different when you run the macro, depending on the position of 
the text cursor and if any text was selected. Keep this in mind when recording macros. You may want to 
press a few extra keys to make sure the macro works well. E.g. instead of requiring a macro to have the cursor 
at the start of the line, simply press the Home key when you start recording the macro. Even if the cursor was 
already at the start of the line when you recorded the macro, it will still record that you pressed the Home 
key. 

How to Record Search Terms 

If you want to record search terms as part of a macro, you can do so by selecting the search term from the 
Search|History or Search|Favorites menu. The macro will then record the search text, replace text and all 
search options. You can temporarily add a search term to the favorites before recording the macro. The 
macro will store the actual search terms, not the fact that you selected an item from the history or favorites. If 
you later delete the item from the history or favorites, the macro will still work. 

Macros Record Command Options 

Some commands in the Extra menu, like Delete Duplicate Lines and Compare Files show a screen with 
options before doing their work. If you use these commands while recording, the macro will record the state 
of the options screen when you click the OK button. It will not record whether you toggled any options, but 
the final result. When you play back the macro, the command will be executed with those options every time, 
without showing the options screen. 

This rule may seem to contradict the òonly your actual actions are recordedó rule. However, thereõs a key 
difference between the search options and the alphabetic sort options. You can set the search options in 
EditPad Proõs main window. If you toggle a search option, the optionõs state is recorded. Therefore, you can 
òprepareó the search options before playing back a macro that didnõt record them. You could even record a 
macro that does nothing but set search options. 

The Delete Duplicate Lines commandõs options can only be set when youõve already told EditPad Pro to 
delete duplicate lines. You canõt prepare the options prior to executing the macro. 

The state of options that you can prepare are not recorded by macros, since actions that change the state of 
options that you can prepare are recorded. Commands with options that you cannot prepare record the state 
of the options as part of the command. 
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Failed and Inconsequential Commands Are Recorded 

Pressing the Home key on the keyboard while the text cursor is already at the start of the line does nothing. 
However, macros still record that inconsequential key press. When the macro is played back, it will move the 
cursor to the start of the line if it isnõt there already. 

Search commands are special in EditPad Pro. They can fail. If you click the Find Next button and it flashes, 
that means it failed. There was no next search match. While recording a macro, the Find Next command is 
still recorded. 

Failed Commands Halt Macro Playback 

Though not exactly a recording issue, itõs important to remember that if a search command fails during macro 
playback, it will stop the macro immediately. This allows you to run macros that run until failure to process all 
search terms. 

Organize Macros 

Select Organize Macros in the Macros menu to organize, play back and record macros. 

Repeated Playback 

Playing back a macro via the Organize Macros allows you to play back the same macro many times. Simply 
enter the number of times the macro should run in the Repeat box, and click the Play Macro button. The 
macro may run fewer times than you specified, but never more. 

If the macro includes a search command, and the search fails to find a match, macro playback will stop 
immediately. This enables you to record a macro that does something to a search match, and then run that 
macro on all search matches. Suppose you record a macro that executes the Search|Find Next command and 
then the Edit|Delete Line command. If you then execute this macro with Repeat set to 100, the macro will 
delete the lines containing the next 100 search matches. If there are fewer than 100 search matches, all their 
lines will be deleted, and the macro will stop. You can use the Search|Count Matches command to determine 
the number of times the macro should run, or you could simply enter a large enough number. 

However, there is a reason why you still need to enter an upper limit for the number of times the macro 
should run. You canõt tell EditPad Pro to run the macro until the search fails. The reason is that itõs quite 
possible for a search command to never fail. E.g. a macro that runs Search|Find First but doesnõt delete the 
search match will always find that search match. A macro using Search|Find Next with the òloop 
automaticallyó option turned on will loop forever if it doesnõt delete search matches. By specifying a 
reasonable number of times for the macro to repeat itself, you can prevent it from going on forever. 

Recording 

Click the Record button to record a new macro. EditPad Pro will ask you to enter a name for the macro. 
When you confirm the macroõs properties, the Organize Macros screen closes and recording begins 
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immediately. There are a number of important issues to keep in mind when recording macros. Make sure to 
review them. 

When youõre done recording the macro, select the Stop Recording item in the Macros menu. Youõll notice itõs 
the only available command during recording. You cannot play back and record macros at the same time. 

Organizing Macros 

Click the Properties button to rename a macro or to change its shortcut key, or to rename a folder. You can 
add folders with the New Folder button. To put macros into a folder, simply drag and drop them with the 
mouse. If you have a lot of macros, organizing them in folders makes it easier to find them later. 

Import and Export 

EditPad Pro automatically saves all your macros internally along with your preferences, history lists, etc. If 
you want to share a macro with other people, or copy it from one computer to another, use the Export 
Macro button. The selected macro is then saved into the file that you specified. You can open the file in 
EditPad Pro to view its contents if you like. However, macro files are not intended to be edited. 

If youõve received a macro that youõd like to run in a file, first import it with the Import Macro button. The 
macro is then added to your list of macros. You can play back imported macros just like macros that you 
recorded yourself. The macro file is no longer needed once youõve imported it. 

You can export multiple macros into a single file by selecting multiple macros before clicking the Export 
Macro button. If you include one or more folders in your selection, all the macros in those folders and their 
subfolders will be exported. If you click the Export Macro button a second time and select an existing file, 
EditPad Pro will replace that file rather than append to it. When importing a file that holds more than one 
macro, all of the macros will be imported. If you wanted to import only some, you can delete the extraneous 
ones after importing the file. 

Macros|Record Instant Macro 

The Record Instant Macro command in the Macros menu records a macro just like Macros|Record Macro 
does. The only difference is that EditPad Pro doesnõt ask you for a name and keyboard shortcut for the 
macro. The only way to play back the instant macro is with Macros|Play Instant Macro. 

Only one instant macro is preserved at a time. Recording a new instant macro deletes the previous instant 
macro without warning. 

Use instant macros when you want to quickly record and play back a group of keystrokes a few times. 

Macros|Play Instant Macro 

Use the Play Instant Macro command in the Macros menu to play back the macro you last recorded with 
Macros|Record Instant Macro. 
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Macro Properties 

The Macro Properties screen appears when you select the Record Macro 

item in the Macros menu, and when you click the Properties button when organizing macros. 

EditPad Pro macros have only two properties: a name, and an optional keyboard shortcut. Each macro must 
have a unique name. If you start recording a new macro with the same name as an existing macro, the existing 
macro is automatically and silently replaced. 

The keyboard shortcut can either be a single key combination, or a double key combination. Assigning a 
shortcut to a macro works just like assigning shortcuts in the Keyboard preferences. The procedure is 
explained in detail in the help topic about Keyboard preferences. If you assign a shortcut to a macro that is 
already assigned to another macro, the new macro will take over the shortcut from the old macro. You 
cannot assign a shortcut thatõs already used for a menu item to a macro. 
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11. Extra Menu 

Extra|Spell Check 

Select |Spell Check from the Extra menu to check the spelling of the current file. The spell check function 
always starts from the beginning of the file. 

The pane below appears during the spell check process: 

 

When a word is not found in the dictionary, it will be selected in the editor and reported in the upper left area 
of the spell check pane. EditPad Pro will start searching through the dictionary for words similar to the 
misspelled one, and show them in the list. As long as "(searching...)" is visible, EditPad Pro is still looking for 
more possible, correctly spelled substitutions. You do not have to wait until EditPad Pro is finished. You can 
correct the error right away. 

If the word is really misspelled, you can type in the correctly spelled word in the òReplace withó field. You 
can also click on an item in the list with EditPad Proõs suggestions and it will automatically be placed in the 
òReplace withó field. If you click on òSuggest similaró, EditPad Pro will start looking for words in the 
dictionary similar to what you typed into the òReplace withó field. 

Then you need to click one of the three replace buttons:  òReplaceó will replace the misspelled word with the 
replacement just this time. òReplace Alló will replace the misspelled word with the replacement every time it 
is found during the current EditPad Pro session. When you pick File|Exit or switch to a different language, 
the replacement is forgotten. If you click òLearn Replaceó, EditPad Pro will always automatically replace the 
misspelled word with the replacement and remember this even if you quit EditPad Pro. 

You can also fix the error directly in the editor. After doing so, you will have to click the òResumeó button to 
continue to check the spelling of the rest of the file. 

If the word is correctly spelled, you can click òIgnoreó to accept the word as correct just this time. òIgnore 
Alló will make EditPad Pro ignore all occurrences of this word until you switch languages or close EditPad 
Pro. òLearnó will make EditPad Pro add the word to its dictionary and will from then on always be accepted 
as correct. 

If you make a mistake, click on òBackó to restore the original word. 

Click òAbortó to stop spell checking and close the pane. 

The òWord Listó button allows you to edit the list of words that you added to the custom dictionary. When 
you click the button, a new window will appear. The left hand side of the window contains the list of words 
that you specified as correctly spelt by clicking on the òLearnó button. The right hand side of the window 
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contains pairs of words separated by an equals sign (=). These are the automatic replacements you added by 
clicking the òLearn Replaceó button. Whenever the spell checker finds the word at the left side of the equals 
sign, it will be replaced with the word at the right of the equals sign. 

Extra|Spell Check Selection 

Select òSpell Check Selectionó from the Extra menu to check the selected portion of the current file for 
spelling errors. See Extra|Spell Check for a description of the spell check pane. 

Extra|Spell Check Project 

Select òSpell Check Projectó from the Extra menu to check all files in the current project for spelling errors. 
See Extra|Spell Check for a description of the spell check pane. 

Extra|Spell Check All 

Extra|Spell Check All will activate the first file and start the spell check process. When the first file has been 
completed, the second file will be activated and the spell checker will be invoked on that file, until all files 
have been checked or you clicked the Abort button on the spell check page. 

See Extra|Spell Check for a description of the spell check pane. 

Extra|Live Spelling  

Pick Live Spelling from the Extra menu to turn on or off live spell checking for the current file. Live spell 
checking will mark all words that do not appear in the dictionary. By default, they will appear underlined and 
in red. You can change the look and whether live spelling is on or of by default in File Types|Colors. 

Live spelling, as well as the regular spell check in EditPad Pro, works together with EditPad Proõs syntax 
coloring. Each syntax coloring scheme can exclude certain parts of the file from the spell check. Schemes for 
programming languages, such as the C++ and Java schemes, will restrict the spell checker to strings and 
comments. Those are likely to contain natural language, and therefore words that should appear in the 
dictionary. Other parts of the file are likely to contain specialized programming syntax, consisting of words 
and character sequences that are not English words. 

If a word is marked as misspelled, you can double click on it to open the spell check pane. The pane will 
present you with a list of suggested replacements for the word, as well as allow you to ignore the word or add 
it to the dictionary. As soon as the word has passed the spell check, the spell check pane will close 
automatically. 
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Download Spell Check Dictionaries 

Before you can use Extra|Spell Check or Extra|Live Spelling, you need to download and install spell check 
dictionaries for one or more languages. You can easily do so right within EditPad Pro. Pick 
Options|Configure File Types from the menu, and click on the Colors and Syntax tab. Click the button 
òDownload Spell Checker Dictionariesó. EditPad Pro will then connect to the Internet to fetch a list of 
available languages. 

 

If you want, you can choose the folder into which the dictionaries should be installed. If you specify a folder 
that does not exist, EditPad Pro will create it. All dictionaries must be installed into the same folder. If you 
already installed some dictionaries, and then install another dictionary into a different folder, EditPad Pro will 
move the previously installed dictionaries to the new folder. 

To install a dictionary, click on the language you want in the list, and click the Install button. EditPad Pro will 
then automatically download the dictionary, and install it into the folder you specified. A progress meter will 
appear while downloading. 

You can have as many dictionaries installed as you want. There is no need to uninstall dictionaries. However, 
if you want, you can select a language and click the Uninstall button to delete a spell check dictionary. 
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If you are behind a proxy server, and EditPad Pro is unable to detect your proxy settings, you can change 
them by clicking the Settings button. 

Due to firewall and other network settings, it is possible that EditPad Pro cannot connect to the Internet 
directly. In that case, you can manually download and install the dictionaries from 
http://www.editpadpro.com/spell.html 

Extra|Sort Alphabetically A-Z 

If no part of the active file has been selected, Extra|Sort Alphabetically will sort the entire file alphabetically, 
paragraph by paragraph. 

To sort the entire file on a specific column of text, select that column of text before selecting Extra|Sort 
Alphabetically first. Make sure that the selection does not span more than one paragraph. All the paragraphs 
in the file will be sorted, using the selected column as the sort key. 

If the selection spans more than one paragraph, then the selected paragraphs will be sorted. If you want to 
sort only a selected number of paragraphs on a certain column, make a rectangular selection first. The 
paragraphs that are partially covered by the rectangular selection will be sorted entirely as if the selection was 
a normal one. However, the sort order will not be determined by their entire paragraph text, but only by the 
text covered by the selection. 

If you are working with a text files that contains information arranged in columns, padded with spaces, you 
could make a rectangular selection of the third column and then use Extra|Sort Alphabetically. The data will 
then be sorted on the third column. 

The progress meter indicates the percentage of paragraphs that have already been sorted. The sort operation 
works from top to bottom. If you abort the operation, the paragraphs that have already been sorted will 
remain sorted, and the unsorted paragraphs will maintain their old position. If you want to cancel the sort 
altogether and revert its results, use Edit|Undo. 

Extra|Sort Alphabetically Z-A 

Extra|Sort Alphabetically Z-A works just like Extra|Sort Alphabetically A-Z, except that the file or the 
selected text is sorted in reverse alphabetical order. 

Extra|Delete Duplicate Lines 

Select the Delete Duplicate Lines item in the Extra menu to delete lines with (nearly) identical text on them. 
The status bar will indicate how many lines were deleted. You can make a number of choices as to what 
EditPad Pro will consider a duplicate line. 
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Scope 

If youõve selected part of the file before using the Delete Duplicate Lines command, you can limit the 
command to delete only lines that are selected. If the first and/or last line in the selection are only partially 
selected, the selection will be expanded to include them entirely. If the selection is rectangular, lines covered 
by the selection will be deleted entirely. 

Proximity of Duplicate Lines 

Select òanywhere in the scopeó to delete all lines that are duplicated anywhere. The first copy of the line will 
remain, while all the others will be deleted. If youõve set the scope to òselected linesó, the lines must be 
duplicated inside the selection. Lines that are not duplicated inside the selection will not be deleted, even if 
they have lines outside the selection. 

Select òadjacent lines onlyó if you only want to delete a lineõs duplicates if theyõre immediately below the line 
they duplicate, without any other lines between them. If the fileõs lines are sorted alphabetically, then the end 
result of òanywhere in the scopeó and òadjacent lines onlyó will be the same. In a sorted file, all duplicates are 
sorted together. However, selecting òadjacent lines onlyó will delete the duplicate lines significantly faster, 
certainly when the number of lines in the file is large. If you select òanywhere in the scopeó, EditPad Pro has 
to compare each line with every other line in the file. 

Comparison Options 

By turning on one or more comparison options, you can tell EditPad Pro to consider lines as duplicates even 
when they arenõt identical. 

The òcompare selected columns onlyó is only available when youõve made a selection that does not span 
more than one line, or when youõve made a rectangular selection. With this option, EditPad Pro will only 
compare the selected columns. E.g. if the selection spans from column 10 to column 20, EditPad Pro will 
compare columns 10 through 20 of each line. If a line has less than 10 characters it will be considered blank. 
This has important consequences (see next section). 

òIgnore differences in leading spaces and tabsó will treat lines that only differ in the number of spaces and 
tabs at the start of the line as duplicates. Similarly, òignore trailing spaces and tabsó ignores differences in 
spaces and tabs at the end of each line. òIgnore all differences in spaces and tabó is more than a combination 
of the two previous options. EditPad Pro will then completely ignore all spaces and tabs, including spaces and 
tabs in the middle of lines. 

òIgnore difference in caseó compares lines without regard to the difference between upper case and lower 
case letters. 

Lines to Delete 

You must select one or two choices in the òlines to deleteó section. Every line in the file belongs to one of 
the 3 categories. Selecting none of the options would have no effect, and selecting all of them would delete all 
the lines in the file. 
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Turn on ò2nd and following occurrences of duplicate linesó and turn off the other two options to delete all 
duplicate lines, leaving only unique files in the file, regardless of whether they were previously unique. Use 
this to delete unnecessary duplicates from a file. 

Turn on both "2nd...ò and ó1st occurrence of duplicate lines" to delete all duplicate lines, leaving only lines 
that were previously unique. 

Turn on both "2nd...ò and ónon-duplicated lines" to leave only one copy of all lines that had duplicates. If 
you paste the contents of two lists that consist of unique lines (when viewed separately) into a file in EditPad, 
then you can use this combination to get the lines that occurred in both files, but not the lines that occurred 
in only one of the files. 

If you want to keep only lines that occur a certain number of times, use the Delete Duplicate Lines several 
times. E.g. if you only want lines that occur 3 times or more, use it twice with the "1st 
occurrence...ò and ónon-duplicated..." options turned on. Then use it again with the "2nd 
occurrence...ò and ónon-duplicated..." options. The first time you delete the lines that occur only once, the 
second time you delete lines that occur only twice, and the third time you delete the duplicates of lines that 
occur four times or more. 

Blank Lines 

Since blank lines are technically all duplicates of each other, EditPad Pro offers you an extra choice for blank 
lines. You can choose to either delete all blank lines, not to delete any blank lines, or to only delete duplicate 
blank lines. The òduplicate blank linesó option takes into account the òproximityó setting, deleting either all 
but the first blank lines (òanywhere in the scopeó), or only replacing subsequent blank lines with a single 
blank line (òadjacent lines onlyó). 

If youõve turned on the òcompare selected columns onlyó option, a line may be considered blank even when 
it isnõt. If a line is shorter than the leftmost column in the selection, it is considered to be blank, even if it 
does have text on it. 

Lines with only spaces and tabs on them are only considered to be blank if youõve turned one of the options 
to ignore differences in spaces and tabs. On a line with only spaces and tabs, all spaces and tabs are 
considered to be both leading and trailing at the same time. 

Extra|Delete Blank Lines 

Select Delete Blank Lines in the Extra menu to delete all totally blank lines from the file. Only lines that have 
no characters at all are deleted. Lines that consist solely of whitespace are not deleted. 

If you want to delete lines that have whitespace too, first use Extra|Trim Trailing Whitespace to remove the 
whitespace, and then use Delete Blank Lines. 
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Extra|Consolidate Blank Lines 

Select Delete Blank Lines in the Extra menu to replace all blocks of consecutive totally blank lines with a 
single blank line. Only lines that have no characters at all are consolidated. Lines that consist solely of 
whitespace are ignored. 

If you want to consolidate lines that have whitespace too, first use Extra|Trim Trailing Whitespace to remove 
the whitespace, and then use Consolidate Blank Lines. 

Extra|Trim Leading Whitespace 

Select Trim Leading Whitespace in the Extra menu to remove whitespace from the start of each line. If you 
selected part of the file, only lines that area selected will be trimmed. If not, all lines in the file will be 
trimmed. 

If youõve made a rectangular selection, EditPad Pro will only delete whitespace inside the rectangular block. 
Whitespace in the leftmost selected column and adjacent columns to the right will be deleted. This whitespace 
neednõt be at the start of the line 

Extra|Trim Trailing Whitespace  

Select Trim Trailing Whitespace in the Extra menu to remove whitespace from the end of each line. If you 
selected part of the file, only lines that area selected will be trimmed. If not, all lines in the file will be 
trimmed. 

If youõve made a rectangular selection, EditPad Pro will only delete whitespace inside the rectangular block. 
Whitespace in the rightmost selected column and adjacent columns to the left will be deleted. This whitespace 
neednõt be at the end of the line. If a line is short and doesnõt extend to the rightmost selected column, any 
whitespace at the end of the line covered by the selection will be deleted. 

Extra|Trim Whitespace 

Select Trim Whitespace in the Extra menu to remove whitespace from the start and the end of each line. If 
you selected part of the file, only lines that area selected will be trimmed. If not, all lines in the file will be 
trimmed. 

If youõve made a rectangular selection, EditPad Pro will only delete whitespace inside the rectangular block. 
Whitespace in the leftmost selected column and adjacent columns to the right will be deleted. Whitespace in 
the rightmost selected column and adjacent columns to the left will also be deleted. 
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Extra|Compare Files 

If you have two versions of the same text file, you can use Extra|Compare Files to visualize the differences 
between those files. After that, you can edit the generated difference file to merge both versions into a single, 
new file. 

First you need to open the two files you want to compare. The Extra|Compare Files menu item will be 
grayed out until you have two or more files open. 

 

Selecting Files 

To compare the files, first activate the file that contains the original or older version of the document by 
clicking on its tab. Then select Extra|Compare Files from the menu. In the window that appears, click on the 
file that contains the newer version of the document, in the list of files that are currently open. The active file 
is omitted from that list, since you cannot compare a file with itself. 

The file that was active at the time you selected Extra|Compare Files in the menu will be considered the 
òoldó file. The file that you select in the file comparison options screen will be considered the ònewó file. 
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How to Compare The Files 

You can specify several options when comparing files. The setting for the minimum match size will be 
explained in detail later. 3 is a good default value. 

You can choose to ignore differences in leading spaces and tabs. That is, when comparing two lines, EditPad 
Pro will ignore any space and tab characters at the start of the lines. Similarly, you can choose to ignore 
trailing spaces and tabs. That is, spaces and tabs at the end of a line. You can mark both options to ignore 
both leading and trailing spaces and tabs. If you mark òignore all differences in spaces and tabsó, then 
EditPad Pro will ignore any spaces and tabs throughout both files when comparing their lines. These options 
are useful when comparing files where differences in whitespace have little or no meaning. 

If you turn on òignore added and removed blank linesó, EditPad Pro will not add blank lines that occur only 
in one of the two compared files to any new file created by the file comparison. Those lines will also not be 
highlighted in the original files. Lines with only spaces and tabs will be considered to be blank only if youõve 
turned on one of the options to ignore differences in spaces and tabs. 

Finally, òignore differences in caseó tells EditPad Pro to ignore whether a character is uppercase or lowercase, 
making òAó identical to òaó. 

What to Display 

If you select to highlight changes in the original files, EditPad Pro will mark lines present in the òoldó or 
òoriginaló file in red when they are not present in the ònewó or òeditedó file. It will also mark lines in the 
ònewó file in green when they are not present in the òoldó file. You can configure the "compare files: deleted 
lineò and ócompare files: added line" colors in the Colors Preferences. 

If you turn on ònew file with fully merged contentsó, EditPad Pro will create a new tab with the two files 
merged, based on their differences. The tab will be labeled òOldFile compared with NewFileó. Lines that are 
identical in both files are added once and displayed on a normal background. Lines only present in the òoldó 
file are added on a red background, and lines only present in the ònewó file are added on a green background. 
If the text on a line was changed between the òoldó and ònewó versions of the file, EditPad Pro will first add 
the old version of the line on a red background, and then the new version of the line on a green background. 
If consecutive lines where changed, EditPad Pro will first add a block with the old versions of all the 
consecutive lines, and then the new versions of the consecutive lines. 

òNew file with removed and added linesó is the same as ònew file with fully merged contentsó, except that 
lines present in both the òoldó and ònewó files are not added. Lines are highlighted red and green. 
Consecutive changed lines are grouped in the same way. The tab will be labeled òDifferences between 
OldFile and NewFileó. 

òNew file with removed lines onlyó contains a tab with lines that are present in the òoldó file, but not in the 
ònewó file. Since all lines are old lines, none of them are highlighted. The tabs label will be òLines from 
OldFile removed in NewFileó. 

Similarly, ònew files with added lines onlyó creates a tab labeled òLines not in OldFile added to NewFileó 
with lines present in the ònewó file, but not in the òoldó file. 
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Finally, ònew file with unchanged lines onlyó creates a tab labeled òLines unchanged between OldFile and 
NewFileó. This tab will show all the lines present in both files. 

All new tabs with difference output behave like a regular files in EditPad Pro. You can use any editing 
command on them and save them for later use. If you open the View|File History, it will remind you of the 
two files that were compared, and which was the òoldó or òoriginaló file, and which was the ònewó or 
òeditedó file. 

Minimum number of lines for matching block 

When you pick Extra|Compare Files from the menu, EditPad Pro will ask for a file to compare the active 
one with. Near the bottom of the selection window, you will see the spinner box labeled òminimum number 
of lines for a matching blockó. 

The default setting is 3. You can set it to any number from 1 up to and including 9. 

This value is used by EditPad Pro in the following situation. While comparing the files, it encounters a 
section of one or more changed paragraphs. In the difference output, these paragraphs are grouped into a 
single red block showing the original paragraphs, followed by a single green block with the new paragraphs. 
This is done because all those paragraphs are most likely to be connected somehow: a chapter in a book that 
was heavily edited, a source code routine that has been modified, etc. Keeping those paragraphs together 
maintains their logical connection so you can easily see what happened when inspecting the output of 
Extra|Compare Files. 

To even better maintain the logical structure of the document, you can have EditPad Pro also include a few 
paragraphs in the block that are identical in both versions of the document. This will happen when you set 
òminimum number of lines for a matching blockó to a number greater than one (1). 

The setting indicates the minimum number of consecutive paragraphs that are identical in both files are 
required for EditPad Pro to stop grouping the modified paragraphs and add the identical paragraphs as an 
unchanged block. The graphical illustrations below make this clear. 

First you see the old and new version of our test document: 
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Then we use Options|Compare Files, and set òminimum number of lines for a matching blockó to one, 
effectively turning off the feature. This is the result: 

 

You see that EditPad Pro detects the line òVersion 2ó as being inserted. 
It also detects that the lines numbered 3 and 7 are present in both files, and that the blocks 1-2, 4-6 and 8-9 
have changed. This is technically exact (it is the optimum solution), but logically it makes no sense. The arrow 
is broken into pieces. 

If we try again and set òminimum number of lines for a matching blockó to anything greater than 1, we get 
the following result: 
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Much better!  The "I created..." line is still included on its own since it does not follow a block of changed 
paragraphs, but an inserted one. 

However, the lines containing the numbers 3 and 7, even though they are present in both files, are displayed 
in the middle of the changed block as if they had been changed too. This way, our logical structure, the arrow, 
is kept together nicely and we can instantly see what happened: the arrowõs direction was changed. This was 
not at all so clear in our first comparison attempt. 

Since you will not be comparing arrows but real documents such as source code files, the òminimum number 
of lines for a matching blockó can be configured for the task at hand. Many source code files contain lines 
with nothing but a curly brace or a òbeginó or òendó. These lines add structure to the source, and not 
content. When comparing two versions of a piece of source, these lines are likely to be matched all over the 
place, breaking up the logical structure of the source code in the difference output. 

If things donõt look right, experiment with the òminimum number of lines for a matching blockó setting. 

Extra|Compare with File on Disk 

The Compare with File on Disk item in the Extra menu works just like the Compare Files item, with one key 
difference. Whereas Compare Files asks you which file you want to compare the active file with, Compare 
with File on Disk compares the active file with the same file on disk. If you have made changes to a file in 
EditPad Pro and you havenõt saved those changes yet, you can use Compare with File on Disk to see the 
changes that you made. 
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Extra|Next Comparison  Mark 

If you have used Extra|Compare Files or Extra|Compare with File on Disk, you can use Extra|Next 
Comparison Mark to find the block of differing paragraphs after the text cursorõs position. 

Extra|Previous Comparison Mark 

If you have used Extra|Compare Files or Extra|Compare with File on Disk, you can use Extra|Previous 
Comparison Mark to find the block of differing paragraphs before the text cursorõs position. 

Extra|Clear Comparison Marks 

After youõve used Extra|Compare Files or Extra|Compare with File on Disk, the files you compared may 
have their differences highlighted. If youõre done comparing the files but want to continue working with them 
in EditPad Pro, select Clear Comparison Marks in the Extra menu to remove the red and green highlights. 

If you donõt want to continue working with the files, simply close them. You donõt need to remove the 
comparison marks first. 
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Extra|Statistics 

Choose Statistics from the Extra menu to have EditPad Pro compute a bunch of statistics about the file you 
are currently editing. EditPad Pro will create a new tab to hold the statistics. An example: 

                           Filename: 
S: \ JGsoft \ EditPad7 \ Help \ source \ extrastatistics.txt  
                         Last saved: 11 - Feb- 2011 11:32  
                          File size: 3,260 bytes  
               Number of paragraphs:    41  
                    Number of words:   497  
       Number of letters and digits: 2,332  

     Number of printable characters: 2,594  
         Total number of characters: 3,260  

                     Selection size:   6 38 bytes  
                     Selected words:    69  
        Selected letters and digits:   338  
      Selected printable characters:   365  
Total number of selected characters:   638  

The first two lines indicate under which name the file was saved, and when it was last saved. The third line 
indicates the size of the file in bytes. The total file size is the total number of characters in the file, including 
hidden character such as line breaks. 

If part of the file was selected before you picked Extra|Statistics from the menu, then the size in bytes of the 
selection is indicated as well. 

òNumber of paragraphsó indicates the number of paragraphs in the file. A paragraph is a sequence of 
characters terminated by pressing Enter on the keyboard, which inserts a hard return into the file. If you turn 
off word wrapping, then each paragraph is displayed as one line. The number of lines is not indicated in the 
statistics, because it varies with word wrapping. 

Number of words indicates the number of sequences of òletters and digitsó, separated by sequences of ònon-
lettersó. A sequence consisting of a single letter or digit is also considered a word. A òletter or digitó is any 
character that is matched by the character class «\ w» in regular expressions. This includes letters, digits, and 
underscores in all scripts. You can test what EditPad Pro considers a letter by picking Search|Prepare to 
Search from the menu, typing «\ wè into the search box, turning on the option òregular expressionsó, and 
clicking the Search button. To search for words, use \ w+ (slash lowercase w plus) instead. 

òNumber of charactersó indicates the number of printable characters. This includes all characters except 
spaces, tabs, line breaks and other control characters. òTotal number of charactersó counts all characters, 
including whitespace, line breaks, and control characters. 

Extra|Project Statistics 

Like Extra|Statistics, Project Statistics will create a new tab with statistics. It will compute the same statistics, 
but for all files in the current project rather than the current file only. The order of the files in the statistics is 
the same order as in which they are arranged in EditPad Proõs tabs. If you want the files to be sorted 
alphabetically, use View|Sort Tabs Alphabetically prior to using Extra|Statistics for All Files. 
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Extra|Statistics for All Files 

Like Extra|Statistics, Statistics for All Files will create a new tab with statistics. It will compute the same 
statistics, but for all files in all projects rather than the current file only. The order of the files in the statistics 
is the same order as in which they are arranged in EditPad Proõs tabs. If you want the files to be sorted 
alphabetically, use View|Sort Tabs Alphabetically prior to using Extra|Statistics for All Files. 
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12. Convert Menu 

Convert|To Uppercase 

Converts the current selection to all uppercase letters. If there is no selection, the line the cursor is on is 
converted to uppercase. 

Convert|To Lowercase 

Converts the current selection to all lowercase letters. If there is no selection, the line the cursor is on is 
converted to lowercase. 

Convert|Initial Caps 

Turns all the letters in the current selection into lowercase letters, except for the first letter of each word 
which becomes uppercase. If there is no selection, the line the cursor is on is converted to initial caps. 

Convert|Invert Case 

Turns all uppercase letters in the selection into lowercase letters, and all lowercase letters into uppercase. If 
there is no selection, the line the cursor is on is inverted. 

If you have been typing with Caps Lock on, you do not have to start over. Let this function come to the 
rescue. 

Convert|Text Encoding 

Computers deal with numbers, not with characters. When you save a text file, each character is mapped to a 
number, and the numbers are stored on disk. When you open a text file, the numbers are read and mapped 
back to characters. When saving a file in one application, and opening the that file in another application, 
both applications need to use the same character mappings. 

Traditional character mappings or code pages use only 8 bits per character. This means that only 256 
characters can be represented in any text file. As a result, different character mappings are used for different 
language and scripts. Since different computer manufacturers had different ideas about how to create 
character mappings, thereõs a wide variety of legacy character mappings. EditPad supports a wide range of 
these. 

In addition to conversion problems, the main problem with using traditional character mappings is that it is 
impossible to create text files written in multiple languages using multiple scripts. You canõt mix Chinese, 
Russian and French in a text file, unless you use Unicode. Unicode is a standard that aims to encompass all 
traditional character mappings, and all scripts used by current and historical human languages. 
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How to Make a File Readable in EditPad 

If youõve received a text file from another person, or opened a file created on another computer, it may not 
immediately be readable in EditPad. Two things need to be set right. First, you must use a font that contains 
the characters you want to display. While all fonts contain English characters, far fewer fonts contain Chinese, 
Thai, or Arabic characters. In EditPad, select Options|Font in the menu. Make sure to select the script you 
want in the lower right corner of the font selection screen. 

If you use multiple scripts in a single file, then you probably wonõt have a single font that can (nicely) display 
all of those scripts. Fortunately, EditPad can use any number of fonts at the same time, and automatically use 
each font only for those scripts that it supports. Select Options|Text Layout in the menu. Set òtext layout 
and directionó to òcomplex scriptó. Select a main font and any number of fallback fonts. If the main font 
doesnõt support certain script, EditPad displays that script using the first fallback font that does support it. 

If the file still isnõt displayed property after youõve selected a proper font, the file was saved with a different 
character encoding than EditPad is using. Select Text Encoding in the Convert menu to change the encoding 
EditPad uses for that file. 

At the top of the screen, you will see part of the file as EditPad interprets it now, along with the encoding 
used. Make sure the "interpret the original data as being encoded with another character set" is 
marked. Then, try selecting a new encoding. The result will appear immediately in the preview at the bottom 
of the screen. Keep trying different encodings until you find one that produces a readable file. 

If the file was created on a computer running Windows, try the Windows encodings first. All Windows 
computers use one of the Windows encodings as the default. UTF-8 and UTF-16 little endian are also likely, 
as Unicode is becoming popular among modern Windows applications. 

If the file was created on a computer running a UNIX variant such as Linux, try the ISO-8859 and EUC 
encodings. UTF-8 and UTF-16 little endian are also likely. 

If the file was created on a modern Mac running OS X, it probably uses UTF-8. If it was created on an older 
Mac, try the Mac encodings. 

If the file was created by a old DOS application, try one the DOS character sets. The DOS character sets 
were used by Microsoftõs MS-DOS and DOS versions from other companies. If you know that the file is 
supposed to contain òline drawing symbolsó, the DOS character sets are also very likely. The DOS character 
sets are the only ones that contain line drawing symbols. DOS applications used characters that look like 
lines, bevels and corners to draw pseudo-graphical interfaces on character-based screens. DOS predates 
Unicode, so the Unicode formats are unlikely, even if they contain line drawing symbols. 

If the file is written in Russian or Ukrainian, the KOI8-R and KOI8-U encodings are very likely candidates, 
even for files created on Windows or UNIX systems. Particularly ISO-8859-5 has never reached the 
popularity of KOI8. 

If the file was created on an old mainframe or an IBM AS/400 (renamed iSeries) system, try the EBCDIC 
encodings. EBCDIC was the de facto standard in the days computers used punch cards. If EBCDIC doesnõt 
produce a readable file, try the DOS character sets, which were used by IBMõs PC-DOS. 
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Non-Representable Characters Replaced with Question Marks 

There are two ways in which a text editor can keep files in memory while editing them. Some editors use 
Unicode internally. On Windows that is typically UTF-16 LE. When you open a file that uses any other 
encoding, it is converted into UTF-16 LE in memory. When you save the file, it is converted back into the 
other encoding. The benefit is that the developers of such editors have only one encoding to deal with for all 
editing functions. The downside is that the conversion takes extra time and extra memory. Such editors 
usually donõt perform with very large files. If a file is loaded with the wrong encoding, it has to be reloaded 
with the correct one. If you donõt notice the wrong encoding is being used, or if it contains bytes that are 
invalid for the encoding that the file actually uses, data loss may occur. Thereõs no way to preserve invalid 
byte sequences when converting to UTF-16. 

When EditPad loads a file, it loads its actual bytes into memory. In EditPad Pro you can even see those bytes 
by switching to hexadecimal mode. That is what the term òoriginal dataó in the choices in the Convert|Text 
Encoding window refers to. Because EditPad keeps the fileõs original bytes in memory, it can instantly change 
how it interprets those bytes. Simply use the òinterpretó option in the Text Encoding window and select 
another encoding. This option does not change the contents of the file at all, nor is there any need to reload 
the file. It only changes how EditPad translates the bytes into characters. 

While you edit a file, EditPad converts those bytes into characters on-the-fly for display. When you type in or 
paste in new text, EditPad immediately converts the characters you type into the appropriate bytes for the 
fileõs encoding. That means if your file doesnõt use Unicode, you can only type in or paste in characters that 
are supported by the fileõs encoding. EditPadõs Character Map can show you all those characters. 

If you paste in characters that are not supported by the fileõs encoding, EditPad has no way to convert those 
characters into bytes to store them into the file. Such characters will be lost. They are permanently changed 
into question marks to indicate the actual characters you tried to paste could not be represented. In order to 
paste the actual characters, first use Edit|Undo to remove the question marks. Then use Convert|Text 
Encoding with the òencode original data with another character setó option. Select a Unicode transformation 
or any encoding that supports the characters you want to paste, as well as those already present in the file. 
EditPad then changes the bytes in the file to represent the same characters in the new encoding. Now you can 
paste your text again and get the actual characters. Note that you have to undo pasting the question marks. 
Changing the encoding does not magically restore the characters. Since EditPad Pro uses the fileõs actual 
encoding for in-memory storage rather than Unicode, newly typed or pasted characters that cannot be 
represented cannot be stored. 

How to Make an EditPad File Readable by Others 

To make sure other people can read files youõve written in EditPad, simply save it in an encoding that the 
other person can read. If he or she also uses Windows, you donõt need to do anything. EditPadõs default text 
encoding settings save the file in your computerõs default Windows code page. 

If the file is written in English, you also have little to worry about. English text is encoded the same way in 
UTF-8, all Windows code pages, all ISO-8859 code pages, all DOS code pages, all Mac code pages, and also 
KOI8. 

If your document uses non-English characters, and youõre not sure which encodings the other person can 
read, the UTF-8 encoding is a safe bet. UTF-8 files start with a byte order marker that identify them. EditPad 
and many other applications running on Windows, Linux and Mac OS X detect the byte order marker, and 
automatically interpret the file as UTF-8. Since UTF-8 is a Unicode transformation, it supports all modern 
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human languages. All characters present in any of the non-Unicode code pages supported by EditPad are also 
present in the Unicode mapping. 

To change a fileõs encoding, select Text Encoding in the Convert menu. Mark the "encode original data 
with another character set" option and select the encoding you want to convert the file into. If you get a 
bold red warning that some characters could not be converted, this means that the encoding you are trying to 
convert the file into cannot represent some characters youõve used in the file. Those characters will be 
replaced by question marks if you proceed with the conversion. The Unicode encodings are the only ones 
that can represent all characters from all human languages. The others are typically limited to English plus 
one language (e.g. Chinese) or one group of languages (e.g. Western European languages). 

Convert|To Windows (CR LF) 

Converts the active file to the line break style used by Windows and DOS text files. These operating systems 
terminate each line with a Carriage Return and Line Feed pair. Only the line termination characters are 
converted. Anything else remains untouched. 

To EditPad, it does not matter whether a file uses Windows, UNIX, or Mac line breaks. EditPad even 
handles files that use a mixture of all three. However, other applications often only support the òproperó line 
breaks for their environment. Windows applications like Notepad display UNIX text files with everything on 
one line. 

Use the Convert|To Windows command to make sure your file uses consistent Windows line breaks if youõll 
be using the file with other Windows applications. If the Convert|To Windows menu item is grayed out, that 
means the file already uses Windows line breaks consistently. 

If line break styles matter for your work, use the Status Bar Preferences to enable a status bar indicator to 
show the fileõs (dominant) line break style. In EditPad Pro, in the Editor Preferences you can configure 
Options|Visualize Line Breaks to display the actual line break style for each line rather than a generic 
paragraph marker. 

Convert|To UNIX (LF only)  

Converts the active file to the line break style used by UNIX and derivatives like Linux, BSD, and even OS X. 
These operating systems terminate each line with a single Line Feed character. Only the line termination 
characters are converted. Anything else remains untouched. 

To EditPad, it does not matter whether a file uses Windows, UNIX, or Mac line breaks. EditPad even 
handles files that use a mixture of all three. However, other applications often only support the òproperó line 
breaks for their environment. UNIX applications often try to display the CR in Windows text files, resulting 
in a weird character at the end of each line. 

Use the Convert|To UNIX command to make sure your file uses consistent UNIX line breaks if youõll be 
using the file with other UNIX, Linux, or OS X applications. If the Convert|To UNIX menu item is grayed 
out, that means the file already uses UNIX line breaks consistently. 
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If line break styles matter for your work, use the Status Bar Preferences to enable a status bar indicator to 
show the fileõs (dominant) line break style. In EditPad Pro, in the Editor Preferences you can configure 
Options|Visualize Line Breaks to display the actual line break style for each line rather than a generic 
paragraph marker. 

Convert|To Macintosh (CR only) 

Converts the active file to the line break style used by the Apple Macintosh. On the Macintosh, text files use a 
single Carriage Return character to terminate a line. Note that OS X applications may use the LF only UNIX 
format rather than the classic Mac CR only format. Only the line termination characters are converted. 
Anything else remains untouched. 

To EditPad, it does not matter whether a file uses Windows, UNIX, or Mac line breaks. EditPad even 
handles files that use a mixture of all three. However, other applications often only support the òproperó line 
breaks for their environment. Classic Mac applications may try to display the LF in Windows text files, 
resulting in a weird character at the start of each line. 

Use the Convert|To Macintosh command to make sure your file uses consistent classic Mac line breaks if 
youõll be using the file with older Mac applications. If the Convert|To Macintosh menu item is grayed out, 
that means the file already uses classic Mac line breaks consistently. 

If line break styles matter for your work, use the Status Bar Preferences to enable a status bar indicator to 
show the fileõs (dominant) line break style. In EditPad Pro, in the Editor Preferences you can configure 
Options|Visualize Line Breaks to display the actual line break style for each line rather than a generic 
paragraph marker. 

Convert|Wrapping -> Line Breaks 

When Options|Word Wrap is on, EditPad will break up long lines so they fit within the width of the EditPad 
window or are no longer than a certain number of characters. This wrapping is dynamic. It is not saved into 
the file. Therefore, the file will look different if you change the word wrap settings or open it in another 
application. 

Use Convert|Wrapping -> Line Breaks if you want to solidify a text in its wrapped state. This will convert all 
soft line breaks introduced by the wrapping into hard line breaks as if you had pressed Enter at each position 
where a long line is wrapped. 

You will also be asked if you want to align the text at the left side only, or if you want to align it at both sides. 
If you choose to align to the left side only, only line breaks will be inserted, as explained above. If you choose 
to align to both sides, EditPad Pro will also inserts spaces into each line, so that each line has the same 
number of characters. The spaces will be distributed evenly across each line. They will be inserted next to 
spaces already present on the original line. When the file is viewed with a fixed-width font such as Courier 
New, both the left and the right side of the text will be perfectly aligned. 

This function will also turn off word wrap. 
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If you want to limit the maximum length of each line in the file, you can first set the maximum line length by 
using the drop-down menu of the word wrap button on the toolbar. Then use Convert|Wrapping->Line 
Breaks. 

You should use Convert|Wrapping -> Lines when you have finished editing a file that will be used by an 
application or system that does not support word wrapping, or does not support lines longer than a certain 
number of character. For example, when preparing a message to be posted to a Usenet newsgroup or a 
message to be sent via email, you should set word wrap to 72 characters and then use Convert|Wrapping -> 
Lines. There are still a lot of newsreaders and email clients in use that cannot word wrap messages. 

Convert|Line Breaks -> Wrapping 

Convert|Line Breaks -> Wrapping attempts to do the opposite of Convert|Wrapping -> Line Breaks. Email 
clients and newsreaders, for example, will often limit the maximum line length, inserting additional line breaks 
into the file that you did not type in by pressing Enter onto the keyboard. This is done because a lot of email 
and newsgroup software, mostly older software, still cannot handle long lines. 

The problem with this is that after the hard line breaks have been inserted, the text becomes difficult to edit. 
The text will not be nicely and automatically rewrapped when you insert new text into a middle of the 
paragraph, like EditPad does when word wrap is on. With Convert|Line Breaks -> Wrapping you can tell 
EditPad Pro to attempt to remove the line breaks that were inserted into the file for the purpose of emulating 
word wrap. I did say òattemptó, because EditPad Pro has no way of detecting whether a line break was 
automatically inserted to limit the length of the line, or if it was inserted by a person pressing Enter on the 
keyboard. Technically, there is no difference between the two. But usually, EditPad Pro does a remarkably 
good job. 

If there is no selection when you use this command then it will unwrap the entire file. If there is a selection, 
only the selected lines are unwrapped. The algorithm that decides whether a line break should be removed or 
not may make different decisions when unwrapping the whole file versus unwrapping only part of the file. 
When unwrapping part of the file, it assumes that the selection is your entire document. If you have a file 
with lines that were pasted in from different files that were hard wrapped at different line lengths, then 
separately unwrapping blocks of lines wrapped at different line lengths may produces better results than 
unwrapping everything at once. 

Convert|Double -> Single Spacing 

A text file is double-spaced if there is a blank line between each line of text. Select Double -> Single Spacing 
from the Convert menu to remove those blank lines. If you select multiple lines of text first, only the selected 
block is converted. If there is no selection or the selection does not span multiple lines, then this conversion 
affects the entire file. 

If you use the double to single spacing conversion on a file that is not double-spaced, EditPad Pro will 
remove as many alternating blank lines as possible. If part of the file is single spaced and part is double 
spaced, the whole file will become single spaced. If the entire file is single spaced, but blank lines are used to 
separate paragraphs, then those blank lines will be removed. 

Certain files will appear double-spaced in EditPad, and single-spaced in other applications such as Notepad. 
This is caused by a different interpretation of line break characters. Usually, those files were incorrectly 
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transferred between a Windows and UNIX system, such as a PC and a web server. This causes incorrect line 
break characters to be added to the file. You can easily fix such files in EditPad Pro. First, select 
Convert|Double -> Single Spacing from the menu to remove the unwanted blank lines. Blank lines that 
appeared in the original file will remain. Then, select Convert|To Windows to make all the line breaks 
consistent with the Windows format. If Convert|To Windows is grayed out (i.e. unavailable), then the file 
already uses the correct line breaks. 

Convert|Single -> Double Spacing 

A text file is double-spaced if there is a blank line between each line of text. Select Single -> Double Spacing 
from the Convert menu to insert a blank line between each line of text, making the current file double spaced. 
If you select multiple lines of text first, only the the selected block is converted. If there is no selection or the 
selection does not span multiple lines, then this conversion affects the entire file. 

Note that EditPad Pro will not force you to maintain the double spaced format of the file. Pressing Enter will 
insert a single line break as usual. Press Enter twice to insert a double line break. You can type text into the 
blank lines added by the conversion if you want. This could be useful to annotate a manuscript, for example. 

Convert|Tabs -> Spaces 

Converts all tab characters in the active file into spaces. This command will only have its desired effect when 
using a fixed-width font like Courier New. If you select multiple lines of text first, only the the selected block 
is converted. If there is no selection or the selection does not span multiple lines, then this conversion affects 
the entire file. 

The number of spaces used for each tab by the conversion is the same the number of spaces used for each 
tab to display the file. It can be set in File Types|Editor. 

Convert|Spaces -> Tabs 

Converts as many spaces into tab characters as possible, without changing the layout of the file. This function 
will only have its desired effect when using a fixed-width font like Courier New. If you select multiple lines of 
text first, only the the selected block is converted. If there is no selection or the selection does not span 
multiple lines, then this conversion affects the entire file. 

The number of spaces used for each tab by the conversion is the same the number of spaces used for each 
tab to display the file. It can be set in File Types|Editor. 

Convert|Indentation Spaces -> Tabs 

Converts as many spaces at the start of each line into tab characters as possible, without changing the layout 
of the file. Spaces that occur after a non-whitespace character on a line are not converted. This function will 
only have its desired effect when using a fixed-width font like Courier New. If you select multiple lines of text 
first, only the the selected block is converted. If there is no selection or the selection does not span multiple 
lines, then this conversion affects the entire file. 
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The number of spaces used for each tab by the conversion is the same the number of spaces used for each 
tab to display the file. It can be set in File Types|Editor. 

Convert|Characters -> \ uFFFF 

Select the Characters -> \ uFFFF command in the Convert menu to replace all non-ASCII characters in the 
file with an escape sequence in the form of \ uFFFF. If you select some text before using this command, only 
non-ASCII characters in the selection are replaced. Otherwise, all non-ASCII characters in the file are 
replaced. 

Using this command does not change the encoding EditPad Pro uses for this file. Saving the file after 
replacing all non-ASCII characters this way only results in an ASCII file if the encoding youõre using for the 
file is compatible with ASCII. For example, the Windows code pages will result in an ASCII file, but UTF-16 
will not. 

In Convert|Text Encoding you can select "ASCII + \ uFFFF Unicode Escapes" as the fileõs encoding. When 
using this encoding, EditPad Pro displays the actual characters for all \ uFFFF escapes in the file. When you 
type non-ASCII characters into the file, EditPad Pro will display the character you typed, but store its 
\ uFFFF escape in the file. If you type òapr¯s-skió using this encoding, EditPad Pro will display òapr¯s-skió, 
but store "apr\ u00E8s-ski" in the file. If you open that file in Notepad (which cannot interpret Unicode 
escapes), youõll see "apr\ u00E8s-ski". 

Use the Convert|Characters -> \ uFFFF along with an encoding such as UTF-8 or Windows 1252 when you 
want to use Unicode escapes in only part of the file. EditPad will display the Unicode escapes while you edit 
the file. You can see where Unicode escapes are used and where actual characters are used. 

Use the "ASCII + \ uFFFF Unicode Escapes" encoding when working with files where Unicode escapes are 
the only way of representing non-ASCII characters. EditPad will display the actual characters while you edit 
the file. You wonõt see the Unicode escapes. EditPad makes sure all newly typed or pasted characters are 
stored as Unicode escapes in the file. 

If you have a file that contains non-ASCII characters that are not written as Unicode escapes then you can 
convert that file you being pure ASCII + \ uFFFF Unicode Escapes in three steps. First, open the file in 
EditPad and make sure all characters are displayed correctly. If not, use Convert|Text Encoding to select the 
proper encoding with the òinterpretó option. Second, use Convert|Characters -> \ uFFFF to convert all non-
ASCII characters to Unicode escapes. The actual escapes will appear. Finally, use Convert|Text Encoding 
and select to convert to ASCII + \ uFFFF Unicode Escapes. The Unicode escapes now again appear as actual 
characters. If you save the file the, it will be saved as pure ASCII with Unicode escapes. 

In the Encoding section in the file type configuration, there is an option to make EditPad Pro detect whether 
a file consists of pure ASCII with Unicode Escapes. If that option is on, EditPad Pro automatically selects the 
"ASCII + \ uFFFF Unicode Escapes" encoding for such files and displays the actual characters rather than 
the escapes. By default, this option is off for all file types except the Java file type. In Java source code files, 
Unicode escapes are 100% equivalent to actual characters, even for ASCII characters. 
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Convert| \ uFFFF -> Characters 

Select the \ uFFFF -> Characters command in the Convert menu to replace all escape sequence in the form 
of \ uFFFF into their actual characters. If you select some text before using this command, only escape 
sequences in the selection are replaced. Otherwise, all escape sequences in the file are replaced. 

The conversion will only be successful if all the characters can be represented in the encoding used by the file. 
If not, use Convert|Text Encoding to change the encoding before converting the escapes. Escapes that 
represent characters that are not supported by the fileõs encoding will not be converted. EditPad will pop up a 
message to alert you when this happens. 

Use the \ uFFFF -> Characters command when you actually want to remove the escapes from your file. Do 
not use this command if you have a file that is pure ASCII with \ uFFFF escapes and you want to be able to 
see the actual characters while keeping Unicode escapes in the file. To do that, use Convert|Text Encoding 
and select the "ASCII + \ uFFFF Unicode Escapes" encoding. This encoding makes EditPad Pro display the 
actual characters, but keeps the escapes in the file. If you type or paste non-ASCII characters while using the 
"ASCII + \ uFFFF Unicode Escapes" encoding, they will be automatically stored as Unicode escapes in the 
file. 

Convert|Characters -> &#65535; 

Select the Characters -> &#65535; command in the Convert menu to replace all non-ASCII characters in the 
file with a decimal character reference in the form of &#65535; . If you select some text before using this 
command, only non-ASCII characters in the selection are replaced. Otherwise, all non-ASCII characters in 
the file are replaced. 

Using this command does not change the encoding EditPad Pro uses for this file. Saving the file after 
replacing all non-ASCII characters this way only results in an ASCII file if the encoding youõre using for the 
file is compatible with ASCII. For example, the Windows code pages will result in an ASCII file, but UTF-16 
will not. 

In Convert|Text Encoding you can select "ASCII + &#65535; NCR" as the fileõs encoding. When using this 
encoding, EditPad Pro displays the actual characters for all &#65535;  character references in the file. When 
you type non-ASCII characters into the file, EditPad Pro will display the character you typed, but store its 
&#65535;  NCR in the file. If you type òapr¯s-skió using this encoding, EditPad Pro will display òapr¯s-skió, 
but store "apr&#232;s-ski" in the file. If you open that file in Notepad (which cannot interpret numeric 
character references), youõll see "apr&#232;s-ski". 

Use the Convert|Characters -> &#65535; along with an encoding such as UTF-8 or Windows 1252 when 
you want to use numeric character references in only part of the file. EditPad will display the numeric 
character references while you edit the file. You can see where numeric character references are used and 
where actual characters are used. 

Use the "ASCII + &#65535; NCR" encoding when working with files where numeric character references 
are the only way of representing non-ASCII characters. EditPad will display the actual characters while you 
edit the file. You wonõt see the numeric character references. EditPad makes sure all newly typed or pasted 
characters are stored as numeric character references in the file. 
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If you have a file that contains non-ASCII characters that are not written as numeric character references 
then you can convert that file you being pure ASCII + &#65535; NCR in three steps. First, open the file in 
EditPad and make sure all characters are displayed correctly. If not, use Convert|Text Encoding to select the 
proper encoding with the òinterpretó option. Second, use Convert|Characters -> &#65535; to convert all 
non-ASCII characters to numeric character references. The actual escapes will appear. Finally, use 
Convert|Text Encoding and select to convert to ASCII + &#65535; NCR. The numeric character references 
now again appear as actual characters. If you save the file the, it will be saved as pure ASCII with numeric 
character references. 

In the Encoding section in the file type configuration, there is an option to make EditPad Pro detect whether 
a file consists of pure ASCII with numeric character references. If that option is on, EditPad Pro 
automatically selects the "ASCII + &#65535; NCR" encoding for such files and displays the actual characters 
rather than the numeric character references. 

Convert|Characters -> &#xFFFF;  

This command does the same as Convert|Characters -> &#65535; except that it replaces characters with 
hexadecimal references instead of decimal references. So òaprès-skió becomes "apr&#xE8;s-ski". 

Convert|&#65535; and &#xFFFF; -> Characters 

Select the &#65535; and &#xFFFF; -> Characters command in the Convert menu to replace all decimal and 
hexadecimal character references in the form of &#65535;  and &#xFFFF;  into their actual characters. If you 
select some text before using this command, only numeric character references in the selection are replaced. 
Otherwise, all numeric character references in the file are replaced. 

This command does not convert numeric character references that represent the characters <, >, ' , " , and & 
that have special meanings in XML. To convert these, use Convert|XML Entities -> Reserved Characters. 

The conversion will only be successful if the all the characters can be represented in the encoding used by the 
file. If not, use Convert|Text Encoding to change the encoding before converting the numeric character 
references. numeric character references that represent characters that are not supported by the fileõs 
encoding will not be converted. EditPad will pop up a message to alert you when this happens. 

Use the &#65535; and &#xFFFF; -> Characters command when you actually want to remove the numeric 
character references from your file. Do not use this command if you have a file that is pure ASCII with 
numeric character references and you want to be able to see the actual characters while keeping numeric 
character references in the file. To do that, use Convert|Text Encoding and select the "ASCII + NCR" 
encoding. This encoding makes EditPad Pro display the actual characters, but keeps the numeric character 
references in the file. If you type or paste non-ASCII characters while using the "ASCII + NCR" encoding, 
they will be automatically stored as numeric character references in the file. 

Convert|Characters -> &htmlchar;  

Select the Characters -> &htmlchar; command in the Convert menu to replace all characters that have HTML 
entities with those HTML entities. It replaces òapr¯s-skió with "apr&egrave;s-ski". If you select some text 
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before using this command, only characters in the selection are replaced. Otherwise, all characters in the file 
that have HTML entities are replaced. 

Characters that do not have HTML entities are not changed. If you want to convert your file into pure ASCII 
using HTML entities and numeric character references for non-ASCII characters, first use the Characters -> 
&htmlchar; command to replace those characters that have named HTML entities. Then use the Characters -
> &#65535; or Characters -> &#xFFFF; command to replace the remaining non-ASCII characters that do 
not have named HTML entities. 

This command does not replace reserved characters such as <. Thus you can safely use this command on an 
entire HTML file without destroying its HTML tags. If you do want to replace reserved characters such as < 
with entities such as &lt; , use the Convert|Reserved Characters -> XML Entities menu item. 

Convert|&htmlchar; -> Characters 

Select the &htmlchar; -> Characters command in the Convert menu to replace all named HTML entities into 
their actual characters. If you select some text before using this command, only HTML entities in the 
selection are replaced. Otherwise, all HTML entities in the file are replaced. 

The conversion will only be successful if the all the characters can be represented in the encoding used by the 
file. If not, use Convert|Text Encoding to change the encoding before converting the HTML entities. HTML 
entities that represent characters that are not supported by the fileõs encoding will not be converted. EditPad 
will pop up a message to alert you when this happens. 

This command does not replace numeric character references. Only named HTML entities are replaced. To 
replace both named HTML entities and numeric character references, use both the &htmlchar; -> Characters 
command and the Convert|&#65535; and &#xFFFF; -> Characters command. 

This command also does not replace HTML entities that represent reserved characters such as &lt; . To 
replace those, use Convert|XML Entities -> Reserved Characters. 

Use the &htmlchar; -> Characters command when you actually want to remove the HTML entities from your 
file. Do not use this command if you have a file that is pure ASCII with HTML entities and you want to be 
able to see the actual characters while keeping HTML entities in the file. To do that, use Convert|Text 
Encoding and select the "ASCII + &htmlchar;" encoding. This encoding makes EditPad Pro display the 
actual characters, but keeps the HTML entities in the file. If you type or paste non-ASCII characters while 
using the "ASCII + NCR" encoding, they will be automatically stored as HTML entities in the file. 

Convert|Reserved Characters -> XML Entities  

Select the Reserved Characters -> XML Entities command in the Convert menu to replace the characters <, 
>, ' , " , and & that have special meanings in XML with their respective XML entities &lt; , &gt; , &apos; , 
&quot; , and &amp; . If you select some text before using this command, only characters in the selection are 
replaced. Otherwise, all reserved characters in the file are replaced. 
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Convert|XML Entities -> Reserved Characters 

Select the XML Entities -> Reserved Characters command in the Convert menu to replace XML entities 
&lt; , &gt; , &apos; , &quot; , and &amp;  with the characters <, >, ' , " , and & that they represent. Numeric 
character references that represent these 5 characters are also converted. If you select some text before using 
this command, only characters in the selection are replaced. Otherwise, all reserved characters in the file are 
replaced. 

Convert|ROT -13 

Applies ROT-13 character rotation to the current selection, making it a little difficult to read. Applying ROT-
13 again restores the original text. 

Before the Internet went commercial, people had the good habit to use ROT-13 to conceal possible offensive 
postings in newsgroups and then add a warning message in plain text. This made sure that nobody would 
read the text by accident and be offended. If one was offended after applying ROT-13, he or she would only 
have himself or herself to blame for ignoring the warning. 
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13. Options Menu 

Options|File Type  

When you open a file, EditPad looks at the fileõs extension to see which type of file it is. If you open a file 
with an extension not associated with any file type in EditPadõs file type configuration, you can change the file 
type through Options|File Type. 

Changing the file type will cause EditPad to change the fileõs settings for auto indent, line numbering, word 
wrap, etc. to those specified in the file type configuration for that file type. It will not change the fileõs 
extension. Use File|Rename and Move to change the fileõs name and extension. 

Options|Auto Indent  

Turn on Options|Auto Indent if you want the next line to automatically start at the same column position as 
the previous line whenever you press Enter on the keyboard while in the editor. EditPad will accomplish this 
by counting the number of spaces and tabs at the beginning of the previous line and inserting them at the 
beginning of the new line you created by pressing Enter. This is most useful for writing source code. 

When Auto Indent is on, using the Backspace key when there is only whitespace to the left of the cursor 
either deletes a single space, or deletes multiple spaces to go back to the previous level of indentation. The 
òbackspace unindentsó option in the Cursor Preferences determines this. 

Note that òauto indentó is a file type specific setting in EditPad. If you change the setting through the 
Options menu or the toolbar, it is applied to the active file only. If you create a new file or open an existing 
one, the setting made in File Type Editor Options for the type of file you are creating or opening, will be 
used. Also, when you use File|Save As, and you save the file with a new extension, then the setting for the 
current file will change into what you specified in File Types Preferences for the file type that corresponds 
with the fileõs new extension. 

Options|Line Numbers  

Turn on Options|Lines Numbers to have EditPad display a number before each line in the left margin. 

In File Type Editor Options, you can indicate if you want visible lines or physical lines to be numbered. This 
setting cannot be changed in the Options menu. 

Note that òlines numbersó is a file type specific setting in EditPad. If you change the setting through the 
Options menu or the toolbar, it is applied to the active file only. If you create a new file or open an existing 
one, the setting made in File Type Editor Options for the type of file you are creating or opening, will be 
used. Also, when you use File|Save As, and you save the file with a new extension, then the setting for the 
current file will change into what you specified in File Types Preferences for the file type that corresponds 
with the fileõs new extension. 
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Options|Column Numbers  

Turn on Options|Column Numbers to have EditPad display a horizontal ruler above the file indicating 
column numbers. Column numbers are only displayed when using a fixed-width font or a monospaced text 
layout. 

Note that òcolumn numbersó is a file type specific setting in EditPad. If you change the setting through the 
Options menu or the toolbar, it is applied to the active file only. If you create a new file or open an existing 
one, the setting made in File Type Editor Options for the type of file you are creating or opening, will be 
used. Also, when you use File|Save As, and you save the file with a new extension, then the setting for the 
current file will change into what you specified in File Types Preferences for the file type that corresponds 
with the fileõs new extension. 

Options|Visualize Spaces 

Turn on Options|Visualize Spaces if you want spaces and tabs to be visualized. Spaces will be indicated by a 
vertically centered dot. Tabs are indicated by a » character. This option is useful when working with files 
where extraneous whitespace can lead to problems, or where the difference between tabs and spaces matters. 

You can set the color of visualized spaces in the Colors Preferences. If you set a background color other than 
òdefaultó for whitespace in the preferences, then spaces will always be drawn with that background color, 
whether youõve turned on the option to visualize them or not. Spaces will then appear as colored rectangles, 
with or without the symbol. 

Note that òvisualize spacesó is a file type specific setting in EditPad Pro. If you change the setting through 
the Options menu or the toolbar, it is applied to the active file only. If you create a new file or open an 
existing one, the setting made in File Type Editor Options for the type of file you are creating or opening, will 
be used. Also, when you use File|Save As, and you save the file with a new extension, then the setting for the 
current file will change into what you specified in File Types Preferences for the file type that corresponds 
with the fileõs new extension. 

Options|Visualize Line Breaks 

Turn on Options|Visualize Line Breaks if you always want to see a ¶ character at the end of each paragraph, 
indicating the invisible line break character(s). You can set the color of the paragraph symbols in File 
Types|Colors. Instead of showing the generic ¶ character for all line breaks, EditPad Pro can show specific 
symbols that indicate the line break style. You can configure this in the Editor Preferences. 

If you turn off Options|Visualize Line Breaks, line break symbols are only displayed when line break 
characters are selected. If you never want to see any line break symbols, turn off òalways visualize line breaks 
in selected textó in the Editor Preferences.  

Note that òvisualize line breaksó is a file type specific setting in EditPad Pro. If you change the setting 
through the Options menu or the toolbar, it is applied to the active file only. If you create a new file or open 
an existing one, the setting made in File Type Editor Options for the type of file you are creating or opening, 
will be used. Also, when you use File|Save As, and you save the file with a new extension, then the setting for 
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the current file will change into what you specified in File Types Preferences for the file type that corresponds 
with the fileõs new extension. 

Options|Word Wrap 

Select Options|Word Wrap from the menu to toggle word wrapping on or off. By default, word wrap takes 
place at the right edge of the EditPad window. If you want the text to wrap at a certain number of characters, 
use the drop-down menu of the word wrap button on the toolbar. You can select one of a few commonly 
used line lengths, or define your own. 

Note that òword wrapó is a file type specific setting in EditPad. If you change the setting through the Options 
menu or the toolbar, it is applied to the active file only. If you create a new file or open an existing one, the 
setting made in File Type Editor Options for the type of file you are creating or opening, will be used. Also, 
when you use File|Save As, and you save the file with a new extension, then the setting for the current file 
will change into what you specified in File Types Preferences for the file type that corresponds with the fileõs 
new extension. 

Word wrapping is only used in text mode. In hexadecimal mode, use Options|Record Size. 

Options|Indent Wrapped Lines 

When word wrap is on, you can select Options|Word Wrap from the menu to toggle wrapping line 
indentation on or off. When on, lines created by the word wrapping will be indented by the same amount as 
the line they were broken off from. If you turn it off, wrapped lines will start at the first column regardless of 
the indentation of the original line. Turning on this option is useful when turning on word wrap for files 
using nested block structures, such as XML files and various programming languages. 

Note that òindent wrapped linesó is a file type specific setting in EditPad. If you change the setting through 
the Options menu or the toolbar, it is applied to the active file only. If you create a new file or open an 
existing one, the setting made in File Type Editor Options for the type of file you are creating or opening, will 
be used. Also, when you use File|Save As, and you save the file with a new extension, then the setting for the 
current file will change into what you specified in File Types Preferences for the file type that corresponds 
with the fileõs new extension. 

Options|Record Size 

What Options|Word Wrap is to text editing, Options|Record Size is to hexadecimal editing. Use this menu 
item to change the number of bytes that EditPad Pro displays on each row in hexadecimal mode. If you enter 
zero, you get EditPad Proõs default behavior of showing the smallest multiple of 8 bytes that fits within the 
width of EditPadõs window. If you enter a positive number, thatõs the number of bytes EditPad Pro displays 
on a row. You can enter any number. It doesnõt have to be divisible by 8 or by 2. 

The Record Size command is particularly useful for editing binary files in which each record takes up a 
specific number of bytes. Set the record size to that number of bytes to have one record on each line. 
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Options|Font  

If you pick Options|Font from the menu, a font selection window will appear. Select the font you want to 
use and click OK. You can also select a recently used font from the Options|Font submenu. 

The font setting applies to the entire file. It only changes the way it is displayed. EditPad is a plain text editor. 
It does not support any text formatting. 

Changing the font via Options|Font only affects the active file. In EditPad, the choice of font is part of the 
text layout configuration. That is the combination of settings that determines how EditPad displays text. The 
default text layout configuration can be set for each file type in File Types|Editor Options. 

If you want to edit text files in a language that uses characters that are not used in English, you will need to 
select the correct òscriptó from the drop-down list near the bottom of the font selection window that appears 
when you select Options|Font from the menu. Not all fonts support all scripts. Particularly scripts like 
Arabic, Chinese, Japanese or Korean are often supported by few fonts. If you canõt find any font with the 
script you want, you will need to install them from your original Windows CD. You can do so by clicking on 
the Windows Start button, choosing Settings, and opening the Control Panel. Among the Regional Settings, 
there are options for enabling support for complex scripts and ideographic scripts. 

Some fonts have òUnicodeó in their name. Such fonts include òArial Unicodeó and òLucida Sans Unicodeó. 
These fonts contain all characters in all languages that Windows supports. If you use one of these fonts, you 
never have to worry about using the right font for the right language. 

Fonts with Chinese, Japanese and Korean characters are available in two variants: the regular variant (e.g. MS 
Mincho), and a rotated variant for vertical printing (e.g @MS Mincho). The rotated variant always has the 
same name as the regular variant, but with an @ symbol in front of it. In Options|Font, you should select the 
regular variant, so characters will appear upright on the screen. In the print preview, you can select the rotated 
variant if you want. If you print with the rotated variant, the text will appear printed vertically if you rotate the 
printed sheet of paper 90 degrees clockwise. If you print with the regular variant, the printed text will flow 
from left to right, like you edit it in EditPad. 

Options|Text Layout  

In EditPad, a "text layout" is a combination of settings that control how text is displayed and how the text 
cursor navigates through that text. The settings include the font, text direction, text cursor behavior, which 
characters are word characters, and how the text should be spaced. 

The default text layout is configured for each file type in File Types|Editor Options. Via the Text Layout 
submenu in the Options menu you can select a different text layout for the active file. You can use the 
Configure Text Layout item in the Text Layout submenu to configure a new text layout or to edit an existing 
one. If you edit an existing text layout, the changes will be applied to any file and to any file type that uses it. 
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Select The Text Layout Configuration That You Want to Use 

The Text Layout Configuration screen shows the details of the text layout configuration that you select in the 
list in the top left corner. Any changes you make on the screen are automatically applied to the selected layout 
and persist as you choose different layouts in the list. The changes become permanent when you click OK. 
The layout that is selected in the list when you click OK becomes the new default layout. 

Click the New and Delete buttons to add or remove layouts. You must have at least one text layout 
configuration. If you have more than one, you can use the Up and Down buttons to change their order. The 
order does not affect anything other than the order in which the text layouts configurations appear in 
selection lists. 

EditPad comes with a number of preconfigured text layouts. If you find the options on this screen 
bewildering, simply choose the preconfigured layout that matches your needs, and ignore all the other 
settings. You can fully edit and delete all the preconfigured text layouts if you donõt like them. 
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¶ Left-to-right: Normal settings with best performance for editing text in European languages and 
ideographic languages (Chinese, Japanese, Korean). The default font is monospaced. The layout does 
respect individual character width if the font is not purely monospaced or if you select another font. 

¶ Proportionally spaced left-to-right: Like left-to-right, but the default font is proportionally spaced. 

¶ Monospaced left-to-right: Like left-to-right, but the text is forced to be monospaced. Columns are 
guaranteed to line up perfectly even if the font is not purely monospaced. This is the best choice for 
working with source code and text files with tabular data. 

¶ Monospaced ideographic width: Like monospaced left-to-right, but ASCII characters are given the 
same width as ideographs. This is the best choice if you want columns of mixed ASCII and 
ideographic text to line up perfectly. 

¶ Complex script left-to-right: Supports text in any language, including complex scripts (e.g. Indic 
scripts) and right-to-left scripts (Hebrew, Arabic). Choose this for editing text that is written from 
left-to-right, perhaps mixed with an occasional word or phrase written from right-to-left. 

¶ Complex script right-to-left: For writing text in scripts such as Hebrew or Arabic that are written 
from right-to-left, perhaps mixed with an occasional word or phrase written from left-to-right. 

¶ Monospaced complex left-to-right: Like òcomplex script left-to-rightó, but using monospaced fonts 
for as many scripts as possible. Text is not forced to be monospaced, so columns may not line up 
perfectly. 

¶ Monospaced complex right-to-left: Like òcomplex script right-to-leftó, but using monospaced fonts 
for as many scripts as possible. Text is not forced to be monospaced, so columns may not line up 
perfectly. 

Selected Text Layout Configuration 

The section in the upper right corner provides a box to type in the name of the text layout configuration. This 
name is only used to help you identify it in selection lists when you have prepared more than one text layout 
configuration. 

In the Example box you can type in some text to see how the selected text layout configuration causes the 
editor to behave. 

Text Layout and Direction 

¶ Complex script, predominantly left-to-right: Text is written from left to right and can be mixed with 
text written from right to left. Choose this for complex scripts such as the Indic scripts, or for text in 
any language that mixes in the occasional word or phrase in a right-to-left or complex script. 

¶ Complex script, predominantly right-to-left: Text is written from right to left and can be mixed with 
text written from left to right. Choose this for writing text in scripts written from right to left such as 
Hebrew or Arabic. 

¶ Left-to-right only: Text is always written from left to right. Complex scripts and right-to-left scripts 
are not supported. Choose this for best performance for editing text in European languages and 
ideographic languages (Chinese, Japanese, Korean) that is written from left to right without 
exception. 

¶ Monospaced left-to-right only: Text is always written from left to right and is forced to be 
monospaced. Complex scripts and right-to-left scripts are not supported. Each character is given the 
same horizontal width even if the font specifies different widths for different characters. This 
guarantees columns to be lined up perfectly. To keep the text readable, you should choose a 
monospaced font. 
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¶ ASCII characters with full ideographic width: You can choose this option in combination with any of 
the four preceding options. In most fonts, ASCII characters (English letters, digits, and punctuation) 
are about half the width of ideographs. This option substitutes full-width characters for the ASCII 
characters so they are the same width as ideographs. If you turn this on in combination with 
òmonospaced left-to-right onlyó then columns that mix English letters and digits with ideographs will 
line up perfectly. 

Text Cursor Movement 

¶ Monodirectional: The left arrow key on the keyboard always moves the cursor to the left on the 
screen and the right arrow key always moves the cursor to the right on the screen, regardless of the 
predominant or actual text direction.  

¶ Bidirectional: This option is only available if you have chosen one of the complex script options in 
the òtext layout and directionó list. The direction that the left and right arrow keys move the cursor 
into depends on the predominant text direction selected in the òtext layout and directionó list and on 
the actual text direction of the word that the cursor is pointing to when you press the left or right 
arrow key on the keyboard.  

o Predominantly left-to-right: The left key moves to the preceding character in logical order, 
and the right key moves to the following character in logical order. 
Á Actual left-to-right: The left key moves left, and the right key moves right. 
Á Actual right-to-left: The actual direction is reversed from the predominant direction. 

The left key moves right, and the right key moves left. 
o Predominantly right-to-left: The left key moves to the following character in logical order, 

and the right key moves to the preceding character in logical order. 
Á Actual left-to-right: The actual direction is reversed from the predominant direction. 

The left key moves right, and the right key moves left. 
Á Actual right-to-left: The left key moves left, and the right key moves right. 

Selection of Words 

¶ Select only the word: Pressing Ctrl+Shift+Right moves the cursor to the end of the word that the 
cursor is on. The selection stops at the end of the word. This is the default behavior for all Just Great 
Software applications. It makes it easy to select a specific word or string of words without any 
extraneous spaces or characters. To include the space after the last word, press Ctrl+Shift+Right 
once more, and then Ctrl+Shift+Left. 

¶ Select the word plus everything to the next word: Pressing Ctrl+Shift+Right moves the cursor to the 
start of the word after the one that the cursor is on. The selection includes the word that the cursor 
was on and the non-word characters between that word and the next word that the cursor is moved 
to. This is how text editors usually behave on the Windows platform. 

Character Sequences to Treat as words 

¶ Letters, digits, and underscores: Characters that are considered to be letters, digits, or underscores by 
the Unicode standard are selected when you double-click them. Ctrl+Left and Ctrl+Right move the 
cursor to the start of the preceding or following sequence of letters, digits, or underscores. If symbols 
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or punctuation appear adjacent to the start of a word, the cursor is positioned between the symbol 
and the first letter of the word. Ideographs are considered to be letters. 

¶ Letters, digits, and symbols: As above, but symbols other than punctuation are included in the 
selection when double-clicking. Ctrl+Left and Ctrl+Right never put the cursor between a symbol and 
another word character. 

¶ Everything except whitespace: All characters except whitespace are selected when you double-click 
them. Ctrl+Left and Ctrl+Right move the cursor to the preceding or following position that has a 
whitespace character to the left of the cursor and a non-whitespace character to the right of the 
cursor. 

¶ Words determined by complex script analysis: If you selected the òbidirectionaló text cursor 
movement option, you can turn on this option to allow Ctrl+Left and Ctrl+Right to place the cursor 
between two letters for languages such as Thai that donõt write spaces between words. 

Text Cursor Appearance 

Select a predefined cursor or click the Configure button to show the text cursor configuration screen. There 
you can configure the looks of the blinking text cursor (and even make it stop blinking). 

A text layout uses two cursors. One cursor is used for insert mode, where typing in text pushes ahead the text 
after the cursor. The other cursor is used for overwrite mode, where tying in text replaces the characters after 
the cursor. Pressing the Insert key on the keyboard toggles between insert and overwrite mode. 

Main Font 

Select the font that you want to use from the drop-down list. Turn on òallow bitmapped fontsó to include 
bitmapped fonts in the list. Otherwise, only TrueType and OpenType fonts are included. Using a TrueType 
or OpenType font is recommended. Bitmapped fonts may not be displayed perfectly (e.g. italics may be 
clipped) and only support a few specific sizes. 

If you access the text layout configuration screen from the print preview, then turning on òallow bitmapped 
fontsó will include printer fonts rather than screen fonts in the list, in addition to the TrueType and 
OpenType fonts that work everywhere. A òprinter fontó is a font built into your printerõs hardware. If you 
select a printer font, set òtext layout and directionó to òleft to right onlyó for best results. 

Fallback Fonts 

Not all fonts are capable of displaying text in all scripts or languages. If you have selected one of the complex 
script options in the òtext layout and directionó list, you can specify one or more òfallbackó fonts. If the main 
font does not support a particular script, EditPad will try to use one of the fallback fonts. It starts with the 
topmost font at the list and continues to attempt fonts lower in the list until it finds a font that supports the 
script you are typing with. If none of the fonts supports the script, then the text will appear as squares. 

To figure out which scripts a particular font supports, first type or paste some text using those scripts into the 
Example box. Make sure one of the complex script options is selected. Then remove all fallback fonts. Now 
you can change the main font and see which characters that font can display. When youõve come up with a 
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list of fonts that, if used together, can display all of your characters, select your preferred font as the main 
font. Then add all the others as fallback fonts. 

Line and Character Spacing 

By default all the spacing options are set to zero. This tells EditPad to use the default spacing for the font you 
have selected. 

If you find that lines are spaced apart too widely, specify a negative value for "increase (or decrease) the line 
height". Set to òadd 0 pixels of extra space between linesó. 

If you find that lines are spaced too closely together, specify a positive value for "increase (or decrease) the 
line height" and/or "add ... pixels of extra space between lines". The difference between the two is that when 
you select a line of text, increasing the line 
height increases the height of the selection 
highlighting, while adding extra space 
between lines does not. If you select 
multiple lines of text, extra space between 
lines shows up as gaps between the selected 
lines. Adding extra space between lines may 
make it easier to distinguish between lines. 

The "increase (or decrease) the character 
width by ... pixelsò setting is only used 
when you select ómonospaced left-to-
rightò only in the ótext layout and 
direction" list. You can specify a positive 
value to increase the character or column 
width, or a negative value to decrease it. 
This can be useful if your chosen font is 
not perfectly monospaced and because of 
that characters appear spaced too widely or 
too closely. 

Text Cursor Configuration 

You can access the text cursor 
configuration screen from the text layout 
configuration screen by clicking one of the 
Configure buttons in the òtext cursor 
appearanceó section. 
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Existing Text Cursor Configurations 

The Text Cursor Configuration screen shows the details of the text cursor configuration that you select in the 
list at the top. Any changes you make on the screen are automatically applied to the selected cursor and 
persist as you choose different cursors in the list. The changes become permanent when you click OK. The 
cursor that is selected in the list when you click OK becomes the new default cursor. 

Click the New and Delete buttons to add or remove cursors. You must have at least one text cursor 
configuration. If you have more than one, you can use the Up and Down buttons to change their order. The 
order does not affect anything other than the order in which the text cursor configurations appear in selection 
lists. 

EditPad comes with a number of preconfigured text cursors. You can fully edit or delete all the preconfigured 
text cursors if you donõt like them. 

¶ Insertion cursor: Blinking vertical bar similar to the standard Windows cursor, except that it is thicker 
and fully black, even on a gray background. 

¶ Bidirectional insertion cursor: Like the insertion cursor, but with a little flag that indicates whether 
the keyboard layout is left-to-right (e.g. youõre tying in English) or right-to-left (e.g. youõre typing in 
Hebrew). The flag is larger than what you get with the standard Windows cursor and is shown even if 
you donõt have any right-to-left layouts installed. 

¶ Underbar cursor: Blinking horizontal bar that lies under the character. This mimics the text cursor 
that was common in DOS applications. 

¶ Overwrite cursor: Blinking rectangle that covers the bottom half of the character. In EditPad this is 
the default cursor for overwrite mode. In this mode, which is toggled with the Insert key on the 
keyboard, typing text overwrites the following characters instead of pushing them ahead. 

¶ Standard Windows cursor: The standard Windows cursor is a very thin blinking vertical bar that is 
XOR-ed on the screen, making it very hard to see on anything except a pure black or pure white 
background. If you have a right-to-left keyboard layout installed, the cursor gets a tiny flag indicating 
keyboard direction. You should only use this cursor if you rely on accessibility software such as a 
screen reader or magnification tool that fails to track any of EditPadõs other cursor shapes. 

Selected Text Cursor Configuration 

Type in the name of the text cursor configuration. This name is only used to help you identify it in selection 
lists when you have prepared more than one text cursor configuration. 

In the Example box you can type in some text to see what the cursor looks like. The box has a word in Latin 
and Arabic so you can see the difference in cursor appearance, if any, based on the text direction of the word 
that the cursor is on. 

Shape 

¶ Standard Windows Text cursor: The standard Windows cursor is a very thin blinking vertical bar that 
is XOR-ed on the screen, making it very hard to see on anything except a pure black or pure white 
background. If you have a right-to-left keyboard layout installed, the cursor gets a tiny flag indicating 
keyboard direction. You should only use this cursor if you rely on accessibility software such as a 



 
 
129 

screen reader or magnification tool that fails to track any of EditPadõs other cursor shapes. The 
standard Windows cursor provides no configuration options. 

¶ Vertical bar in front of the character: On the Windows platform, the normal cursor shape is a vertical 
bar that is positioned in front of the character that it points to. That is to the left of the character for 
left-to-right text, and to the right of the character for right-to-left text. 

¶ Vertical bar with a flag indicating keyboard direction: A vertical bar positioned in front of the 
character that it points to, with a little flag (triangle) at the top that indicates the direction of the 
active keyboard layout. When the cursor points to a character in left-to-right text, it is placed to the 
left of that character. When the cursor point to a character in right-to-left text, it is placed to the right 
of that character. The direction of the cursorõs flag is independent of the text under the cursor. The 
cursorõs flag points to the right when the active keyboard layout is for a left-to-right language. The 
cursorõs flag points to the left when the active keyboard layout is for a right-to-left language. 

¶ Vertical bar with a flag indicating text direction: A vertical bar positioned in front of the character 
that it points to, with a little flag (triangle) at the top that points to that character. When the cursor 
points to a character in left-to-right text, it is placed to the left of that character with its flag pointing 
to the right towards that character. When the cursor point to a character in right-to-left text, it is 
placed to the right of that character with its flag pointing to the left towards that character. 

¶ Horizontal bar under the character: In DOS applications, the cursor was a horizontal line under the 
character that the cursor points to. 

¶ Half rectangle covering half the character: The cursor covers the bottom half of the character that it 
points to. This is a traditional cursor shape to indicate typing will overwrite the character rather than 
push it ahead. 

¶ Rectangle covering the whole character: The cursor makes the character invisible. This can also be 
used to indicate overwrite mode. 

Blinking Style 

¶ Do not blink: The cursor is permanently visible in a single color. Choose this option if the blinking 
distracts you or if it confuses accessibility software such as screen readers or magnification tools.  

¶ Blink on and off: The usual blinking style for text cursors on the Windows platform. The cursor is 
permanently visible while you type (quickly). When you stop typing for about half a second, the 
cursor blinks by becoming temporarily invisible. Blinking makes it easier to locate the cursor with 
your eyes in a large block of text.  

¶ Alternate between two colors: Makes the cursor blink when you stop typing like òon and offó. But 
instead of making the cursor invisible, it is displayed with an alternate color. This option gives the 
cursor maximum visibility: the blinking animation attracts the eye while keeping the cursor 
permanently visible.  

Sizes 

¶ Width: Width in pixels for the vertical bar shape.  

¶ Height: Height in pixels for the horizontal bar shape.  

¶ Flag: Length in pixels of the edges of the flag that indicates text direction.  
























































































































































































































































































































































































































































































